should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through help links. All such sample code is provided “as is” and “as available”, for use only with an authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's particular usage pattern requires a higher limit or threshold, then the Customer should procure a subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally available. To use such features, Customer acknowledges and agrees that such beta features are subject to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will use the beta feature carefully and will not use it in any way which might result in any loss, corruption or unauthorized access of or to its or any third party's property or information. Customer must promptly report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability of such beta features and may substantially modify or cease providing such beta features without entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the performance of the Service resulting from the use of beta features. Oracle's standard service levels, warranties and related commitments regarding the Service shall not apply to beta features and they may not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the date that Oracle at its sole option makes a beta feature generally available to its customers and partners as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document.

Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click [here](mailto:) to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
Table of Contents

Search ................................................................. 1
Search Overview ..................................................... 2
Finding Records ...................................................... 3
Global Search ......................................................... 3
  Tips for Effective Global Searches .......................... 4
  Global Search Prefixes ......................................... 7
  Including Custom Fields in Global Search ............... 9
  Inline Editing of Global Search Results .................. 10
  User Preferences for Global Search ....................... 12
  Notes about Global Search Auto Suggest ................. 13
Quick Find .......................................................... 13
Quick Search Portlet .............................................. 14
  Customizing Quick Search Results ....................... 16
Finding Invoices, Bills, Orders, and Other Transactions 19
Running Searches ............................................... 20
  Searchable Record Types ...................................... 20
  Defining a Simple Search ...................................... 25
    Tips for Defining Simple Search Filters ................. 26
  Defining an Advanced Search ................................ 27
    Advanced Search Criteria Filters ....................... 27
    Search Results Display Options ......................... 34
    Related Records Fields Available for Advanced Searches 44
    Searching by File Attachments ......................... 63
  Summary Types for Search Results ...................... 64
  Formulas in Search ............................................ 71
    Using a Custom Formula Field in a Search .............. 73
    Using a Formula in Search Criteria ..................... 73
    Using a Formula in Search Results ..................... 74
    Using Formula Tags in Search Results .................. 75
    Search Formula Examples and Tips ..................... 76
    SQL Expressions .............................................. 80
  Exporting Search Results ..................................... 86
  Persisting Search Results ..................................... 88
  Emailing Search Results ...................................... 89
  Permissions for Searches ..................................... 90
  Popup Searches ................................................. 92
  Personalizing a Search Form ................................ 92
    Adding Personalized Search Forms to NetSuite Pages 94
  Mass Changes or Updates .................................... 94
    Defining a Mass Update .................................... 95
    Entering Formulas for a Mass Update .................... 99
    Scheduling a Mass Update ................................. 99
    Translations for Mass Updates ........................... 100
    Example Mass Update ...................................... 102
    Available Mass Updates .................................... 102
    Mass Updates of Global Subscription Status .......... 110
    Performing Mass Deletes .................................. 110
  Saved Searches ................................................. 112
    Defining a Saved Search ................................... 113
    Selecting Available Filters for Saved Searches ....... 116
    Defining Audiences for Saved Searches ................. 118
    Highlighting Search Results .............................. 120
    Marking a Search Inactive ................................. 123
Search

- Search Overview
- Finding Records
- Running Searches
- Saved Searches
- FAQ: Search
Search Overview

NetSuite provides a variety of search tools that you can use to retrieve real-time data from your account. You can search for a single record by keywords, return a set of records that match filters you define, customize the display of search results, export results to other applications, email results to other users, and save search definitions for reuse.

Use the following methods to quickly find specific records:

- **Global Search.** You can enter keywords in the Search field, located at the top of every NetSuite page, to search your entire account for matching records. Prefix your keywords with the first few letters of a record type and a colon to narrow results. See Global Search.

- **Quick Find Links.** You can click a Quick Find icon in the header of many individual records to quickly find a record of the same type. See Quick Find.

- **Quick Search Portlet.** You can add a portlet to your dashboard, where you can enter keywords to return records with matching names or IDs. See Quick Search Portlet.

Use the following methods to return a set of records of a selected type, with values that match filters you have defined.

- **Simple Search.** To run a simple search, go to Reports > New Search and choose the type of records you want to find. On the search page that opens, you can filter retrieved records by one or more field values. See Defining a Simple Search.

- **Advanced Search.** You can shift to advanced search mode by checking the Use Advanced Search box on a search page. On this page, you can filter records by formulas containing SQL expressions, and by join field values in related records, and you can sort results and group them into summary calculations. See Defining an Advanced Search.

- You can save simple and advanced search results to a .csv, .xls, or .pdf file, and include these results in email messages. See:
  - Exporting Search Results
  - Emailing Search Results

Use **Saved Search** to save a search definition that you and other users can run repeatedly for dynamically updated results. See Defining a Saved Search. Saved search includes all of the functions of advanced search, and more, including the following:

- **Automatic, customizable emails of saved search results.** You can designate saved search results to be emailed to users at regularly scheduled intervals and/or when results change. See Saved Search Email.

- **Display of saved search results in dashboard portlets.** You can define saved searches as custom key performance indicators so that summary values are available for display in Key Performance Indicators, KPI Scorecard, KPI Meter, and trend graph portlets. You also can display saved search results columns in custom search portlets. See the help topic Custom KPIs.

- **Display of saved search performance details in the Search Performance Analysis dashboard.** If you have the Application Performance Management SuiteApp installed in your account, you can use the Search Performance Analysis dashboard to view saved search performance details. See the help topic Analyzing Search Performance.

The system maintains a rolling log of saved search execution information, that is maintained for 60 days.
Finding Records

You may want to quickly find a specific record to review or update its details. The NetSuite interface includes search tools where you can enter keywords and retrieve matching records. The following quick retrieval tools are available:

- A Search field appears in the center of the NetSuite header so that it is accessible everywhere in NetSuite. You can enter keywords here to search your entire NetSuite account. See Global Search.
- Many NetSuite pages, including transaction records and some lists of records, include a Quick Find icon at the top of the page that you can click to search for other records of the same type. See Quick Find.
- You can add a Quick Search portlet to your home page dashboard and to some other pages, where you can enter keywords to search for records of a selected type. See Quick Search Portlet.

Global Search

The NetSuite global search feature enables you to find records anywhere in your account data. In the Search field near the center at the top of any page, enter keywords that map to all or part of a record name or ID.

You can quickly move the cursor to this Search field by pressing Alt+G.

Global search keywords can be made up of letters, numbers, dashes, underscores, and % wildcards. Any other characters entered in keywords are considered white space. You can use OR as a separator in global search keywords. You can include a prefix in keywords to narrow the search by record type. A search prefix is made up of all or some of the letters of a record type plus a colon or a caret. For example, you could use `it:` to search for items.

For successful global searches, NetSuite recommends that the keywords you use are between 3 and 32 characters long. If a keyword is longer than 32 characters, all additional characters are ignored. If a keyword has less than 3 characters or is not unique, your search may not return the results you expect when you are searching over a large amount of data.

By default, global search provides a list of suggested matches as you type. You can select a suggested match or press Enter to return all matching results.

- When you select a suggested match:
  - To open a record in view mode, click directly on the record name.
  - To open a record in edit mode, click Edit that appears at right.
  - To open a record in a new tab or new window, right-click on the record name or Edit, and choose Open in New Tab or Open in New Window.
  - To open the customer dashboard for a suggested customer record, click Dash that appears to the right.
  - You can also use the Tab key to move through the suggested matches list.
  - For more information, see Notes about Global Search Auto Suggest.
- When you press Enter, keywords are compared to record name and ID field values.
  - If multiple records match your keywords, a list page of results opens. This list includes a Type column displaying the record type for each row.
If only a single record matches, by default the record opens in view mode.
To return a single result record on a list page instead, go to Home > Set Preferences, click the Analytics subtab, and check the Show List When Only One Result box.
For item records, keywords also are compared to Vendor Name/ID and UPC Code values.
If you have made any custom fields available for global search, keywords also are compared to these fields' values. See Including Custom Fields in Global Search.
- If you do not want a list of suggested matches to display for global searches, you can disable the Global Search Auto Suggest option at Home > Set Preferences on the Analytics subtab.

By default, global search results are sorted by record type, and within each record type, by name or ID. To sort results by name or ID, without dividing them by record type, you can enable the Global Search Sort by Name/ID option at Home > Set Preferences on the Analytics subtab.

**Important:** Global search is designed to return the best matches quickly, not to return every possible match. For searches with a large number of possible matches, global search limits results to maintain speed and ease of use. To return every possible match in result sets over 300 records, NetSuite recommends that you use a record type search instead. See Running Searches.

You can print, email, or export global search results to a CSV or Microsoft® Excel file. See Emailing Search Results and Exporting Search Results.

You can edit records directly on the global search results page. See Inline Editing of Global Search Results.

For more information about using global search, see:
- Tips for Effective Global Searches
  - Global Search by Email Address
  - Global Search by IP Address
  - Global Search by Document Number Only
- Global Search Prefixes
- Including Custom Fields in Global Search
- Inline Editing of Global Search Results
- User Preferences for Global Search
- Using Global Search to Find Help Topics
- Notes about Global Search Auto Suggest

**Tips for Effective Global Searches**

To enhance the effectiveness of global search, you can do the following:

- **Use search prefixes.** Narrow the search to records of one type by adding a prefix to the search string, to speed the search and eliminate the return of irrelevant records. A search prefix is made up of all or some of the letters of a record type plus a colon or a caret.
  - Enter `cu:max` or `cu^max` to search for customers with records containing the letters max.
  - Note that the colon (:) and caret (^) are special command characters for global search, used to separate a type specifier from keywords.
    - If you enter characters that end with a colon or caret, you receive an error requesting keywords. Avoid this problem by leaving off the colon or caret.
- If you enter a hierarchical entity name such as 1000P:100SUB (where 1000P is a customer and 100SUB is a subcustomer), the text before the colon is treated as a type specifier and no results are found. Avoid this problem by adding a space before the colon, so that it is treated as a normal keyword separator instead of a type specifier. For example, enter 1000P:100SUB. You can add a type specifier as needed, for example, enter cu:1000P:100SUB.

For more information, see Global Search Prefixes.

- **Use keywords that are at least 3 characters long.** Use more specific keywords that contain 3 or more characters. Searching by shorter keywords or keywords that are not unique may not return the results you expect when searching over a large amount of data.

- **Search for multiple text strings at the same time.** You can use OR as a separator in keywords, to search for multiple text strings.
  - Enter **max OR macs OR machs** to search for records containing any of these three strings in one search.
  - Note that OR must be uppercase for it to be recognized as a separator.
  Instead of OR, you can use a space or a hyphen. If a string includes spaces between words, each word is treated as a separate keyword and results return exact matches per keyword.

- **Include inactive records.** Append a + to your keywords to include inactive records in a global search.
  - Enter **cu:max+** to search for both active and inactive customers with records containing the letters max.
  To always include inactive records, go to Home > Set Preferences, click the Analytics subtab, and check the Include Inactives in Global and Quick Search box.

- **Go directly to a customer dashboard.** Use the dash: prefix with a customer name to open that customer’s dashboard.
  - Enter **dash:Acme Supply** in the Search field, then press Enter or click Go to open that company’s customer dashboard.

- **Use % as a wildcard in numeric keywords.** To avoid returning extremely large result sets for purely numeric keywords, global search returns exact matches only, unless you add the % wildcard.
  - If you enter **inv:115**, only an invoice with invoice #115 is returned.
  - If you enter **inv:115%**, all invoices with numbers starting with 115 are returned.

- Use the SQL % wildcard to select columns that begin with a certain character strings. For example, if you would like to see Customers in the cities of Minneapolis and Minnetonka, you could use the SQL % wildcard as follows to return all cities beginning with “Minn”:

```sql
SELECT * FROM Customers WHERE City LIKE 'Minn%';
```

- Use the SQL % wildcard to select columns that contain certain character strings. For example, if you would like to see Customers in the cities of Dulles and Los Angeles, you could use the SQL % wildcard as follows to return all cities that contain with “es”:

```sql
SELECT * FROM Customers WHERE City LIKE '%es%';
```

- Use the SQL _ wildcard to select all customers with a City starting with any character, followed by “erlin”:

```sql
SELECT * FROM Customers WHERE City LIKE '_erlin';
```

- **Keep keyword length to 32 characters or less.** Keywords with a greater number of characters may cause a failure to find matching results.

- **Search for exact text matches only.** Enclose the search string in quotation marks, or follow it with a backslash, to search for records containing only exact matches.
Enter **cu: "max"** or **cu:max\** to search for customers with a name of Max. Customers with names containing the letters max, like Maxam, Lomax, or Maximum Tires, are not returned. Quotation marks or backslashes are not required for numeric keywords, as these searches return only exact matches.

- **Search for exact record type matches only.** Use a prefix of the entire record type name and enclose it in quotation marks to search for records only of that record type.

  This capability is useful when your account includes custom record types that contain the names of other record types, for example a custom record type named Customer Survey. In this case, use of the “customer” prefix causes the search to return only customer records, not customer survey records. Without the quotation marks, both record types would be returned.

- **Search by Document Number Only.** Use the Global Search by Document Number Only feature to return search results only by document number. This can prevent situations where the search includes both document and transaction number, producing two results in the auto-suggested search terms. For more information see Global Search by Document Number Only.

- **Return a single result in edit mode.** By default, a single record returned by a global search opens in view mode. You can override this default by capitalizing the first letter of a search prefix. (This prefix has no effect when the Show List When Only One Result preference is enabled.)

  - Enter **Cu:"Maximum Tires"** to open this customer's record in edit mode.
  - Enter **In:115** to open invoice number 115 in edit mode.
  - Note that you can open a suggested matching record in edit mode by clicking **Edit** that appears at right when your cursor is over the record in the suggested matches list box.

- **Return search results in a new browser window.** Add an extra colon between the prefix and the search string to open a new browser window displaying the results list page, or the single result record in either view or edit mode.

  - Enter **in::115%** to open a new browser window displaying the list of invoices with invoice numbers starting with the digits 115.
  - Enter **In::115** to open a new browser window displaying invoice number 115 in edit mode.

- **Index custom fields to be included in global search.** You can search for matches in custom fields as well as name/ID fields. See Including Custom Fields in Global Search.

- **Edit fields directly on the global search results page.** You can quickly modify records without moving to different pages. See Inline Editing of Global Search Results.

- **Email a list of global search results.** Click the Email button at the bottom of a global search results list page to open a popup window where you can select recipients, enter comment text, and choose a format for the results.

**Note:** Also see Global Search by Email Address and Global Search by IP Address.

**Note:** Records for customers in all stages to be returned, including leads, prospects, and customers, when you use the **cu** global search prefix, enable the Global Search Customer Prefix Includes Leads and Prospect option, at Home > Set Preferences on the Analytics subtab.

**Global Search by Email Address**

To do an effective global search for an email address, NetSuite recommends that you enter the complete email address, in the format `<user name>@<domain>`. If you use this format, global search treats this entry as a single keyword and returns anyone with that exact, complete email address.
This treatment of a recognized email address overrides the normal global search treatment of the . (period) and @ (at) characters as spaces.

For example:

- If you enter a complete email address, such as john.brown@abc.com, global search returns that exact match only.
- If you enter only brown@abc.com, global search treats it as a complete email address and only returns that exact match.
- If you enter only john.brown, global search looks for two different keywords, john, and brown, and returns any records containing these two keywords.

The starts-with matching generally used by default in global search is not supported for email addresses because the complete email address is required for global search to interpret a keyword as an email address.

**Global Search by IP Address**

Global search treats each . (period) character as a space, so a global search for an IP address runs as a search for four separate keywords, rather than as a search for one keyword. This type of search may return multiple IP addresses that contain the same numbers in different orders, because keyword order is not relevant.

For example: searching for 111.222.333.444 could return an IP address such as 111.222.444.333 as well as the exact match of 111.222.333.444.

By default, global search does keywords-starts-with matching. You can enclose any individual keyword in quotation marks to turn off starts-with matching on that keyword, as described in Tips for Effective Global Searches. Global search does not support the enclosing of multiple separate keywords in quotations to express order.

**Global Search by Document Number Only**

NetSuite's Global Search can include both document numbers (for example, invoice numbers) and system-generated transaction numbers in its search results. Role preferences allow you to include or exclude results by transaction numbers from your global searches.

To include transaction numbers at the role level, administrators can go to Setup > Users/Roles > Manage Roles and click Customize next to a role. Then, go to the Preferences subtab and select the Global Search Includes Transaction Numbers from the dropdown list. If the box is cleared, Global Search results will only include results by document number.

To include transaction numbers at the user level, go to Home > Set Preferences > Analytics > Search and select Global Search Includes Transaction Numbers. This preference is available to all roles, and does not require any permission to enable it.

For more information, see the help topic Setting General Account Preferences.

View the Global Search by Document Number Only video

**Global Search Prefixes**

You can use record type prefixes in global search keywords, to narrow search results to records of a single type. A search prefix is made up of some or all of the letters of a standard or custom record type name plus a colon or caret, for example: cu: or cu^ for customer searches, em: or em^ for employee searches, bu: or bu^ for budget searches.
The system provides “keywords starts with” matching for record type prefixes, meaning it returns results with record type names that either contain or start with the letters in a prefix.

For example, to search for an inventory item, you could use any of the following prefixes:

- i:
- it:
- inv:
- inve:

However, some of the above prefixes would return extra results, because they match more than one record type. For example, a prefix of inv: could return results for both inventory items and invoices.

For more details, see Example Global Search Prefixes.

For example, to search for results with a record type of plain text file, you could use any of the following prefixes:

- p:
- pl:
- t:
- te:
- fi:
- fil:

However, some of the above prefixes would return irrelevant results, because they are not unique matches to one record type name. If the letters entered as a prefix match more than one record type name in your system, the search may return records of more than one type. So for example, a prefix of p: could return results with record types of plain text file, phone call, promotion code, partner, page, and others.

Note that the colon and caret are special command characters for global search, used to separate a type specifier from keywords. If you enter characters that end with a colon or caret, you receive an error requesting keywords.

You can use a prefix of the entire record type name and enclose it in quotation marks to search for records only of that record type. This capability is useful when your account includes custom record types that contain the names of other record types, for example a custom record type named Customer Survey. In this case, use of the customer prefix causes the search to return only customer records, not customer survey records. Without the quotation marks, both record types would be returned.

By default, the cu prefix returns records only for customers, not for leads or prospects. To cause records for customers in all stages to be returned when you use the cu global search prefix, including leads, prospects, and customers, enable the Global Search Customer Prefix Includes Leads and Prospect preference, at Home > Set Preferences on the Analytics subtab.

**Note:** You can use the dash: prefix with a customer name to go directly to that customer’s dashboard.

### Example Global Search Prefixes

The following list of example global search prefixes is based on a language setting of English (U.S.) and default record names. This list is intended to provide examples, not a reference of prefixes that work for you!
Global Search

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Record Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>cam</td>
<td>Campaign</td>
</tr>
<tr>
<td>cash</td>
<td>Cash Sale</td>
</tr>
<tr>
<td>con</td>
<td>Contact</td>
</tr>
<tr>
<td>cust</td>
<td>Customer</td>
</tr>
<tr>
<td>emp</td>
<td>Employee</td>
</tr>
<tr>
<td>est</td>
<td>Estimate</td>
</tr>
<tr>
<td>ev</td>
<td>Event</td>
</tr>
<tr>
<td>exp</td>
<td>Expense Report</td>
</tr>
<tr>
<td>fi</td>
<td>File</td>
</tr>
<tr>
<td>invo</td>
<td>Invoice</td>
</tr>
<tr>
<td>iss</td>
<td>Issue</td>
</tr>
<tr>
<td>it</td>
<td>Item</td>
</tr>
<tr>
<td>opp</td>
<td>Opportunity</td>
</tr>
<tr>
<td>par</td>
<td>Partner</td>
</tr>
<tr>
<td>ph</td>
<td>Phone Call</td>
</tr>
<tr>
<td>sales</td>
<td>Sales Order</td>
</tr>
</tbody>
</table>

**Warning:** The global search prefixes that work for you may vary from this list, depending upon the language you have selected at Home > Set Preferences and renaming of records in your account by your account administrator!

You do not need to select a global search prefix from this list. You need to use the first few letters of the record type name as a prefix, enough to be unique so that other record types are excluded.

**Using Global Search to Find Help Topics**

The NetSuite Help Center has its own search capability. In addition, global search enables you to search help for a topic directly from your NetSuite page.

To search the NetSuite Help Center for a match, use the `help:` prefix in the Search field in the upper right corner. For example, to search for help topics about dashboards, enter `help:dashboards`.

**Including Custom Fields in Global Search**

Global searches generally include only record name and ID fields. Global searches return records that have name or ID field values that match the entered keywords. Custom fields also may be indexed for global search. Records with indexed custom field values that match keywords are returned for global searches.

To index a custom field to be included in global search, a user with permission to edit or create custom fields must check the Global Search box on the custom field record. By default, the Available for Global Search box is not checked for preexisting or new custom fields.
Global search indexing is available for the following data types, when the Store Value preference is enabled:

- Currency
- Decimal Number
- Email Address
- Free-Form Text
- Help
- Hyperlink
- Inline HTML
- Integer Number
- Percent
- Phone Number
- Text Area

Global search results that include multiple record types include a Custom Fields column that lists the custom field name and value for each matching record.

By default, global search results that include a single record type do not include columns for custom fields, so you may not see matching custom field values on the results page.

**Warning:** You cannot index a custom field for global search if None is selected for any Level for Search/Reporting option on the Access subtab of the custom field record.

### Inline Editing of Global Search Results

You can edit records directly on the global search results page. This function is supported when: all results share the same record type, that record type supports inline editing, and the Inline Editing feature is enabled for your account.

An Edit button at the top of the list means inline editing is supported for the results.

**To enable editing:**

- If Edit is off, the button displays a gray x as shown in the following screenshot. Click to turn it on. A green arrow appears when editing is enabled.

**To edit a field:**

- Select a field with a pencil in the column header, and edit as desired. Your changes are saved as soon as you move the cursor from the field.
To add a new record of the selected type:

1. Click **Add** above the list toolbar to open a Quick Add popup window for the current record type.

2. Complete the fields.

3. Click **Save**.

To add a related record to a global search result:

1. Click the icon in a record's **New** column.
2. Select a record type from the menu.
3. Complete the page that opens.

To delete a record:

- Click the icon in a record’s New column, and select Delete Record from the menu.

For more information, see the help topic Using Inline Editing.

User Preferences for Global Search

You can set the following user preferences for global search at Home > Set Preferences on the Analytics subtab:

- **Include Inactives in Global & Quick Search** – Enable this option to include inactive records in results returned for keywords entered in the Search field or in the Quick Search portlet. By default this option is disabled, and only active records are returned for these searches.

- **Global Search Auto Suggest** – When this option is enabled, NetSuite suggests matches for the text you enter in the Search field, automatically as you type. You can select from the list of suggested records to go directly to the record you need. This option is enabled by default. For more information, see Notes about Global Search Auto Suggest.

- **Global Search Sort by Name/ID** – Enable this option to sort global search results by name. This option is disabled by default, and global search results are sorted by record type, and then by name within each record type.

- **Global Search Customer Prefix Includes Leads and Prospects** – Enable this option to cause records for customers in all stages to be returned when you use the cu global search prefix, including leads,
prospects, and customers. By default this option is disabled, and the **cu** prefix returns records only for customers, not for leads or prospects.

### Notes about Global Search Auto Suggest

When the Global Search Auto Suggest user preference is enabled, which it is by default, NetSuite suggests matches for the text you enter in the Search field, automatically as you type. You can select from the list of suggested records to go directly to the record you need. The following tips relate to the auto suggest feature:

- If global search keywords include an extremely large number of matches, a list of suggested matches is not provided, and you are instructed to refine keywords to narrow the search results. If you do not want to refine keywords, you can click Go to return full results.
- You can scroll through a list box of suggested matches using the mouse, or the up and down arrows, and select from a list using the mouse, Enter, or Tab.
- You can select from the list, or click the Go button to return a list of all matches.
- The record type of each suggested match precedes the record's name.
- To open a suggested match in view mode, click directly on the record name.
- To open a suggested match in edit mode, click **Edit** that appears at right.
- To open a record in a new tab or window, right-click on the record name or **Edit**, and choose Open in New Tab or Open in New Window.
- To open the customer dashboard for a suggested customer record match, click the View Dashboard icon that appears at right.
- The suggestion box displays a maximum of 10 results. If there are more matches, a Show More Items link is provided that you can click to view all suggested matches.
- If only one suggested match is returned, by default NetSuite automatically selects that record.
- If you have enabled the Show List When Only One Result preference on the Analytics tab of Home > Set Preferences, NetSuite does not select a single suggested match automatically.
- If you do not want a list of suggested matches to appear when you enter keywords in the Search field, you can disable the auto suggest feature by clearing the Global Search Auto Suggest box on the Analytics subtab of Home > Set Preferences.

### Quick Find

NetSuite provides quick find capabilities from many pages, so that you can quickly find another record of the same type.

Quick Find is available when a magnifying glass icon 🕵️‍♀️ is shown in a page header.

### Transactions Quick Find

You can click the Quick Find icon on a transaction page to find a specific transaction, or set of transactions of the same type, based on their dates, numbers, or associated entity name.

When you click the icon, a Quick Find popup opens. In the popup, enter a name, date, transaction number, or a combination, and click Submit.
If one transaction matches, as in cases where you enter a number, its transaction record opens.

If more than one transaction matches, as in cases where you enter a name or a date, a Found page opens with a list of matching transactions. Each transaction in the list includes a link that you can click to open its transaction record.

**Records Quick Find**

You can click the Quick Find icon on a record page to quickly search records of the same type.

When you click the icon, a popup keywords box opens. Type in keywords, and press Enter or click the Go button.

- If one record matches your keywords, the record opens.
- If more than one record matches, a Search Results page opens with a list of matching records. Each record in the list includes links that you can click to open the record in view or edit mode. This results page also includes the buttons included on other search results pages, so that you can email or export search results.

For example, when viewing a customer record, click the Quick Find icon in the header, enter keywords in the box, and press Enter to find all customer records that match the keywords.

**Quick Search Portlet**

You can add a Quick Search portlet on most pages. In this portlet, you can search for data that matches your entered keywords for the selected field.
After you add the portlet, you can click its setup link to specify the type of data to be searched. You also can set user-level preferences to include inactive data in searches, and to alter the logic for keyword matching.

For information about using Quick Search, see:

- Adding a Quick Search Portlet
- Setting Up a Quick Search Portlet
- Setting Quick Search Preferences
- Finding Records with the Quick Search Portlet
- Customizing Quick Search Results

**Adding a Quick Search Portlet**

1. Click **Personalize** on the page where you want to add the portlet.
2. In the Standard Content tab of the Personalize Dashboard palette, click or drag and drop the **Quick Search** icon.

**Setting Up a Quick Search Portlet**

1. Click **Set Up** on the portlet menu to open the Quick Search Setup popup window.

2. In the **Search Type** list, select the type of search you want.
   - **General** means a search for data that NetSuite defines as records, such as customers, campaigns, and vendors.
   - **Transaction** means a search for data that NetSuite defines as transactions, such as cash sales, sales orders, and purchase orders.
3. In the **Default General Search Type** list, you can select a type of record to be searched. If you do not make a selection, all records are searched.
4. In the **Default Transaction Search Type** list, you can select a type of transaction to be searched. If you do not make a selection, all transactions are searched.
5. Click **Save**.

**Setting Quick Search Preferences**

1. Go to Home > Set Preferences, and click the **Analytics** subtab.
2. To include inactive records in searches, check the Include Inactives in Global and Quick Search box. (By default, only active records are included.)

3. If you want Quick Search to return records with names/IDs that start with keywords you enter and records with names/IDs that contain those keywords, check the Quick Search Uses Keywords box.

If you do not enable this preference, the Quick Search portlet includes Starts With and Contains option buttons. Searches can return either records with names/IDs that start with keywords or records with names/IDs that contain keywords, based on the option button selection. Enabling this preference removes the option buttons.

4. Click Save.

Finding Records with the Quick Search Portlet

1. In the Quick Search portlet, enter keywords to match to the name or ID of the record you want to find.

If available, select the Starts With or Contains option button to determine keyword matching logic. For more information, see Setting Quick Search Preferences.

2. In the Search For list, select the field name of the name or ID to be used for keyword matching.

3. Click the Search button.

A page opens with a list of results. Depending upon your permissions, you may be able to do the following:

- Click an Edit or View to open an individual record.
- Click Return to Criteria to open a search form that includes your entered keywords.
- Click Save this Search to create a saved search.
- Click on of the export icons 📃 to export the list of results.
- Click the print or email icons 📝 to print or to email search results to one or more recipients.

Customizing Quick Search Results

You can use either of the following methods to customize your quick search results:

- Using the Search Customization Page
- Setting a Saved Search to be Used as Preferred Search Results

Using the Search Customization Page

You can access a simple search customization page by clicking the Customize button at the top of the quick search results page. The Customize button is available when all results records share the same record type and you have at least the Edit level of the Perform Search permission.
On this simple search customization page, you can:

- Change the search title. Default is: Preferred Search Results - <record type>
- Change the displayed results columns, by adding or removing fields on the Results subtab. You also can change the sort order of records and column labels.
- Add fields to be available as filters in the results page footer, on the Available Filters subtab. (Note that if you clear the Show in Footer box for a field here, this filter field does not display on results pages.)
- Click More Options to display a full saved search definition page, where you can edit other options. (Note that if you make changes to other options on this page, these settings are preserved when you return to the simple customization page, even though they are no longer visible.)
- Click Save to use these customized search settings for all of your quick search results for the record type.
- Click Cancel to return to the quick search results page, with no changes.

**Setting a Saved Search to be Used as Preferred Search Results**

You can apply settings from a saved search that you own to customize your quick search results, by checking the My Preferred Search Results box, on the Results subtab of the saved search definition page.
Administrators and other users with the Publish Search permission can set a saved search's settings to customize quick search results for other users, on the Roles subtab of the saved search definition page.

- To set a saved search's settings to customize quick search results for users assigned a selected role, check the Results box for that role.
- To set a saved search's settings to customize quick search results for all roles, ensure the Public box is checked, and check the Preferred Search Results box.
**Finding Invoices, Bills, Orders, and Other Transactions**

Invoices, bills, orders, cash sales, and many other records are considered transactions by NetSuite. To be able to find any of these records, you need to use the Transaction search type.

**To search for invoices, bills, orders, and other transactions:**

1. Go to Reports > New Search.
2. Select **Transaction** as the search type.
3. In the **Type** list, select the type of transaction you are looking for. You can select **Invoice**, **Bill**, **Cash Sale**, **Purchase Order**, or any other available type of transaction.
   
   To select multiple transaction types, hold down the Ctrl key and select the types.
4. Define other search options, if needed.
5. Click **Submit**.

Similarly, if you are defining a saved search, you can add a Type filter on the Criteria tab of your saved search and set this filter to Invoice, Bill, Purchase Order, or any other type of transaction you are looking for. To learn more about saved searches, see **Saved Searches**.

See also **Finding Transactions**.
Running Searches

You can use NetSuite search pages to define sophisticated filtering criteria and results formatting options. Each search page is tailored to a particular record type. Search pages are accessible from a large number of menu links, including general search links on the Reports tab, and subject area-specific links on other tabs.

Each search page offers a choice of two levels:

- **Simple search**, where you can enter one or more field values to be used as filters for search results. See Defining a Simple Search.
- **Advanced search**, where you can enter additional criteria for filtering, including formulas containing SQL expressions and filtering by join field values in related records, define sort order for results, and define groupings for results with summary calculations that can be used as filters. See Defining an Advanced Search.

When you click a search link, the search that opens, simple or advanced, is the one you used most recently for the selected record type. If a simple search opens, and you want to switch to an advanced search, check the Use Advanced Search box. If an advanced search opens, and you want to switch to a simple search, clear the Use Advanced Search box.

You can click the Create Saved Search button on any simple or advanced search page to open a saved search page, where you can save a search definition for reuse. Saved search includes all of the functions of advanced search, and more, including the ability to send automatic, customizable emails of results, and to display summaries of results as key performance indicators in dashboard portlets. For more information, see Saved Searches.

Your account administrator grants general search permissions and search access, by record type, that enable you to run searches. Your level of search permissions determines whether you can email, export, and persist search results. For more information, see Permissions for Searches.

If your saved search takes a long time to run, you may consider setting up a scheduled email or persisting search results. For more details, see Enabling Saved Search Scheduled Email and Persisting Search Results.

For a list of record types that can be searched, see Searchable Record Types.

**Note:** A popup search page is available from popup select menus within individual records. This search opens either a simple or advanced search in a new popup window. A popup search does not provide all of the buttons available on other search pages. For more information, see Popup Searches.

**Searchable Record Types**

Other than global search, NetSuite searches are limited by record type, so each page where you enter search criteria includes fields specific to one type of record.

Simple, advanced, and saved searches are available for the standard record types in the following list. You also may have access to additional searches for custom record types created in your system.

Advanced searches let you include results and criteria of join fields from related record types. For information, see Related Records Fields Available for Advanced Searches.
Note: You may not have access to all of the searches in the following list. The record types available for you to search depend upon the role you use to log in and its assigned permissions and search access. See Permissions for Searches.

For more information about the following record types, see the help topic NetSuite Record Types.

**Standard Record Type Searches**

- Account
- Accounting Book (Multi-Book Accounts only)
- Accounting Period
- Activity
- Amortization Schedules
- Analytics Audit Trail
- Bank Statement Import
- Bill of Distribution
- Bill of Materials
- Bill of Materials Revision
- Billing Class
- Billing Rate Card
- Billing Schedule
- Billing Operation
- Billing Operation Schedule
- Bins
- Budget
- Budget Exchange Rates
- Campaign (includes marketing and sales campaigns)
- Campaign Template
- Case
- Charge
- Charge Rule
- Class
- Commissionable Item
- Company
- Competitor
- Consolidated Exchange Rates (OneWorld accounts only)
- Contact
- Cost Category
- Coupon Code
- Custom GL Lines Plug-in Audit Log
- Custom Segment
- Customer
- Deleted Record
- Department
- Distribution Network
- Document
- Email Template
- Employee
- Employee Change
- Employee Change Reason
- Employee Change Request
- Employee Change Request Type
- Employee Payroll Item
- Employee Status
- Employee Type
- Entity
- Event
- Fair Value Formula
- Fair Value Price
- Fax Template
- Financial Institution
- Folder
- Generic Resource
- Gift Certificates
- Global Account Mapping (Multi-Book Accounts only)
- Global Inventory Relationship
- Group
  (The use of "Group Member Fields..." is not supported for searches that include dynamic groups.)
- Inbound Shipment
- Information Item
- Installment
- Inventory and Bin Numbers
- Inventory Balance
- Inventory Cost Template
- Inventory Detail
- Inventory Numbers
- Inventory Status
- Issue
- Item
- Item Account Mapping (Multi-Book Accounts only)
- Item Collection
- Item Demand Plan
- Item Location Configuration
- Item Supply Plan
- Job
- Job Requisition
- Kudos
- Location
- Location Costing Group
- Login Audit Trail
- Manufacturing Cost Template
- Manufacturing Operation Task
- Manufacturing Planned Time
- Manufacturing Routing
- Memorized Transaction
- Merchandise Hierarchy Level
- Merchandise Hierarchy Node
- Merchandise Hierarchy Version
- Message
- Multi-Book Accounting Transaction (Multi-Book Accounts only)
- News Item
- Nexus
- Online Case Form
- Online Lead Form
- Opportunity
- Organizational Value
- Outbound Requests
- Partner
- Paycheck
- Payment Event
- Payment Processing Profile
- Payroll Batch
- Payroll Item
- Phone Call
- Planned Standard Cost
- Pricing (You can set up an item search to generate a price list. See Using Search for Price Lists.)
- Project
- Project Expense Type
- Project Resource
- Project Task
- Project Task and CRM Task
- Project Task Manager Criteria
- Project Task Manager Search
- Project Template
- Promotion
- Quota
- Report
- Resource Allocation
- Resource Group
- Revenue Element
- Revenue Recognition Event
- Revenue Recognition Plan
- Revenue Recognition Schedules
- Revenue Recognition Templates
- Role (available only to users with Manage Roles permissions, at Setup > Users/Roles > User Management > Manage Roles > Search)
- Sales Campaign
- Saved Search
- Sent Email List (Administrators can access from Setup > Company > Communication > Sent Email List.)
- Scheduled Script Instance
- Script
- Script Deployment
- Server Script Log
- Shipment Package
- Shipping Item
- Shipping Partner Package
- Shipping Partner Registration
- Shipping Partner Shipment
- Shopping Cart
- Solution
- Standard Cost Version
- Subsidiary (OneWorld accounts only)
- Supply Chain Snapshot
- System Email Template
- System Note
- Task (CRM Tasks)
- Tax Agency
(Tax agency is a category of vendor. To do a tax agency search, filter a vendor search to records with a Category of Tax agency.)

- Tax Group
- Tax Item (also known as Sales Tax Item, Tax Code)
- Tax Type
- Termination Reason
- Time (if Time Tracking feature enabled)
- Time-Off Change
- Time-Off Plan
- Time-Off Request
- Time-Off Type
- Timesheet
- Token-based Authentication Application
- Topic
- Transaction (Transaction is considered one record type, although it can encompass a wide assortment of records.)
- Transaction Numbering Audit Log
- Two-Factor Tokens
- Undelivered Emails (Administrators can access from Lists > Mailing > Undelivered Emails.)
- Units Type
- User Note
- Vendor
- Web Services Operations
- Web Services Record Processing
- Work Calendar
- Workflow
- Workflow Instance
- Workplace

Defining a Simple Search

A simple search page displays the selected record type's fields, with dropdown lists or boxes where you can select or enter values to filter the records returned by the search. Some fields also have dropdown lists where you can select comparison logic.

- To run a simple search, go to Reports > New Search and choose the type of records you want to find.
- (If the Use Advanced Search box is checked, clear it to switch to a simple search.)
- If you need help in defining filters for a simple search, click on a search page field's label to view its online help, or review Tips for Defining Simple Search Filters.

After you have defined one or more filters for a simple search, you can:

- Click Submit to run the search and display a list of results.
Defining a Simple Search

- Click **Export** to run the search and save results to a .csv, .xls, or .pdf file that you can save to disk or open on your desktop. For more information, see Exporting Search Results.
- Click **Reset** to clear the filters you defined.
- Click **Personalize** Search to display a page where you can define fields and available filters for a personalized search form.
- Click **Create Saved Search** to display a page where you can save and modify a search that includes the filters you defined.

**Note:** Some search date filters let you include specific times of day. These times are adjusted automatically for users’ local time zones. For information about defining search date filters and some other filters, see Defining Search Date Filters.

Tips for Defining Simple Search Filters

NetSuite provides many dropdown lists and popups to assist you in defining search filters. For additional information, review the following tips.

- The search date filters offer a complex set of options. For help with these filters, see Defining Search Date Filters.
- To avoid displaying multiple lines for each transaction in transaction search results, include a criteria of Main Line is True or click the Yes option button for the Main Line field.
- Select **any of** to include all of the field values you select and **none of** to exclude all of the field values you select.
- For fields with multi-select boxes, press and hold the Ctrl key to select multiple field values.
- For some text fields, select **starts with** or **contains** if you know only part of the name or title.
- For searches that support keywords, you can use **OR** as a separator to search for multiple text strings at the same time. You must enter **OR** in uppercase for it to be recognized as a separator.
- When you enter text, you can use **%** to match any string of characters and **_** to match any single character. For example, if you search for **aa%r fra%i**, your results will include Aaron Frankenstein and Frangelica Aardvark.
- When you enter purely numeric keywords, remember that only advanced matches are returned, unless you include the % wildcard.
- In some fields, you can select **-Unassigned-** to find transactions that are not tied to an employee **-Mine-** to find only transactions associated with you, or **-My Team-** to find transactions associated with you or your subordinates.
- When the ANY operator is selected for a field, this filter will not be used in the search.
- When you add some value and the ANY operator is selected, the operator changes to ‘has keywords’ in case of the text field (to ‘equal to’ in case of number field) by default.

**Defining Search Date Filters**

NetSuite provides three different types of date filters: a named time period, like **last fiscal year**, a custom date range defined by a specific start date and end date, and a relative date range defined by a beginning number of days, weeks, months, quarters, or years **ago** or **from now**, to an ending number of same.

Some date fields let you include specific times of day in custom date range filters and in filters for named time periods such as today, tomorrow, and yesterday. For these fields, relative date range filters are not available.
Defining a Simple Search

In the first Date dropdown list, select search logic. Any of the options can apply to a named time period, but you need to select within or not within for a custom or relative date range.

In the second dropdown list, select a named time period, or select custom if you want to define start and end dates in the From and To fields, or select relative if you want to define a relative date range.

To use the From and To fields to set a custom date range filter, click on the calendar icons to enter a starting date in the From field and an ending date in the To field.

To include specific times of day in custom date range filters or named time period filters such as today, tomorrow, and yesterday, select the times in the From and To dropdown lists, or enter times directly in the editable fields next to the dropdown lists.

Note: The times that you enter for search date filters are adjusted automatically for users' local time zones.

To use the From and To fields to set a relative date range filter, enter the beginning and ending numbers and select calendar units (days, weeks, months, quarters, or years; ago or from now) from the dropdown lists in the From and To fields. Be sure to put the earlier date (for example, 90 days ago) in the From field, and the later date (for example, 0 days ago) in the To field.

Defining an Advanced Search

An advanced search page includes a Criteria subtab where you can define filters for searches, and a Results subtab where you can define display options for search results.

To run an advanced search:

1. Go to Reports > New Search and choose the type of records you want to find.
2. Select the Use Advanced Search box to switch to advanced search.
3. Define the Criteria filters. See Advanced Search Criteria Filters.
4. Define the Results display options. See Search Results Display Options.
5. After you have defined criteria and results display options for an advanced search, you can:
   - Click Submit to run the search and display a list of results.
     After you have submitted the search, you can export the results as .csv, .xls, or .pdf files that you can save to disk or open on your desktop. For more information, see Exporting Search Results.
   - Click Reset to clear the criteria and results options you defined.
   - Click Personalize Search to display a page where you can define results columns and available filters for a personalized search form.
   - Click Create Saved Search to display a page where you can save and modify a search that includes the filters you defined.
     To learn more about saved searches, see Saved Searches.

Advanced Search Criteria Filters

You can define advanced filtering options for advanced searches and saved searches. You select filter fields and define their values on the Criteria subtab’s Standard and Summary subtabs.
A standard search filter selects results based on individual records' values for a field. You can define And/Or expressions for standard search filters by checking the Use Expressions box.

If you add a field for which you do not have permission, you will see the following message, “Your formula contains a reference to a field for which you do not have a permission.”

A summary search filter selects results based on calculated summary field values for a group of records; this filter is available only if you have defined a summary type for a field on the Results tab.

- Defining Standard Search Filters
- Using And/Or Expressions in Search Criteria
- Summary Search Filters

⚠️ **Important:** If you define multiple date filters for a search, the date filter with the most recent date is used to calculate exchange rates for monetary values, no matter the order in which the date filters are specified.

### Defining Standard Search Filters

You can define the following as filter fields on the Criteria, Standard subtab of an advanced or saved search: the selected record type's fields, related record types' join fields, and formulas. For some types of searches, you also can define values from attached files as filters.

**Note:** To use a saved search as a custom KPI that displays results for multiple date ranges, you must not define a date field as a filter on the Criteria subtab. For additional requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom KPIs.

**To define a field value from the selected record type as a filter:**

1. Select the field from the Filter dropdown list. (The fields are listed in alphabetical order.)
2. Click the **Set Description** button to the right of the filter field to open a popup where you can define the filter by entering a value and search logic (if available).
3. Click **Add** to choose the next filter.
Defining an Advanced Search

To define a join field value from a related record type as a filter:

1. Select the related record type in the Filter dropdown list. (Related record types that have join fields available to be used as filters are listed at the end and are followed by ‘...’, for example, Account Fields...)
2. In the first popup that appears, select the join field from the related record type you selected.
3. In the next popup, enter a value, and search logic (if available), for the filter field, and click Set.
4. Click Add to choose the next filter.

For a list of related record types with join fields available for each record type search, see Related Records Fields Available for Advanced Searches.

To define a formula as a filter:

1. Select a Formula option from the Filter dropdown list.
2. Click the Set Description button to open a popup where you can enter the formula.
3. Click Add to choose the next filter.

For more information, see Formulas in Search.

Note: If you want to use parenthetical expressions to define search filters, check the Use Expressions box. For more information, see Using And/Or Expressions in Search Criteria.

To define a field from an attached file (such as the file's name) as a filter:

1. Select File Fields... in the Filter dropdown list.
2. In the popup that appears, select a field from the File Filter dropdown list.
3. Click the Set Description button and in the popup, enter or select a value for the filter field, and click Set.
4. Click Add to choose the next filter.

For more information, see Searching by File Attachments.

Using Encrypted Fields in Searches

Searches and saved searches support the use of custom fields with encrypted values. Encrypted fields can be used in search results columns. They can also be included in search criteria filters with a limited
Defining an Advanced Search

set of operators (is, is not, is empty, is not empty). However, encrypted fields cannot be used in search formulas, highlighting, summary results, or summary criteria. Also, SuiteScript does not support saved searches with encrypted stored values. Please note that credit card numbers can be displayed in search results only when the user who runs the search has the View Unencrypted Credit Card Numbers permission. For more information about credit card number security, see the help topic Payment Card Number Security and Compliance.

Defining Preferred Vendor Filter for Item Search in OneWorld Account with Multiple Vendors Feature Enabled

If you define the Preferred Vendor field as a filter for an item search in a OneWorld account that has the Multiple Vendors feature enabled, you may encounter the following issue: If an item has more than one preferred vendor, the search is only capable of displaying the item under one of the preferred vendors, which happens to be the first one listed on the item record. This case is possible because there can be multiple preferred vendors in a OneWorld account that has the Multiple Vendors feature enabled, with a different preferred vendor per subsidiary.

To avoid this issue, instead of using the Preferred Vendor field as a filter, use a combination of the Vendor field and Vendor is Preferred field in filter criteria for the item search. Set the value for the Vendor filter field to be any of the vendors you wish to include, and set the value for the Vendor is Preferred field to be Yes. An item search with these filter criteria will return all items where at least one of the subsidiaries has any of the designated vendors as the preferred vendor.

Limitations on Credit Card Number Search Filters

To maintain the security of customers’ credit card information, as of January 9, 2014, search criteria based on the Credit Card Number field can use only the following operators: is empty or is not empty. This limitation applies to searches executed in the NetSuite UI, as well as those executed programmatically through SOAP web services, SuiteScript, and SuiteFlow.

The Credit Card Number search criteria field has been changed from a text to a check box type field. If you select this field on the Criteria subtab of a search definition page, you have options to filter search results by a value of Yes or No for this field. So you can filter search results based on whether or not they include a credit card number, but you cannot search based on actual credit card number values.

Note: To comply with current limitations, any previously existing saved searches that used operators other than is empty or is not empty, such as contains, is, or is not, with the Credit Card Number field have been deleted from all NetSuite accounts.

Using And/Or Expressions in Search Criteria

You can use parenthetical expressions in search criteria that you define for advanced searches and saved searches. When you create expressions, you can define a string of criteria connected by AND or OR logic.

For example, you can search for customers who live near your store location in CA by entering (city is San Francisco AND phone starts with 415) OR (city is Los Angeles AND phone starts with 310) OR (city is San Diego AND phone starts with 619).

NetSuite addresses parenthetical clauses from an order of inside-to-outside. For example, (clause1 AND ((clause2 OR clause4) AND (clause5 OR clause6))) OR clause7. Clauses are addressed in the following order:

'((clause2 OR clause4) AND ((clause5 OR clause6)))' and '(((clause2 OR clause4) AND (clause5 OR clause6)) OR clause7', second '((clause2 OR clause4) AND (clause5 OR clause6)) AND clause7', third '((clause2 OR clause4) AND (clause5 OR clause6)) AND (clause5 OR clause6)', fourth '(((clause2 OR clause4) AND (clause5 OR clause6)) OR clause7).
We can show it on Transaction saved search with these criteria:

```
(Type is 'Journal' AND
(Account is 'Sales Orders' OR
Account is 'Purchase Orders')) OR
Account is 'Estimates'
```

This search returns all transactions with the Estimates account (does not depend on transaction Type) and all Journal transactions with the Sales Orders or Purchase Orders accounts.

To define search criteria using expressions:

1. On the Criteria subtab of an advanced or saved search, check the Use Expressions box.
2. To indicate that an expression sets criteria for records or transactions that you do not want to include in your results, check the box in the Not column.
3. In the Pares column, select an opening parenthesis to begin an expression.
4. In the Filter column, select a field from the record or transaction to set criteria with.
   For more information about defining filters, see Defining Standard Search Filters.
5. In the popup window, set criteria for your filter, and click Set.
6. In the Pares column, you can choose to close the parentheses, or you can leave the column blank to add to your expression.
7. In the And/Or column:
   - Select And to enter criteria in the next line that records or transactions must also meet to be in your results list. Records or transactions must match all criteria you set in a string connected by And.
   - Select Or to enter criteria in the next line to return records or transactions that match criteria in either the first line of criteria or the next line you are adding. Records or transactions can match any criteria in a string connected by Or.
8. In the Pares column, close your parentheses to end an expression.
9. Click Add when you have finished a line of criteria.
10. After setting your criteria:
    - If you are conducting an advanced search, set how you want your results to appear, and click Submit.
    - If you are saving or customizing a search, set how you want your results to appear and set up your available filters, and then click Save.
**Important:** If the Use Expressions option is enabled for a search, inline editing is disabled in list, dashboard, and sublist views based on that search. If you want inline editing to be available for a view, ensure that the Use Expressions box is not checked for the search that filters view results.

**Main Line in Transaction Search Criteria**

Main line refers to the **Primary Information** field group in a transaction, as opposed to line item data entered on the transaction's tabs.

In the following example, 1 indicates the transaction's main line data, and 2 indicates the transaction's line item data.
Defining an Advanced Search

By default, the main line and line item data for each transaction appear on separate rows in the search results. To configure the search results to display either the main line data rows only or the line item data rows only, you can use the Main Line filter on the search Criteria tab.

**Note:** If the Results tab of your search contains the * (main line) filter, the main line data rows in the search results are marked with *. 

**Warning:** The Main Line filter is not supported for transaction searches where the type is set to Journal Entry.

The Account (Main) field represents the account that is shown in the results when the criteria include Main Line is true. For example, Account (Main) for an invoice is an accounts receivable account, but the Account for lines on the invoice are specific to the item, billable expense, or billable time.

**When Main Line is set to true**

When you add the Main Line filter on the search Criteria tab and set it to true (Yes), the search results display one row per transaction, whereas the line item details are omitted.

**When Main Line is set to false**

When you add the Main Line filter on the search Criteria tab and set it to false (No), the search results display one row per line item, but these rows may still include some of the main line data.
Summary Search Filters

If you defined summary types for any of your search results columns, you can apply additional filters to the summary results page of this search. For more information about summary types for results fields, see Defining Summary Types to Roll Up Search Results.

**Note:** For more details about summary types, see Summary Type Descriptions and Summary Type Example Screenshots.

The summary search results page displays only those results fields that have a summary type assigned. The rest of the results fields are available in the detailed search results view that opens when you click an item on the summary search results page.

Additional filtering can be applied only to the fields that are displayed on the summary search results page.

**To apply additional filtering to summary search results:**

1. On the Criteria tab of the search definition page, click the Summary subtab. To learn more about the search definition page, see Defining an Advanced Search and Defining a Saved Search.

2. In the Summary Type and Field columns, select the options that match the field and its summary type defined on the Results tab of the search.

**Warning:** If you use a multi-select related record type or a multi-select field from a related record type to define your summary search filter, your search results may be multiplied. (Related record types that have join fields available to be used as filters are listed at the end of the field list and are followed by ‘...', for example, Account Fields...). There is currently no workaround for this feature.

3. Click the Set Description button next to the field you selected.

4. In the popup that opens, enter a value and search logic (if available) for the field used as a filter, and click Set.

5. The filter value appears in the Description column.

**Warning:** KPIs cannot enforce summary search filters, because KPI calculations do not include groupings. If a saved search used as a custom KPI includes any summary search filters, the result for the KPI may differ from results when the search is run.

Search Results Display Options

You can define search results display options for advanced searches and saved searches on the Results subtab.
Defining an Advanced Search

On the Results subtab, you can:

- Select the fields to be displayed on search results page. For details, see Selecting Fields to Display in Search Results.
- Enter custom labels for results fields to appear instead of field names and, optionally, define translations for these custom labels. For details, see Entering Custom Labels for Search Results Columns.
- Define summary types for results fields to calculate values for groups of records. For details, see Defining Summary Types to Roll Up Search Results.
- Define “when ordered by fields” to maximize another field’s value for a results field. For details, see Using When Ordered By Field for Search Results.
- Show totals for search results. For details, see Showing Totals in Search Results.
- Apply functions to results fields. For details, see Applying Functions to Search Results Columns.
- Set the sort order for fields and define overall formatting. For details, see Defining Order and Overall Formatting for Search Results.

For transaction searches in NetSuite OneWorld accounts with the Multiple Currency feature enabled, you can also select the consolidated exchange rate type to apply. For details, see the help topic Consolidated Exchange Rate Types for Transaction Searches.

### Selecting Fields to Display in Search Results

On an advanced search or saved search page, you can select the following to display in search results: the selected record type’s fields, related record types’ join fields, and formulas. For some types of searches, you also can define values from attached files to display as results columns.

**Note:** If you include a Multiple Select field in the results of a saved search, there is a 4000 character limit on the values that can be displayed for the field.

**To add a field from the selected record type to be shown in results:**

1. Select the field from the Field dropdown list and click **Add**. (The fields are listed in alphabetical order.)
   
   You can add multiple fields at the same time by clicking the **Add Multiple** button to open a popup. In the popup, select multiple fields, holding down the Ctrl key and click the **Add** button. (Fields appear in the results list in the same order you selected them in the popup.)
Defining an Advanced Search

**Note:** For a transaction search, adding a field that has multiple values for one record causes that record to occur multiple times in the search result. Also, if results include a record with a link type that has multiple values for that record, duplicates occur in results, even if the link type field is not included as a search results field.

To define a join field value from a related record type to be shown in results:

1. Select the related record type in the Field dropdown list.
2. In the popup that appears, select the Join field from a Field dropdown list.
3. Click Add.

For a list of related record types with join fields available for each record type search, see Related Records Fields Available for Advanced Searches.

To define a formula used to calculate values shown in results:

1. Select a Formula option from the Field dropdown list.
2. In the Formula column, click the Set Formula button to open a popup where you can enter a formula expression.
3. Click Add.

For more information, see Formulas in Search.

To select a field from an attached file to be displayed with results:

1. Select File Fields... in the Field dropdown list.
2. In the popup that appears, select a field from the File Field dropdown list.
3. Click Add.

For more information, see Searching by File Attachments.

## Entering Custom Labels for Search Results Columns

By default, the header for a search results column is the field name or formula type. On an advanced or saved search page's Results subtab, you have the option of defining more descriptive labels for columns.

**To enter a custom label for a field:**

1. Click the Custom Label column next for a field and enter a name to be displayed for its results page column.
2. Click OK.

**To add translations for a custom field:**

1. Click the Custom Label Translation column next to the custom label and add translations into one or multiple languages.
2. Click Done.
Defining Summary Types to Roll Up Search Results

The Results subtab for an advanced or saved search includes a summary type column where you can define how to roll up, or group, data. When you define one or more summary types, a search returns a summary results page, where you can drill down to each group of results.

- First you need to define a Group summary type for the field you want to use to group results. The summary results page displays a list of values for this grouped field. You can click a value to drill down each group of results.

  For example, in a customer search, you can define a Group summary type for the sales rep field. The summary results page includes a list of all sales reps, and you can click each sales rep to see a list of their customers.

- After you have defined a Group, you can define another summary type to provide quantitative results on the summary results page:
  - Count - Counts the number of results for the field. Counts are usually defined on name or ID fields to get a count of records for each group.
  - Sum - Sums values for the field.
  - Minimum - Displays the minimum amount, or the earliest date value.
  - Maximum - Displays the maximum amount, or the most recent date value.
  - Average - Calculates the average value for the field.

  For example, in a customer search grouped by sales rep, you can define a Count for the customer name field, to display a count of customers for each sales rep. Or, you can define a Sum on the balance field, to display a total balance for each sales rep's customers.

Any field that does not have the same name listed in search criteria field listing (Criteria subtab > Standard subtab) will not be available for drilldown when grouped in Results subtab > Columns subtab.

The results pages where you drill down, by clicking links on the summary results pages, do not include their own subtotals. To add these subtotals on drilldown results pages, check the Show Totals box on the Results subtab. See Showing Totals in Search Results.

There is a special case where you can use a Minimum or Maximum summary type to minimize or maximize the value for a second field, rather than the results field, to return a value for the results field where another field value is minimal or maximal. In this case, this other field should be selected as the When Ordered By Field. See Using When Ordered By Field for Search Results.

For more information, see Summary Type Descriptions and Summary Type Example Screenshots.

**Note:** To use a saved search as a custom KPI that displays results for multiple date ranges, you must have only one field with a summary type defined. For additional requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom KPIs.

Using When Ordered By Field for Search Results

The When Ordered By Field option provides search results that return the value for a field when the value for another field is minimal or maximal. For example, you could use this option to return the:

- amount for the most recent sales order by each customer
- contact for the most recent case filed by a customer
- sales rep for the top transaction by month
- item with the largest transaction per month
When Ordered By Field is available when you select a Summary Type of either Minimum or Maximum, on the Results subtab of a search record.

Normally, the When Ordered By Field is a date field or a quantitative field. A Maximum summary type would find the record with the most recent date or largest quantity. A Minimum summary type would find the record with the earliest date or smallest quantity. (All of the examples above would use a Maximum summary type.)

**Important:** If the field you define in the When Ordered By Field contains NULL values, these records appear last in the search results. However, if you use the Maximum summary type, records with NULL values appear first. To avoid this, do not use the Maximum summary type with the When Ordered By field set to a field with NULL values.

To return the value of a search results field when another value is minimal or maximal:

1. On the Results subtab of an advanced or saved search, in the Field column, select the field for which you want to return a value.
2. In the Summary Type column, select either Minimum or Maximum, depending on whether you want the value to be returned from the record where the When Ordered By field is minimal, or from the record where the When Ordered By field is maximal.
3. Select the field that you want to be minimized or maximized in the record returned.

For example, to return the amount for the most recent transaction by each customer, create a Customer search, select a results Field of **Formula (Date)**, a **Summary Type** of Maximum, and a **When Ordered By** field of Date Created.

**Note:** When Ordered By field does not support Long Text and Rich Text fields. Fields of these types are not available for selection in the dropdown list.

'When Ordered By' in NetSuite has the same behavior as Oracle's analytic 'keep dense_rank'. For example, when the following transactions are present:

<table>
<thead>
<tr>
<th>Name</th>
<th>Amount</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>123</td>
<td>01/23/2014</td>
</tr>
<tr>
<td>mike</td>
<td>10</td>
<td>05/12/2014</td>
</tr>
</tbody>
</table>
If you want to know when the last transaction with the highest amount was created, go to the Results tab and add these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Summary Type</th>
<th>When Ordered By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Maximum</td>
<td>Amount</td>
</tr>
</tbody>
</table>

The result is: 06/12/2014.

If you want to select the highest amount for the most recent transaction by each customer, go to the Results tab and add these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Summary Type</th>
<th>When Ordered By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>Maximum</td>
<td>Date</td>
</tr>
</tbody>
</table>

The result is:

<table>
<thead>
<tr>
<th>Name</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>15</td>
</tr>
<tr>
<td>Mike</td>
<td>10</td>
</tr>
<tr>
<td>Peter</td>
<td>777</td>
</tr>
</tbody>
</table>

If you want to select the lowest amount for the earliest transaction by each customer, go to the Results tab and add these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Summary Type</th>
<th>When Ordered By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>Minimum</td>
<td>Date</td>
</tr>
</tbody>
</table>

The result is:

<table>
<thead>
<tr>
<th>Name</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>456</td>
</tr>
<tr>
<td>Mike</td>
<td>-13</td>
</tr>
<tr>
<td>Peter</td>
<td>777</td>
</tr>
</tbody>
</table>
Showing Totals in Search Results

The Results subtab for an advanced or saved search includes a Show Totals check box. Check this box to add a total line to the results page. This line displays a total for any column that has quantitative values.

For example, Show Totals was checked for the following search:

If a search also includes a summary type that groups results, the total line is added to drill-down results pages. The summary results page includes the total line by default, regardless of the Show Totals setting.
For information about grouping and summing search results, see **Defining Summary Types to Roll Up Search Results**.

**Applying Functions to Search Results Columns**

For each search results column, you have the option of applying a function to transform its data value into a format most useful for your purposes.

**To apply a function to a field’s values on the results page:**

1. In the Function dropdown list for a field, select the function to use:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Total</td>
<td>Calculates the percentage contributed by each record to the sum of all records in the search results.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Absolute Value</td>
<td>Returns the absolute value of a number.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Age in Days</td>
<td>Calculates the days passed since a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Age in Months</td>
<td>Calculates the months passed since a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Age in Weeks</td>
<td>Calculates the weeks passed since a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Age in Years</td>
<td>Calculates the years passed since a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Calendar Week</td>
<td>Returns the first day of the week for a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Day</td>
<td>Returns a full date.</td>
<td>Date</td>
</tr>
<tr>
<td>Month</td>
<td>Returns the month of a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Negate</td>
<td>Returns the value with the opposite sign.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Number as Time</td>
<td>Converts the number value to hours and minutes. For example, 15.489 is converted to 15:29.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Quarter</td>
<td>Returns the quarter of the year for a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Rank</td>
<td>Returns the rank of each row when search results are ordered by column.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Round</td>
<td>Rounds the value to the nearest integer.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Round to Hundredths</td>
<td>Rounds the value to two decimal places.</td>
<td>Numeric</td>
</tr>
</tbody>
</table>
### Defining an Advanced Search

**Function** | **Description** | **Field Type**
--- | --- | ---
Round to Tenths | Rounds the value to one decimal place. | Numeric
Week of Year | Returns the week of the year for a date. | Date
Year | Returns the year for a date. | Date

1. Click **Done**.

### Defining Order and Overall Formatting for Search Results

On the Results subtab for advanced and saved searches, you can set the order in which columns appear, the sort order for rows, and overall formatting for the search results page.

**To set the order in which fields appear as results page columns:**

1. Select a field in the grid, and use the **Move Up**, **Move Down**, **Move To Top**, or **Move To Bottom** buttons.
2. Click **Done**.

**To define primary, secondary, and/or third sort fields for a search's returned records:**

1. Select fields in the Sort By and Then By dropdown lists.
2. Check the **Descending** boxes to sort in reverse order, if desired.

**Note:** By default, search results are sorted in the alphabetical order specific to your NetSuite language settings, but you can use the U.S. English sort order instead. To learn more about the Search Sorting option, see the help topic **General Personal Preferences**.

**Important:** Make sure you sort using the field with the most unique values, or sort using multiple fields. Sorting with a single field that has multiple identical values can cause the result rows to be in a different order each time the search is run.

**To define the format for a search results page:**

- Select one of the following options from the Output Type dropdown list:
  - Normal indicates a list page format.
  - Report indicates a results page formatted like a report.
  - Grid indicates a worksheet format with grid lines.
  - Graph indicates a bar graph of search results.

**To make search results available to users restricted from seeing the underlying records: (saved searches only)**

**Note:** You cannot grant a user access to record types for which they do not have sufficient permissions. The following procedure describes how to grant a user access to specific records by lifting restrictions. See the help topic **Permissions and Restrictions** for clarification on the difference between permissions and restrictions.

1. Check the **Run Unrestricted** box.
Defining an Advanced Search

This option enables administrators to make search results available to users who would normally be restricted from seeing the underlying records. Note that users without the correct permissions will still be unable to view the search results. See the help topic Permissions and Restrictions.

For example, an unrestricted saved search on leads could provide sales reps with the ability to identify potential duplicates before entering lead records.

If you enable this option, the Edit and View columns of search results are blank for users in roles without the required permissions.

2. **After you enable the Run Unrestricted option**, you can choose whether to allow search viewers to drill down into detailed records from summary-level search results.

   Check the Disallow Drill Down box to prevent viewers from drilling down into transaction-level data.

   For example, an unrestricted search with summary-level results listing sales reps' revenue totals could disallow drill down, to prevent viewers from seeing transaction-level data that includes sensitive commission amounts.

---

**Important:** The Run Unrestricted and Disallow Drill Down options for a search override restrictions set on users' roles, but do not override permissions. See the help topic Permissions and Restrictions for clarification on the difference between permissions and restrictions.

---

### Displaying the Number of Rows in List Segments

You can select the number of rows in list segments you would like to display in search results. Alter the number of rows based on your preferences.

**To alter the number of rows in list segments**

1. Go to Set Preferences page under the General tab.

2. Set the number of rows that you would like to display in the list segment as shown in the following screenshot.
3. Click **Save**.

**To define a maximum number of results that a search can display:**
(saved searches only)

- In the Max Results field, enter a number to represent the maximum number of records.
  
  If you define a Max Results limit, and the number of search results exceeds this limit, a "more..." notation displays after the last row of results.

**To define fields displayed when users drill down on search records:** (saved searches only)

The Results, Drill Down Fields subtab is available if you have the Presentation Categories permission, a Lists type permission. You do not have to be an administrator.

1. Click the **Drill Down Fields** subtab.
2. Select a field from the dropdown list, enter a custom label if desired, and click **Add**.
3. Repeat step 2 as necessary.
4. Use the **Move Up**, **Move Down**, **Move To Top**, or **Move To Bottom** buttons as necessary.

**Related Records Fields Available for Advanced Searches**

Some record types' advanced and saved searches let you define filters and display results columns based on join field values in related records. This capability enhances the power of your searches. For example, you can use this capability to search for customers according to the dates of their order transactions, or
to search for deposit transactions based on their related account numbers. The following table lists, for
each record type, the related record types with join fields that are available for advanced search filtering.
This information also is available in the Filter dropdown list on the Criteria subtab of each advanced
search page. In most cases, the same join fields also are available to be displayed as results columns, as
listed in field dropdown lists on the Results subtab.

![Note: You may not have access to all of the record type searches or related record types listed
in the table. The record types available to you depend upon the role you use to log in and its
assigned permissions and search access. See Permissions for Searches.](image)

<table>
<thead>
<tr>
<th>Advanced Search Record Type</th>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Accounting Book</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Accounting Period</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Activity</td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Amortization Schedules</td>
<td>Applied To Transaction</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Journal</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Vendor</td>
</tr>
<tr>
<td>Analytics Audit Trail</td>
<td>Author</td>
</tr>
<tr>
<td></td>
<td>Report</td>
</tr>
<tr>
<td></td>
<td>Role</td>
</tr>
<tr>
<td></td>
<td>Saved Search</td>
</tr>
<tr>
<td></td>
<td>Search Schedule</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Bill of Materials</td>
<td>Assembly Item</td>
</tr>
<tr>
<td></td>
<td>Revision</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td>Bill of Materials Revision</td>
<td>Bill of Materials</td>
</tr>
<tr>
<td></td>
<td>Component</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td>Billing Account</td>
<td>Bill To</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Ship To Subscription</td>
</tr>
<tr>
<td>Billing Class</td>
<td>Billing Class Rate</td>
</tr>
<tr>
<td></td>
<td>Units Type</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Billing Rate Card</td>
<td>Billing Class</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Time-Based Charge Rule</td>
</tr>
<tr>
<td>Billing Schedule</td>
<td>Workflow</td>
</tr>
<tr>
<td>Bins</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Budget</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Budget Exchange Rates</td>
<td>From Subsidiary</td>
</tr>
<tr>
<td></td>
<td>Period</td>
</tr>
<tr>
<td></td>
<td>To Subsidiary</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Campaign</td>
<td>Campaign Recipient</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Promotion</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Case</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Issue</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Charge</td>
<td>Billing Schedule</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Invoice</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Sales Order</td>
</tr>
<tr>
<td>Charge Rule</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Class</td>
<td>Unites Type</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Company</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Competitor</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Consolidated Exchange Rates</td>
<td>From Subsidiary</td>
</tr>
<tr>
<td></td>
<td>Period</td>
</tr>
<tr>
<td></td>
<td>To Subsidiary</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Contact</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Call</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Company (Primary)</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
<tr>
<td></td>
<td>Customer (Primary)</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Event</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Item Purchased (Upsell)</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
</tbody>
</table>
### Advanced Search Record Type

<table>
<thead>
<tr>
<th>Advanced Search Record Type</th>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity</td>
<td>Parent</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent Customer</td>
</tr>
<tr>
<td>Parent Customer</td>
<td>Parent Partner</td>
</tr>
<tr>
<td>Parent Partner</td>
<td>Parent Project</td>
</tr>
<tr>
<td>Parent Project</td>
<td>Parent Vendor</td>
</tr>
<tr>
<td>Parent Vendor</td>
<td>Partner (Primary)</td>
</tr>
<tr>
<td>Partner</td>
<td>Project (Primary)</td>
</tr>
<tr>
<td>Project</td>
<td>Project Rates</td>
</tr>
<tr>
<td>Rates</td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Subscription Message History</td>
<td>System Notes</td>
</tr>
<tr>
<td>Task</td>
<td>Task</td>
</tr>
<tr>
<td>Tax Registration</td>
<td>Transaction</td>
</tr>
<tr>
<td>Transaction</td>
<td>Upsell Item</td>
</tr>
<tr>
<td>User</td>
<td>User Notes</td>
</tr>
<tr>
<td>User Notes</td>
<td>Vendor (Primary)</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow History</td>
</tr>
<tr>
<td>Workflow History</td>
<td></td>
</tr>
</tbody>
</table>

### Cost Category

<table>
<thead>
<tr>
<th>Cost Category</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Transaction</td>
</tr>
</tbody>
</table>

### Coupon Code

<table>
<thead>
<tr>
<th>Coupon Code</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Custom GL Lines Plug-in Audit Log

<table>
<thead>
<tr>
<th>Custom GL Lines Plug-in Audit Log</th>
<th>Plug-in Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom GL Lines Plug-in Audit Log</td>
<td></td>
</tr>
</tbody>
</table>

### Customer

<table>
<thead>
<tr>
<th>Customer</th>
<th>ACT History</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Billing Rate Card</td>
</tr>
<tr>
<td></td>
<td>Billing Schedule</td>
</tr>
<tr>
<td></td>
<td>Call</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Contact (Primary)</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Customer Currency Balance</td>
</tr>
<tr>
<td></td>
<td>Event</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>First Site Visit</td>
</tr>
<tr>
<td></td>
<td>Hosted Page</td>
</tr>
<tr>
<td></td>
<td>Item Purchased (Upsell)</td>
</tr>
<tr>
<td></td>
<td>Lead Source</td>
</tr>
<tr>
<td></td>
<td>Login Audit Trail</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Online Case Form</td>
</tr>
<tr>
<td></td>
<td>Online Lead Form</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Parent Customer</td>
</tr>
<tr>
<td></td>
<td>Partner</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Resource Allocation</td>
</tr>
<tr>
<td></td>
<td>Sales Rep</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Shopping Cart</td>
</tr>
<tr>
<td></td>
<td>Sub Customer</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Top Level Parent</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>Upsell Item</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Web Site Category</td>
</tr>
<tr>
<td></td>
<td>Web Site Information Item</td>
</tr>
<tr>
<td></td>
<td>Web Site Item</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Deleted Record</td>
<td>User</td>
</tr>
<tr>
<td>Department</td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Document</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Employee</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Department</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Login Audit Trail</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Resource Group</td>
</tr>
<tr>
<td></td>
<td>Role</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Weekly Time Tracking</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Employee Change Request</td>
<td>Employee Change Request Change Type</td>
</tr>
<tr>
<td></td>
<td>Employee Change Request Employee</td>
</tr>
<tr>
<td></td>
<td>Employee Change Request Next Approver</td>
</tr>
<tr>
<td></td>
<td>Employee Change Request Requester</td>
</tr>
<tr>
<td>Employee Payroll Item</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Payroll Item</td>
</tr>
<tr>
<td>Entity</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Event</td>
<td>Attendee (Contact)</td>
</tr>
<tr>
<td></td>
<td>Attendee (Customer)</td>
</tr>
<tr>
<td></td>
<td>Attendee</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>First Site Visit</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Generic Resource</td>
<td>Workflow</td>
</tr>
<tr>
<td>Gift Certificates</td>
<td>User</td>
</tr>
<tr>
<td>Global Account Mapping</td>
<td>Accounting Book</td>
</tr>
<tr>
<td></td>
<td>Class</td>
</tr>
<tr>
<td></td>
<td>Department</td>
</tr>
<tr>
<td></td>
<td>Destination Account</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Source Account</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td></td>
<td>■ Subsidiary</td>
</tr>
<tr>
<td></td>
<td>■ System Notes</td>
</tr>
<tr>
<td>Global Inventory Relationship</td>
<td>■ Inventory Location</td>
</tr>
<tr>
<td></td>
<td>■ Inventory Subsidiary</td>
</tr>
<tr>
<td></td>
<td>■ Ongoing Subsidiary</td>
</tr>
<tr>
<td>Group</td>
<td>Group Member</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Inbound Shipment</td>
<td>■ Item</td>
</tr>
<tr>
<td></td>
<td>■ Item Receipt</td>
</tr>
<tr>
<td></td>
<td>■ Purchase Order</td>
</tr>
<tr>
<td></td>
<td>■ Vendor</td>
</tr>
<tr>
<td>Information Item</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Installment</td>
<td>Transaction</td>
</tr>
<tr>
<td>Inventory and Bin Numbers</td>
<td>Bin Number</td>
</tr>
<tr>
<td></td>
<td>Inventory Number</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Inventory Balance</td>
<td>Bin Number</td>
</tr>
<tr>
<td></td>
<td>Inventory Number</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td>Inventory Cost Template</td>
<td>Item</td>
</tr>
<tr>
<td>Inventory Detail</td>
<td>Bin Number</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Inventory Number</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>Users</td>
</tr>
<tr>
<td>Inventory Numbers</td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Issue</td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Product Team</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Version Broken</td>
</tr>
<tr>
<td></td>
<td>Version Fixed</td>
</tr>
<tr>
<td></td>
<td>Version Target</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Item</td>
<td>Accounting Book Rev. Rec. Template</td>
</tr>
<tr>
<td></td>
<td>Assembly Item Bill of Materials</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Billing Rate</td>
</tr>
<tr>
<td></td>
<td>Bin Number</td>
</tr>
<tr>
<td></td>
<td>Bin On Hand</td>
</tr>
<tr>
<td></td>
<td>Correlated Item</td>
</tr>
<tr>
<td></td>
<td>Effective Revision</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Inventory Location</td>
</tr>
<tr>
<td></td>
<td>Inventory Number</td>
</tr>
<tr>
<td></td>
<td>Inventory Number/Bin On Hand</td>
</tr>
<tr>
<td></td>
<td>Member Item</td>
</tr>
<tr>
<td></td>
<td>Obsolete Revision</td>
</tr>
<tr>
<td></td>
<td>Parent</td>
</tr>
<tr>
<td></td>
<td>Preferred Location</td>
</tr>
<tr>
<td></td>
<td>Preferred Vendor</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
</tr>
<tr>
<td></td>
<td>Project Template</td>
</tr>
<tr>
<td></td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Vendor</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Item Account Mapping</td>
<td>Accounting Book</td>
</tr>
<tr>
<td></td>
<td>Class</td>
</tr>
<tr>
<td></td>
<td>Department</td>
</tr>
<tr>
<td></td>
<td>Destination Account</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Source Account</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td>Item Collection</td>
<td>Item Fields</td>
</tr>
<tr>
<td>Item Demand Plan</td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Last Alternate Source Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Item Supply Plan</td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Planning Action Message</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Job</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td>Job Requisition</td>
<td>Approved By</td>
</tr>
<tr>
<td></td>
<td>Hiring Manager</td>
</tr>
<tr>
<td></td>
<td>Recruiter</td>
</tr>
<tr>
<td>Location</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Location Costing Group</td>
</tr>
<tr>
<td></td>
<td>Return Address</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
</tbody>
</table>

Search
<table>
<thead>
<tr>
<th>Advanced Search Record Type</th>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Costing Group</td>
<td>Location</td>
</tr>
<tr>
<td>Login Audit Trail</td>
<td>Customer, Employee, Partner, Role, User, Vendor</td>
</tr>
<tr>
<td>Login Restrictions</td>
<td>User</td>
</tr>
<tr>
<td>Manufacturing Cost Template</td>
<td>Item, User</td>
</tr>
<tr>
<td>Manufacturing Operation Task</td>
<td>Predecessor, User, Work Order</td>
</tr>
<tr>
<td>Manufacturing Planned Time</td>
<td>Manufacturing Work Center, Operation Task</td>
</tr>
<tr>
<td>Manufacturing Routing</td>
<td>Item, Location, Manufacturing Cost Template, Manufacturing Work Center, User</td>
</tr>
<tr>
<td>Memorized Transaction</td>
<td>Transaction, User</td>
</tr>
<tr>
<td>Merchandise Hierarchy Node</td>
<td>Hierarchy Level, Hierarchy Parent Node, Hierarchy Version</td>
</tr>
<tr>
<td>Merchandise Hierarchy Version</td>
<td>Hierarchy Level</td>
</tr>
<tr>
<td>Message</td>
<td>Attachments, Author, Campaign, Case, Contact, Customer, Employee, Entity, Opportunity, Originating Lead, Partner, Recipient, Transaction, User, Vendor</td>
</tr>
<tr>
<td>Multi-Book Accounting Transaction</td>
<td>Account, Amortization Schedule, Rev Rec Schedule, Rev Rec Template, Transaction</td>
</tr>
<tr>
<td>News Item</td>
<td>Restricted to Locations</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Nexus</td>
<td>User</td>
</tr>
<tr>
<td>Online Case Form</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Online Lead Form</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Actual</td>
</tr>
<tr>
<td></td>
<td>Call</td>
</tr>
<tr>
<td></td>
<td>Competitor (Winner)</td>
</tr>
<tr>
<td></td>
<td>Competitor</td>
</tr>
<tr>
<td></td>
<td>Contact (Primary)</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Decision Maker</td>
</tr>
<tr>
<td></td>
<td>Estimate</td>
</tr>
<tr>
<td></td>
<td>Event</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Lead Source</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Order</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Partner</td>
</tr>
<tr>
<td></td>
<td>Sales Rep</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Partner</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Contact (Primary)</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Entity Bank Details</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Login Audit Trail</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Paycheck</td>
<td>Employee</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Payroll Batch</td>
</tr>
<tr>
<td></td>
<td>Payroll Item</td>
</tr>
<tr>
<td>Payment Event</td>
<td>Transaction</td>
</tr>
<tr>
<td>Payroll Batch</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Payroll Item</td>
<td>Workflow</td>
</tr>
<tr>
<td>Phone Call</td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Company (Customer)</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Participant</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Planned Standard Cost</td>
<td>Component Item</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Standard Cost Version</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Price Book</td>
<td>Price Plan</td>
</tr>
<tr>
<td></td>
<td>Subscription Plan</td>
</tr>
<tr>
<td>Price Plan</td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Subscription</td>
</tr>
<tr>
<td></td>
<td>Subscription Line</td>
</tr>
<tr>
<td>Pricing</td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Project</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Billing Milestone</td>
</tr>
<tr>
<td></td>
<td>Billing Schedule</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>Contact (Primary)</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Project Resource</td>
</tr>
<tr>
<td></td>
<td>Project Task</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Project Resource</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Generic Resource</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Vendor</td>
</tr>
<tr>
<td></td>
<td>Work Calendar</td>
</tr>
<tr>
<td>Project Task</td>
<td>Predecessor</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Project Task Assignment</td>
</tr>
<tr>
<td></td>
<td>Project Template</td>
</tr>
<tr>
<td></td>
<td>Successor</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Project Task and CRM Task</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Project Task</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Project Template</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Campaign Response Count</td>
</tr>
<tr>
<td></td>
<td>Campaign Response</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Generic Resource</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Messages From</td>
</tr>
<tr>
<td></td>
<td>Messages To</td>
</tr>
<tr>
<td></td>
<td>Project Task</td>
</tr>
<tr>
<td></td>
<td>Rates</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>Subscription Message History</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Registration</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Promotion</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td><strong>Advanced Search Record Type</strong></td>
<td><strong>Related Record Types with Join Fields</strong></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Quota</td>
<td>User</td>
</tr>
<tr>
<td>Report</td>
<td>User</td>
</tr>
<tr>
<td>Resource Group</td>
<td>Group Member</td>
</tr>
<tr>
<td>Revenue Recognition Schedules</td>
<td>Applied To Transaction</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Journal</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Revenue Recognition Templates</td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Role</td>
<td>Login Audit Trail</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Sales Campaign</td>
<td>Campaign Recipient</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Promotion</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Saved Search</td>
<td>Bundle</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Search Schedule</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Scheduled Script Instance</td>
<td>Script Deployment</td>
</tr>
<tr>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>Script</td>
<td>Execution Log</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Script Deployment</td>
<td>Execution Log</td>
</tr>
<tr>
<td></td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Server Script Log</td>
<td>Script Deployment</td>
</tr>
<tr>
<td></td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Shipment Package</td>
<td>Item Fulfillment</td>
</tr>
<tr>
<td>Shopping Cart</td>
<td>Shopper</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Solution</td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Related Solution</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Topic</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Standard Cost Version</td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Subscription</td>
<td>Billing Account</td>
</tr>
<tr>
<td></td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Default Renewal Term</td>
</tr>
<tr>
<td></td>
<td>Initial Term</td>
</tr>
<tr>
<td></td>
<td>Subscription Plan</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>(Subscription Change Order)</td>
</tr>
<tr>
<td></td>
<td>(Subscription) Line</td>
</tr>
<tr>
<td>Subscription Change Order</td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Default Renewal Term</td>
</tr>
<tr>
<td></td>
<td>Initial Term</td>
</tr>
<tr>
<td></td>
<td>Renewal Term</td>
</tr>
<tr>
<td></td>
<td>Subscription</td>
</tr>
<tr>
<td></td>
<td>Subscription Plan</td>
</tr>
<tr>
<td></td>
<td>Subscription Notes</td>
</tr>
<tr>
<td>Subscription Line</td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Included Quantity Multiplier Line</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Price Plan</td>
</tr>
<tr>
<td></td>
<td>Subscription</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td>Subsidiary (OneWorld only)</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Default Advance to Apply Account</td>
</tr>
<tr>
<td></td>
<td>Fiscal Calendar</td>
</tr>
<tr>
<td></td>
<td>Return Address</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Tax Fiscal Calendar</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Supply Chain Snapshot</td>
<td>Item</td>
</tr>
<tr>
<td>Supply Chain Snapshot Details</td>
<td>Entity</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td>System Note</td>
<td>Role</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Task</td>
<td>Assignee</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Company (Customer)</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
</tbody>
</table>
### Defining an Advanced Search

#### Advanced Search Record Type

<table>
<thead>
<tr>
<th>Advanced Search Record Type</th>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>Originating Lead</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Transaction</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Tax Code</td>
<td>Tax Type</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Tax Group</td>
<td>User</td>
</tr>
<tr>
<td>Tax Type</td>
<td>User</td>
</tr>
<tr>
<td>Termination Reason</td>
<td>System Notes</td>
</tr>
<tr>
<td>Time</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Class</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Department</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Event</td>
</tr>
<tr>
<td></td>
<td>Generic Resource</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Phone Call</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Project Task</td>
</tr>
<tr>
<td></td>
<td>Project Task Assignment</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Vendor</td>
</tr>
<tr>
<td></td>
<td>Weekly Timesheet</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Time-Off Change</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Time Bill</td>
</tr>
<tr>
<td>Time-Off Request</td>
<td>Approver</td>
</tr>
<tr>
<td></td>
<td>Time-Off Request Details</td>
</tr>
<tr>
<td></td>
<td>Time-Off Request Employee</td>
</tr>
<tr>
<td>Time-Off Type</td>
<td>Payroll Item</td>
</tr>
<tr>
<td>Timesheet</td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Topic</td>
<td>Solution</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Advanced Search Record Type</td>
<td>Related Record Types with Join Fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------</td>
</tr>
</tbody>
</table>
| Transaction                 | Account  
Accounting Period  
Activity  
Advance to Apply Account  
Amortization Schedule  
Applied To Transaction  
Applying Transaction  
Batch Transaction Information  
Bill of Materials  
Bill of Materials Revision  
Billing Address  
Billing Transaction  
Bin Number  
COGS Purchase  
COGS Sale  
Call  
Case  
Class  
Contact (Primary)  
Created From  
Currency  
Customer (Main Line)  
Customer/Project  
Department  
Deposit/Refund Transaction  
Employee  
Event  
Expense Category  
Expense Detail  
File  
File (Line)  
From Location  
Fulfilling/Receiving Transaction  
Installment  
Installment On Sales Order  
Inventory Detail  
Item  
Item Number  
Item Pricing  
Lead Source  
Line System Notes  
Location  
Manufacturing Operation Task  
Manufacturing Planned Time  
Memorized  
Messages  
Multi-Book Accounting Transaction  
Next Approver  
Opportunity  
Order Schedule  
Paid Transaction  
Partner  
Paying Transaction  
Payment Event  
Payroll Batch  
Payroll Item  
Posted Time  
Project  
Project (Main Line)  |
<table>
<thead>
<tr>
<th>Advanced Search Record Type</th>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Project Budget</td>
</tr>
<tr>
<td></td>
<td>Project Task</td>
</tr>
<tr>
<td></td>
<td>Project Task Budget</td>
</tr>
<tr>
<td></td>
<td>Purchase Order</td>
</tr>
<tr>
<td></td>
<td>Realized Gain Posting Transaction</td>
</tr>
<tr>
<td></td>
<td>Requestor</td>
</tr>
<tr>
<td></td>
<td>Rev Rec Schedule</td>
</tr>
<tr>
<td></td>
<td>Rev Rec Template</td>
</tr>
<tr>
<td></td>
<td>Revenue Committing Transaction</td>
</tr>
<tr>
<td></td>
<td>Revision</td>
</tr>
<tr>
<td></td>
<td>Sales Order of Deposit</td>
</tr>
<tr>
<td></td>
<td>Sales Rep</td>
</tr>
<tr>
<td></td>
<td>Shipment Package</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td></td>
<td>System Notes</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>Tax Item</td>
</tr>
<tr>
<td></td>
<td>To Location</td>
</tr>
<tr>
<td></td>
<td>User Notes</td>
</tr>
<tr>
<td></td>
<td>Vendor</td>
</tr>
<tr>
<td></td>
<td>Vendor (Line)</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
</tr>
<tr>
<td>Transaction Numbering Audit Log</td>
<td>Author</td>
</tr>
<tr>
<td></td>
<td>Deleted By</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
</tr>
<tr>
<td></td>
<td>Transaction Header</td>
</tr>
<tr>
<td></td>
<td>Transaction Line</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td>Two-Factor Tokens</td>
<td>user</td>
</tr>
<tr>
<td>Units Type</td>
<td>Billing Class</td>
</tr>
<tr>
<td></td>
<td>Time Based Charge Rule</td>
</tr>
<tr>
<td></td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
</tr>
<tr>
<td>Usage</td>
<td>Charge</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Subscription</td>
</tr>
<tr>
<td></td>
<td>Subscription Line</td>
</tr>
<tr>
<td></td>
<td>Subscription Plan</td>
</tr>
<tr>
<td>User Note</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>Author</td>
</tr>
<tr>
<td></td>
<td>Call</td>
</tr>
<tr>
<td></td>
<td>Campaign</td>
</tr>
<tr>
<td></td>
<td>Case</td>
</tr>
<tr>
<td></td>
<td>Contact</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td></td>
<td>Entity</td>
</tr>
<tr>
<td></td>
<td>Event</td>
</tr>
<tr>
<td></td>
<td>Issue</td>
</tr>
<tr>
<td></td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
</tr>
</tbody>
</table>
### Advanced Search Record Type

<table>
<thead>
<tr>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Originating Lead</td>
</tr>
<tr>
<td>Partner</td>
</tr>
<tr>
<td>Solution</td>
</tr>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Transaction</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>Vendor</td>
</tr>
<tr>
<td>Workflow</td>
</tr>
</tbody>
</table>

#### Vendor

<table>
<thead>
<tr>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
</tr>
<tr>
<td>Billing Address</td>
</tr>
<tr>
<td>Campaign Response Count</td>
</tr>
<tr>
<td>Campaign Response</td>
</tr>
<tr>
<td>Contact (Primary)</td>
</tr>
<tr>
<td>Contact</td>
</tr>
<tr>
<td>Entity Bank Details</td>
</tr>
<tr>
<td>Expense Account</td>
</tr>
<tr>
<td>File</td>
</tr>
<tr>
<td>Login Audit Trail</td>
</tr>
<tr>
<td>Messages</td>
</tr>
<tr>
<td>Messages From</td>
</tr>
<tr>
<td>Messages To</td>
</tr>
<tr>
<td>Payable Account</td>
</tr>
<tr>
<td>Rates</td>
</tr>
<tr>
<td>Shipping Address</td>
</tr>
<tr>
<td>Subscription Message History</td>
</tr>
<tr>
<td>Subsidiary</td>
</tr>
<tr>
<td>System Notes</td>
</tr>
<tr>
<td>Tax Registration</td>
</tr>
<tr>
<td>Time Approver</td>
</tr>
<tr>
<td>Transaction</td>
</tr>
<tr>
<td>Transaction (Vendor reverse)</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>User Notes</td>
</tr>
<tr>
<td>Vendor Currency Balance</td>
</tr>
<tr>
<td>Workflow</td>
</tr>
<tr>
<td>Workflow History</td>
</tr>
</tbody>
</table>

#### Vendor-Subsidiary Relationship

| Subsidiary                           |
| Vendor                               |

#### Web Services Operations

<table>
<thead>
<tr>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Services Record Processing</td>
</tr>
</tbody>
</table>

#### Web Services Processing

<table>
<thead>
<tr>
<th>Web Services Operations</th>
</tr>
</thead>
</table>

#### Work Calendar

| User                                 |

#### Workflow

| System Notes                         |
| User                                 |

#### Workflow Instance

| Activity                             |
| Approval Routing                     |
| Availability                         |
| Batch Details                        |
| Calendar                             |
| Call                                 |
| Campaign                             |
| Case                                 |
| Contact                              |
| Customer                             |
| Employee                             |
### Advanced Search Record Type

<table>
<thead>
<tr>
<th>Related Record Types with Join Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>Item</td>
</tr>
<tr>
<td>Opportunity</td>
</tr>
<tr>
<td>Partner</td>
</tr>
<tr>
<td>Project Task</td>
</tr>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Transaction</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>Vendor</td>
</tr>
<tr>
<td>Workflow History</td>
</tr>
<tr>
<td>Workplace</td>
</tr>
<tr>
<td>Address</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>Workflow</td>
</tr>
</tbody>
</table>

### Searching by File Attachments

Advanced searches and saved searches can include search criteria and results based on files attached to records. You can specify file field values to be used as filters for search criteria. You can include fields stored for the attached file, including file names, as columns on results pages.

- To define a field from an attached file (such as the file’s name) as a search filter:
  - On the Search page’s Criteria subtab:
    - Select File Fields... in the Filter dropdown list.
    - In the popup that appears, select a field from the File Filter dropdown list.
    - Click the **Set Options** button and in the popup, enter or select a value for the filter field, and click **Set**.

- To select a field from an attached file to be displayed as a results column:
  - On the Search page’s Results subtab:
    - Select File Fields... in the Field dropdown list.
    - In the popup that appears, select a field from the File Field dropdown list.

- Search by file attachments is available for the following types of searches:
  - Activity
  - Campaign
  - Case
  - Contact
  - Custom Record
  - Customer
  - Employee
  - Entity
  - Event
  - Issue
  - Project
  - Opportunity
  - Partner
Summary Types for Search Results

The Results subtab of the search page includes several summary tools you can use to compile and display search results on a summary results page. The Group summary type is the most widely used, as it is used to roll up results. In order for any other summary type to work, you also need to define a Group, to provide the rollup for the search's summary results page. Results summary types are available for advanced searches and saved searches. Saved searches also let you define filters based on summary values and to highlight summary values.

**Note:** Previously, search results were grouped by time stamp, so it was not possible to display a single day's results in one group, unless all occurred at the exact same time. To group search results by date, define a Group summary type for a date field on a search page Results subtab.

For details about summary types, see the following:

- Summary Type Descriptions
- Summary Type Example Screenshots

### Summary Type Descriptions

The following table lists the different types of summary tools available for search results and describes how you can use them to analyze your data, providing examples in the context of a sales order transaction search.

<table>
<thead>
<tr>
<th>Summary Type</th>
<th>Purpose</th>
<th>Example for Sales Order Transaction Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Rolls up search results by the field to which you apply this type.</td>
<td>You can group transactions by customer name.</td>
</tr>
</tbody>
</table>

**Note:** Some fields contain values that cannot be grouped together. The Group summary type is not available for these fields.

<table>
<thead>
<tr>
<th>Summary Type</th>
<th>Purpose</th>
<th>Example for Sales Order Transaction Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Counts the number of results found that apply to this column.</td>
<td>You can count the number of items purchased by each customer.</td>
</tr>
<tr>
<td>Sum</td>
<td>Sums search results for the column.</td>
<td>You can sum the dollar amount of sales orders for each customer.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Displays the minimum amount, or the earliest date value.</td>
<td>You can show the minimum amount sold in a transaction for each customer.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Displays the maximum amount, or the most recent date value.</td>
<td>You can show the maximum amount sold in a transaction for each customer.</td>
</tr>
</tbody>
</table>
Defining an Advanced Search

<table>
<thead>
<tr>
<th>Summary Type</th>
<th>Purpose</th>
<th>Example for Sales Order Transaction Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Calculates the average amount found for the column.</td>
<td>You can show the average amount sold in a transaction for each customer.</td>
</tr>
</tbody>
</table>

Summary Type Example Screenshots

The following sections walk you through the tasks for defining criteria and results, including summary types, for a sales order transaction search, with screenshots illustrating definitions and results pages for different summary types.

Click on the arrows to display the steps and screenshots for tasks:

**To create a search and define search criteria:**

1. Go to Reports > Saved Searches > All Saved Searches > New and select Transaction.
2. Select Type from the Filter field and in the popup, select Sales Order and click Set.
3. Select Main Line from the Filter field and in the popup, select No and click Set.

**To define a Group summary type:**

1. Click the Results subtab and add the following fields: Amount, Name, Date.
2. Select Group from the Summary Type dropdown list for Name, to group transactions by Customer.
3. Click the Preview button. The first level of results lists customers.
4. Click a customer name to drill down into a list of transactions for that customer.

To define a Sum summary type:

1. Click Return to Summary, then click Return to Criteria.
2. Click the Results subtab and select Sum from the Summary Type dropdown list for Amount.
3. Click **Preview**. The results page displays a total dollar amount of transactions for each customer.

<table>
<thead>
<tr>
<th>SUM OF AMOUNT</th>
<th>NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>-24.00</td>
<td>- None -</td>
</tr>
<tr>
<td>249.37</td>
<td>10 Sillingova, Jana</td>
</tr>
<tr>
<td>5,695.50</td>
<td>2 Acme Inc.</td>
</tr>
<tr>
<td>166.50</td>
<td>3 ABC Co.</td>
</tr>
<tr>
<td>33.00</td>
<td>4 Widgets Inc.</td>
</tr>
<tr>
<td>545.00</td>
<td>5 Widgets Inc.</td>
</tr>
<tr>
<td>666.00</td>
<td>6 Computers Inc.</td>
</tr>
<tr>
<td>14,000.00</td>
<td>7 Great Falls Emergency Clinic: Project 1</td>
</tr>
<tr>
<td>1,558.36</td>
<td>8 Queen Industries</td>
</tr>
<tr>
<td>330.00</td>
<td>A Company 40L</td>
</tr>
<tr>
<td>240.00</td>
<td>AAA Top Level - USD</td>
</tr>
<tr>
<td>360.00</td>
<td>AAA Top Level - USD: AAA Sub - GBP</td>
</tr>
</tbody>
</table>

**To define a Count summary type:**

1. Click **Return to Criteria**.
2. Click the **Results** subtab, add the Item field, and select Count from the Summary Type for Item. Also, remove the Sum from Amount, by selecting a blank from the Summary Type dropdown list.

3. Click **Preview**. The results page lists a count of the number of items sold for each customer.
4. Click a customer to drill down to a list of transactions and items.

To define a Minimum summary type:
1. Click Return to Summary, then click Return to Criteria.
2. Click the Results subtab, remove the Item field, and select Minimum from the Summary Type dropdown list for Amount.
3. Click the **Preview** button. The results page displays the minimum transaction amount for each customer.

![Custom Transaction Search 3: Results](image)

**To define a Maximum summary type:**

1. Click **Return to Criteria**.
2. Click the **Results** subtab, and select Maximum from the Summary Type dropdown list for Amount.
3. Click the Preview button. The results page displays the maximum transaction amount for each customer.

<table>
<thead>
<tr>
<th>MAXIMUM OF AMOUNT</th>
<th>NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>None</td>
</tr>
<tr>
<td>249.37</td>
<td>10 Silingrova, Jana</td>
</tr>
<tr>
<td>2,285.00</td>
<td>2 Acme Inc.</td>
</tr>
<tr>
<td>166.50</td>
<td>3 ABC Co.</td>
</tr>
<tr>
<td>33.00</td>
<td>4 Widgets Inc.</td>
</tr>
<tr>
<td>545.00</td>
<td>5 Widgets Inc.</td>
</tr>
<tr>
<td>666.00</td>
<td>6 Computers Inc.</td>
</tr>
<tr>
<td>7,000.00</td>
<td>7 Great Falls Emergency Clinic : Project 1</td>
</tr>
<tr>
<td>1,240.00</td>
<td>8 Queen Industries</td>
</tr>
<tr>
<td>130.00</td>
<td>A Company 40L</td>
</tr>
<tr>
<td>180.00</td>
<td>AAA Top Level - USD</td>
</tr>
<tr>
<td>180.00</td>
<td>AAA Top Level - USD : AAA Sub - GBP</td>
</tr>
<tr>
<td>3,692.00</td>
<td>Aaron Rosewall-Godley</td>
</tr>
<tr>
<td>5,500.00</td>
<td>AIC Medical Supplies</td>
</tr>
</tbody>
</table>

To define an Average summary type:

1. Click Return to Criteria.
2. Click the Results subtab, and select Average from the Summary Type dropdown list for Amount.

3. Click the Preview button. The results page displays the average transaction amount for each customer.
Defining an Advanced Search

Formulas in Search

For advanced searches and saved searches, you can define formulas to be used in the following ways:

- As part of a custom field that is defined to use a formula to set its value. These custom fields are available to be used as search criteria or in results columns like any other custom field. See Using a Custom Formula Field in a Search.

  For detailed information on how to define formulas in custom fields, see the help topic Creating Formula Fields.

- As part of search criteria. The results returned are based on the calculated value of the formula field. See Using a Formula in Search Criteria.

- As a results column field. The displayed values are based on the calculated value of the formula field. See Using a Formula in Search Results.

Formula values are dynamically calculated at the time a search is performed. Formula definitions can include NetSuite field IDs for which field values are substituted, SQL functions, and mathematical operators.
Important: Field values referenced in formula definitions may be translated based on a user’s language preference. For example, if a formula is created for a saved search using an English field value and the search is run by a user with a different language setting, the results of the search may vary. Consequently, we recommend using internal field IDs when constructing formula definitions. This will ensure the intended results are displayed, regardless of a user’s language settings.

Note: You cannot combine aggregate and non-aggregate SQL functions in the same formula definition. For more information about SQL functions, see SQL Expressions.

The following table shows the variables and corresponding synonyms available for your use in NetSuite.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Synonym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{today}</td>
<td>{now}</td>
<td>Returns current date according to user's time zone, date, and time formatting.</td>
</tr>
<tr>
<td>{me}</td>
<td>{user}, {user.id}</td>
<td>Returns current user ID.</td>
</tr>
<tr>
<td>{userrole}</td>
<td>{userrole.id}</td>
<td>Returns current role ID.</td>
</tr>
<tr>
<td>{user.department}</td>
<td>{userdepartment.id}</td>
<td>Returns current user's department ID.</td>
</tr>
<tr>
<td>{user.location}</td>
<td>{userlocation.id}</td>
<td>Returns current user's location ID.</td>
</tr>
<tr>
<td>{user.subsidiary}</td>
<td>{usersubsidiary.id}</td>
<td>Returns current user's subsidiary ID.</td>
</tr>
<tr>
<td>{user.class}</td>
<td>{userclass.id}</td>
<td>Returns current user's class ID.</td>
</tr>
<tr>
<td>{usercurrency}</td>
<td>{usercurrency.id}</td>
<td>Returns current user's currency.</td>
</tr>
</tbody>
</table>

For example, on a Case Search form, you can:

- Define the formula `{today}-{startdate}` to return a case's number of days open as a new column in search results.
- Define the formula `{(today}-{startdate}) > 3` as a search filter to return only cases open for greater than 3 days.

For other examples and hints for using formulas in search, see Search Formula Examples and Tips.

HTML escaping is performed as needed on search results returned by formulas.
Knowledge of SQL will help you to fully leverage the flexibility and power of SQL functions to define complex formulas, but the Formula popup windows can help you to correctly define formula expressions. These popups include a Function dropdown list that lets you select SQL functions to be included in expressions, and Filter or Field dropdown lists that let you select field names and have their IDs included in expressions.

For more details, refer to SQL Expressions. For tables of NetSuite field IDs, you can also refer to SuiteScript Supported Records.

You cannot use encrypted fields such as credit card numbers and social security numbers in formulas. Use of these fields causes invalid expression errors, because SQL cannot decrypt their encrypted values.

Using a Custom Formula Field in a Search

To use a previously defined custom formula field in a search:

1. On an advanced or saved search page, on the Criteria or Results subtab, select the previously defined custom field and set criteria as for any other custom field. Click OK.

   To learn how to define a custom formula field, see the help topic Creating Formula Fields.

2. Click Submit to view your search results.

   If your searches are returning static values for a custom formula field instead of recalculating when new data is entered into the system, the field may have been defined to store the value for the calculation at the time of record creation. This is controlled by the Store Value check box on the custom field definition. Check with your system administrator if the value should be dynamically calculated at the time of every search.

Using a Formula in Search Criteria

To use a formula in search criteria:

1. On the Criteria subtab of an advanced or saved search page, in the Filter column, select the desired Formula type.

   The following options are available (they are listed in alphabetical order, intermingled with field names in the Filter column dropdown list):
   - Formula (Date)
   - Formula (Numeric)
   - Formula (Text)
The best choice for a formula type depends upon the calculation the formula will perform, because validation varies according to the formula type. For example, to do character manipulation using regular expressions, you should select Formula (Text). To do numeric calculations, Formula (Numeric) is likely a better choice.

2. In the Formula popup window, define your formula, and click **Done**.

   **Note:** For details about supported SQL functions, refer to SQL Expressions. For tables of NetSuite field IDs, you can also refer to SuiteScript Supported Records.

   - Options vary depending on the type of formula selected. For example, date formulas can be filtered based on whether the date occurs before or after a specified date, whereas numeric formulas can be filtered based on whether the resultant value is greater than or equal to the specified criteria.
   - Select from the Function dropdown list to include a SQL function in the formula expression.
   - Select a field name from the Filter dropdown list to include its ID in the formula expression.
   - There is a 1000 character limit per formula expression. You may be able to preview a search with a formula containing more characters, but when you run the search invalid expression errors occur.
   - Remember that search records are dynamically filtered based on the **calculated** value of the formula at the time the search is performed.

3. Click **Submit** to view your search results.

For example, select Formula (Numeric) and enter the formula `{today} - {startdate}`, then set the criteria as greater than or equal to 3, as shown in the following figure.

---

**Using a Formula in Search Results**

**To use a formula as a search result:**

1. On the **Results** subtab of an advanced or saved search page, in the **Field** column, select the desired Formula type.
The following options are available (they are listed in alphabetical order, intermingled with field names in the Field column dropdown list):
- Formula (Currency)
- Formula (Date)
- Formula (Date/Time)
- Formula (Numeric)
- Formula (Percent)
- Formula (Text)

As when you define formulas for search criteria, the type of formula you choose should correspond to the type of calculation and validation desired.

2. In the Formula field, define your formula and click Done, or click the Set Formula button to open a popup that can help you correctly enter the formula expression.

   **Note:** For details about supported SQL functions, refer to SQL Expressions. For tables of NetSuite field IDs, you can also refer to SuiteScript Supported Records.

   - Select from the Function dropdown list to include a SQL function in the formula expression.
   - Select a field name from the Field dropdown list to include its ID in the formula expression.
   - There is a 1000 character limit per formula expression. You may be able to preview a search with a formula containing more characters, but when you run the search invalid expression errors occur.

3. Click Submit to view your search results.

   For example, to add a search results column that displays the total number of days a case has been open, enter the formula `{today} - {startdate}`.

### Using Formula Tags in Search Results

Tags behave like virtual fields. Tags do not impact search, but tailor the results based on your preferences and environment. Tags are different than formulas in that results are retrieved based on the context of the user running the search. The following are some of the supported tags.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TODAY or NOW</td>
<td>Current time in the appropriate time zone of the logged user.</td>
</tr>
<tr>
<td>ME or USER or USER.ID</td>
<td>An internal key (ID) of the logged user.</td>
</tr>
<tr>
<td>USERROLE or USERROLE.ID</td>
<td>An internal key (ID) of the role of the logged user.</td>
</tr>
<tr>
<td>USER.DEPARTMENT or USERDEPARTMENT.ID</td>
<td>An internal key (ID) of the department of the logged user.</td>
</tr>
<tr>
<td>USER.LOCATION or USERLOCATION.ID</td>
<td>An internal key (ID) of the physical location of the logged user.</td>
</tr>
<tr>
<td>USER.SUBSIDIARY or USERSUBSIDIARY.ID</td>
<td>An internal key (ID) of the subsidiary of the logged user.</td>
</tr>
<tr>
<td>USER.CLASS or USERCLASS.ID</td>
<td>An internal key (ID) of the class of the logged user.</td>
</tr>
<tr>
<td>USER.CURRENCY or USERCURRENCY</td>
<td>A base currency for the subsidiary of the logged user.</td>
</tr>
</tbody>
</table>

To add a formula tag in search results:

1. Go to the Results tab of a Saved Search page.
2. Add a Formula (Text) field with your preferred formula tag. The available formula tags are detailed in the table in Using Formula Tags in Search Results.

3. Click the Set Formula icon in the Formula column for the Formula (Text) results field.

![Image of Saved Account Search](image)

In the following screenshot, the currency code formula tag is inserted.

![Image of Setting Formula](image)

4. Click the Set button to add the currency code to the saved search. The formula tag is added to the saved search.

Search Formula Examples and Tips

Review the following items for hints about how other users have defined search formulas.

For other search examples, see Saved Search Examples.
Formulas in Search

For details about supported SQL functions, see SQL Expressions. For tables of NetSuite field IDs you can refer to SuiteScript Supported Records.

⚠️ **Important:** If you have examples or tips that you think other users may find helpful, please submit them to the NetSuite User Group’s 100 Ways to Use Formula Fields thread.

⚠️ **Important:** Field values referenced in formula definitions may be translated based on a user’s language preference. For example, if a formula is created for a saved search using an English field value and the search is run by a user with a different language setting, the results of the search may vary. Consequently, we recommend using internal field IDs when constructing formula definitions. This will ensure the intended results are displayed, regardless of a user’s language settings.

### Including Line Numbers in Transaction Searches

- You can include line numbers in transaction search results, by adding the Line Sequence Number field on the Results subtab of the search definition page. This field represents the internal sequence number stored for each transaction line.

  Note that line numbers are not guaranteed to be in order, even if results include all lines of a transaction. To make line numbers contiguous in search results, add a Formula(Numeric) field as a results field on the search, with the following formula expression:

  ```sql
  RANK() OVER (PARTITION by {internalid} ORDER BY {linesequencenumber})
  ```

- Note that you can create a line number custom formula field and apply it to transaction forms to display line numbers on viewed and printed transactions. For instructions, see the help topic Creating a Formula Field to Display Transaction Line Numbers. If you are using this type of field and you also want to include the line number in search results, set up the search as follows to ensure that search results match viewed and printed transaction items:
  - Set a criteria of Main Line = No (false).
  - Filter out transaction line items related to taxes.
  - Add the Item field as a results field.
  - Add the Amount (Gross) field as a results field; do not use the Amount field.
  - Add a Formula(Numeric) field as a results field, with the following formula expression: RANK() OVER (PARTITION by {internalid} ORDER BY {linesequencenumber})

### Referencing Field IDs

- You can reference the ID values for List/Record type fields in search formulas. To include a field’s ID in a formula, use the format (field_name.ID).

### Avoiding Divide By Zero Errors

- If you use division in a formula, please use Y/nullif(X,0) in place of Y/X.

### Using Joined Search Field Values

- You can use values from related records in your search criteria and results by defining joined search fields in your formula definitions. Joined search fields are specified using dot notation (record.field)
where the related record is specified followed by the field on that record. For example, to specify the credit limit field on a vendor record associated with a contact, enter (vendor.creditlimit).

- Also, note that you can select a field to be included in a formula expression from the Formula popup window's Field dropdown list. Join fields appear at the end of the dropdown list. When you select from the popup's dropdown lists, the system puts the correct ID in the formula.

Retrieving the Day of the Week for a Date on a Custom Record

- Select Formula (Text) and enter the following formula:
  \[ \text{TO\_CHAR}\left(\text{custrecordname\_date}, \text{\'DAY - DD Mon\'}\right) \]

Displaying the Percentage Variance between Custom Record Values

- On the Results subtab, select Formula (Percent), a summary type of Group, a Function of Round to Hundredths, and (if you want) a custom label such as Average. Enter the following formula:
  \[ \text{ROUND}\left(\frac{\{\text{custrecord\_value1}\}}{\{\text{custrecord\_value2}\}} - 1.00\right) \times 100, 2 \]

Calculating Days Remaining Until Task Complete

- You can calculate the number of days remaining for a task to be completed based on the value entered in the Due Date field. Select Formula (Numeric) and enter the following formula:
  \[ \text{ROUND}\left(\{\text{enddate}\} - \{\text{today}\}\right) \]

Displaying Multiplier from Cost to Base Price for Items

- When you review a list of the same model items, you can ensure your markup is similar for all of them. Select Formula (Numeric) and enter the following formula:
  \[ \text{ROUND}\left(\frac{\{\text{price}\}}{\text{\text{nvl}\left(\{\text{cost}\}, 1\right)}}\right) \]

Comparing Summed Amounts Across Two Fiscal Years for Transactions

- On the Criteria subtab, check the Use Expressions box and enter the following on two separate lines: (Date is within this fiscal year to date OR Date is within last fiscal year to date).

  - On the Results subtab, enter the following formulas:
    - If the fiscal year starts in July:
      - For current year to date, Formula (Numeric), SUMMARY TYPE = Sum:
        \[ \text{DECODEx} = \{\text{MAX\_MONTHS}\left(\{\text{trandate}\}, 6\right), \text{\'YYYY\'}\},
           \{\text{ADD\_MONTHS}\left(\{\text{today}\}, 6\right), \text{\'YYYY\'}\}, \{\text{amount}\}, 0) \]
    - For previous year to date, Formula (Numeric), SUMMARY TYPE = Sum:
      \[ \text{DECODEx} = \{\text{MAX\_MONTHS}\left(\{\text{trandate}\}, -6\right), \text{\'YYYY\'}\},
           \{\text{ADD\_MONTHS}\left(\{\text{today}\}, -6\right), \text{\'YYYY\'}\}, \{\text{amount}\}, 0) \]
If the fiscal year is the calendar year:

- For current year to date, Formula (Numeric), SUMMARY TYPE = Sum:
  \[
  \text{DECODE(TO_CHAR({trandate}, 'YYYY'), TO_CHAR({today}, 'YYYY'), {amount}, 0)}
  \]

- For previous year to date, Formula (Numeric), SUMMARY TYPE = Sum:
  \[
  \text{DECODE(TO_CHAR({trandate}, 'YYYY'), TO_CHAR(ADD_MONTHS({today}, -12), 'YYYY'), {amount}, 0)}
  \]

NOTES:

- ADD_MONTHS compensates calendar year for current fiscal year (6) and previous fiscal year (-6) if fiscal year begins in July, and compensates for previous year (-12) if fiscal year is the same as calendar year.
- TO_CHAR extracts the fiscal years.
- DECODE(value1, value2, {amount}, 0) compares the transaction date's fiscal year value (value1) to the current or previous fiscal year (value2). If equal, use amount; otherwise zero it out.

Finding the Most Recent Record Updater

You can use the dense_rank function in a formula, to order records by values in a specified field and assign each record a consecutive numerical ranking from 1 to n, where n is the number of records returned. You can use the keep (dense_rank) function to return only the first or last ranking record as ordered by values in a specified field.

For example, to return the name of the user who most recently updated a document, do a document search, and create a Formula(Text) field with a Summary Type of Minimum and a formula like the following: \[
\text{min({systemnotes.name}) keep (dense_rank last order by {systemnotes.date})}
\]

Calculating Days a Sale Is In Effect

You can use a formula to calculate the days a sale is in effect up to the date it is canceled, like a contract age. If there is no cancellation date, substitute today's date. Select Formula (Numeric) and enter the following formula:
\[
\text{ABS({custom_field_startdate}-nvl({custom_field_cxldate},{today}))}
\]

You can use a similar formula to calculate the days remaining on a contract based on the end date field.

Referencing System Notes Records

You can reference System Notes fields in numeric and text formulas using the format: \{systemnotes.field_name\}. Also, note that you can select a field to be included in a formula expression from the Formula popup window's Field dropdown list. Join fields appear at the end of the dropdown list. When you select from the dropdown lists, the system puts the correct ID in the formula.

Calculating Time Taken to Approve Orders

Do a Transaction search, with filters of Type is Sales Order, Main Line is true, System Notes : Field is Document Status, and System Notes : New Value is Pending Fulfillment.
Add a Formula(Numeric) results column with the formula \{(systemnotes\_date) - \{date\_created\}\}. You can add a Custom Label that indicates this calculation is the time taken to approve each order.

SQL Expressions

The SQL expressions that you enter in field formulas call the Oracle database to evaluate the function, and those functions are maintained by Oracle. For more information about these functions, see the Oracle Database SQL Reference.

If you are familiar with Microsoft SQL Server functions but are new to Oracle databases, see Character Functions to compare SQL functions support in Microsoft SQL Server and Oracle databases. If you are used to Microsoft Excel functions, please note that not all Excel functions are supported by Oracle, and those that are supported often use a different syntax.

The following tables outline the SQL functions that can be used in NetSuite search formulas and custom formula fields:

- Numeric Functions
- Character Functions Returning Character Values
- Character Functions Returning Number Values
- Datetime Functions
- NULL-Related Functions
- Decode
- Sysdate
- Case
- Analytic and Aggregate Functions

**Important:** The following material is provided for convenience only. It is assumed that you are familiar with the implementation of SQL expressions. For a complete reference to SQL expressions, go to the Oracle website (requires Oracle account activation). Not all of the expressions described at the URL are supported in NetSuite.

**Note:** You cannot combine aggregate and non-aggregate SQL functions in the same formula definition. For example, if you create a formula using an aggregate function, then all the functions in the definition must either be aggregate functions or listed in a GROUP\_BY clause.

Conventions in SQL Syntax Examples

The syntax examples use Oracle's typographic conventions for SQL code examples. The following table shows the conventions used in SQL syntax examples.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
</table>
| [] | Anything enclosed in brackets is optional. | LTRIM(char [ , set ])
<p>| {} | Braces are used for grouping items. | TO_CHAR((\text{datetime} | \text{interval} )[, f\text{mt} [, 'nlsparam' ]]) |</p>
<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A vertical bar represents a choice of two options.</td>
<td>ATAN2(n1 { ,</td>
</tr>
<tr>
<td>...</td>
<td>An ellipsis mean repetition in syntax descriptions or an omission in code examples or text.</td>
<td>DECODE(expr, search, result [, search, result ]...[, default ])</td>
</tr>
<tr>
<td>UPPERCASE</td>
<td>Indicates an element supplied by the system. These terms are shown in uppercase to distinguish them from terms you define. Unless terms appear in brackets, enter them in the order and with the spelling shown. Because these terms are not case sensitive, you can use them in either UPPERCASE or lowercase.</td>
<td>TRIM( [ (LEADING</td>
</tr>
<tr>
<td>lowercase</td>
<td>Indicates user-defined programmatic elements, such as field names. Note that some programmatic elements use a mixture of UPPERCASE and lowercase. Enter these elements as shown.</td>
<td>NULLIF(expr1, expr2)</td>
</tr>
</tbody>
</table>

The examples are provided for illustrative purposes only. They may or may not work for you, depending on your NetSuite account settings and data.

### Numeric Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS</td>
<td>ABS(n)</td>
<td>returns the absolute value of n</td>
<td>ABS(amount)</td>
</tr>
<tr>
<td>ACOS</td>
<td>ACOS(n)</td>
<td>returns the arc cosine of n</td>
<td>ACOS(0.35)</td>
</tr>
<tr>
<td>ASIN</td>
<td>ASIN(n)</td>
<td>returns the arc sine of n</td>
<td>ASIN(1)</td>
</tr>
<tr>
<td>ATAN</td>
<td>ATAN(n)</td>
<td>returns the arc tangent of n</td>
<td>ATAN(0.2)</td>
</tr>
<tr>
<td>ATAN2</td>
<td>ATAN2(n1 { ,</td>
<td>} n2)</td>
<td>returns the arc tangent of n1 and n2</td>
</tr>
<tr>
<td>BITAND</td>
<td>BITAND(expr1, expr2)</td>
<td>computes an AND operation on the bits of expr1 and expr2</td>
<td>BITAND(5, 3)</td>
</tr>
<tr>
<td>CEIL</td>
<td>CEIL(n)</td>
<td>returns smallest integer greater than or equal to n</td>
<td>CEIL(today)-(createddate)</td>
</tr>
<tr>
<td>COS</td>
<td>COS(n)</td>
<td>returns the cosine of n</td>
<td>COS(0.35)</td>
</tr>
<tr>
<td>COSH</td>
<td>COSH(n)</td>
<td>returns the hyperbolic cosine of n</td>
<td>COSH(-3.15)</td>
</tr>
<tr>
<td>EXP</td>
<td>EXP(n)</td>
<td>returns e raised to the nth power, where e = 2.71828183</td>
<td>EXP(rate)</td>
</tr>
<tr>
<td>FLOOR</td>
<td>FLOOR(n)</td>
<td>returns largest integer equal to or less than n</td>
<td>FLOOR(today)-(createddate)</td>
</tr>
<tr>
<td>LN</td>
<td>LN(n)</td>
<td>returns the natural logarithm of n</td>
<td>LN(20)</td>
</tr>
<tr>
<td>LOG</td>
<td>LOG(n2, n1)</td>
<td>returns the logarithm, base n2, of n1</td>
<td>LOG(10, 20)</td>
</tr>
<tr>
<td>MOD</td>
<td>MOD(n2, n1)</td>
<td>returns the remainder of n2 divided by n1</td>
<td>MOD(today)-(lastmessagedate), 7</td>
</tr>
</tbody>
</table>
### Formulas in Search

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>NANVL</td>
<td>NANVL(n2, n1)</td>
<td>returns an alternative value n1 if the input value n2 is not a number</td>
<td>NANVL({itemisbn13}, '')</td>
</tr>
<tr>
<td>POWER</td>
<td>POWER(n2, n1)</td>
<td>returns n2 raised to the n1 power</td>
<td>POWER(({custcoldaystoship}),-.196)</td>
</tr>
</tbody>
</table>
| REMAINDER | REMAINDER(n2, n1) | returns the remainder of n2 divided by n1                                  | REMAINDER({transaction.totalamount},
{transaction.amountpaid}) |
| ROUND     | ROUND(n [, integer ]) | returns n rounded to integer places to the right of the decimal point | ROUND(((today)-(startdate)), 0)                  |
| SIGN      | SIGN(n)        | returns the sign of n                                                       | SIGN(({quantity}))                               |
| SIN       | SIN(n)         | returns the sine of n                                                       | SIN(5.2)                                         |
| SINH      | SINH(n)        | returns the hyperbolic sine of n                                            | SINH(3)                                          |
| SQRT      | SQRT(n)        | returns the square root of n                                                | SQRT(Power({taxamount}, 2))                      |
| TAN       | TAN(n)         | returns the tangent of n                                                    | TAN(-5.2)                                       |
| TANH      | TANH(n)        | returns the hyperbolic tangent of n                                         | TANH(3)                                          |
| TRUNC     | TRUNC(n1 [, n2 ]) | returns n1 truncated to n2 decimal places                                   | TRUNC(({amount}, 1))                            |

### Character Functions Returning Character Values

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHR</td>
<td>CHR(n [ USING NCHAR_CS ])</td>
<td>returns the character having the binary equivalent to n as a VARCHAR2 value</td>
<td>CHR(13)</td>
</tr>
<tr>
<td>CONCAT</td>
<td>CONCAT(char1, char2)</td>
<td>concatenates char1 and char2 into one string</td>
<td>CONCAT({number}, CONCAT('_', {line}))</td>
</tr>
<tr>
<td>INITCAP</td>
<td>INITCAP(char)</td>
<td>returns char, with the first letter of each word in uppercase, all other letters in lowercase</td>
<td>INITCAP({customer.companyname})</td>
</tr>
<tr>
<td>LOWER</td>
<td>LOWER(char)</td>
<td>returns char, with all letters lowercase</td>
<td>LOWER({customer.companyname})</td>
</tr>
<tr>
<td>LPAD</td>
<td>LPAD(expr1, n [, expr2 ] )</td>
<td>returns expr1, left-padded to length n characters with the sequence of characters in expr2</td>
<td>LPAD({line},3,'0')</td>
</tr>
<tr>
<td>LTRIM</td>
<td>LTRIM(char [, set ] )</td>
<td>removes from the left end of char all of the characters contained in set</td>
<td>LTRIM({companyname}, '-')</td>
</tr>
<tr>
<td>REGEXP_REPLACE</td>
<td>REGEXP_REPLACE(source_char, pattern [, replace_string [, position [, occurrence [, match_parameter ] ] ] ] )</td>
<td>lets you replace a sequence of characters (source_char) that matches a regular expression pattern with another set of characters (replace_string)</td>
<td>REGEXP_REPLACE({name}, '^.+;', '')</td>
</tr>
<tr>
<td>Function</td>
<td>Syntax</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REGEXP_SUBSTR</td>
<td>REGEXP_SUBSTR(source_char, pattern [, position [, occurrence [, match_parameter ]]]])</td>
<td>lets you extract a sequence of characters that matches a regular expression pattern from the source string (source_char)</td>
<td>REGEXP_SUBSTR({item}, '[^:]+$')</td>
</tr>
<tr>
<td>REPLACE</td>
<td>REPLACE(char, search_string [, replacement_string ] )</td>
<td>returns char with every occurrence of search_string replaced with replacement_string</td>
<td>REPLACE({serialnumber}, '8&amp;', ',')</td>
</tr>
<tr>
<td>RPAD</td>
<td>RPAD(expr1 , n [, expr2 ])</td>
<td>returns expr1, right-padded to length n characters with expr2, replicated as many times as necessary</td>
<td>RPAD({firstname}, 20)</td>
</tr>
<tr>
<td>RTRIM</td>
<td>RTRIM(char [, set ])</td>
<td>removes from the right end of char all of the characters that appear in set</td>
<td>RTRIM({paidtransaction. externalid}, '-Invoice')</td>
</tr>
<tr>
<td>SOUNDEX</td>
<td>SOUNDEX(char)</td>
<td>returns a character string containing the phonetic representation of char</td>
<td>SOUNDEX({companyname})</td>
</tr>
<tr>
<td>SUBSTR</td>
<td>SUBSTR(char, position [, substring_length ]] )</td>
<td>returns a portion of char, beginning at character position, substring_length characters long</td>
<td>SUBSTR({transaction. salesrep},1,3)</td>
</tr>
<tr>
<td>TRANSLATE</td>
<td>TRANSLATE(expr, from_string, to_string)</td>
<td>returns expr with all occurrences of each character in from_string replaced by its corresponding character in to_string</td>
<td>TRANSLATE({expensecategory}, ',', '+')</td>
</tr>
<tr>
<td>TRIM</td>
<td>TRIM({ { LEADING</td>
<td>TRAILING</td>
<td>BOTH } [ { trim_character ]</td>
</tr>
<tr>
<td>UPPER</td>
<td>UPPER(char)</td>
<td>returns char, with all letters uppercase</td>
<td>UPPER({unit})</td>
</tr>
</tbody>
</table>

**Character Functions Returning Number Values**

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>ASCII(char)</td>
<td>returns the decimal representation in the database character set of the first character of char</td>
<td>ASCII({taxitem})</td>
</tr>
<tr>
<td>INSTR</td>
<td>INSTR(string, substring [, position [, occurrence ] ] )</td>
<td>searches string for substring</td>
<td>INSTR({messages.message}, 'cspdr3')</td>
</tr>
<tr>
<td>LENGTH</td>
<td>LENGTH(char)</td>
<td>returns the length of char</td>
<td>LENGTH({name})</td>
</tr>
<tr>
<td>Function</td>
<td>Syntax</td>
<td>Short Description</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>REGEXP_INSTR</td>
<td>REGEXP_INSTR (source_char, pattern [, position [, occurrence [, return_option [, match_parameter ] ] ] ] )</td>
<td>lets you search a string for a regular expression pattern</td>
<td>REGEXP_INSTR ({item.unitstype}, '\d')</td>
</tr>
<tr>
<td>TO_NUMBER()</td>
<td>TO_NUMBER(expr [, fmt [, 'nlsparam' ] ] )</td>
<td>converts a formatted TEXT or NTEXT expression to a number</td>
<td>TO_NUMBER((quantity))</td>
</tr>
</tbody>
</table>

**Datetime Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD_MONTHS</td>
<td>ADD_MONTHS(date, integer)</td>
<td>returns the date plus integer months</td>
<td>ADD_MONTHS((today),-1)</td>
</tr>
<tr>
<td>LAST_DAY</td>
<td>LAST_DAY(date)</td>
<td>returns the date of the last day of the month that contains date</td>
<td>LAST_DAY((today))</td>
</tr>
<tr>
<td>MONTHS_BETWEEN</td>
<td>MONTHS_BETWEEN(date1, date2)</td>
<td>returns the number of months between date1 and date2</td>
<td>MONTHS_BETWEEN(SYSDATE, {createddate})</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>See also Sysdate.</td>
</tr>
<tr>
<td>NEXT_DAY</td>
<td>NEXT_DAY(date, char)</td>
<td>returns the date of the first weekday named by char that is later than the date</td>
<td>NEXT_DAY((today),'SATURDAY')</td>
</tr>
<tr>
<td>ROUND (DATE)</td>
<td>ROUND(date [, fmt ])</td>
<td>returns date rounded to the unit specified by the format model fmt</td>
<td>ROUND(TO_DATE('12/31/2014', 'mm/dd/yyyy')-{datecreated})</td>
</tr>
<tr>
<td>TO_CHAR()</td>
<td>TO_CHAR({ datetime</td>
<td>interval } [, fmt [, 'nlsparam' ] ] )</td>
<td>converts a datetime or interval value to a value of VARCHAR2 datatype in the format specified by the date format fmt</td>
</tr>
<tr>
<td>TO_DATE()</td>
<td>TO_DATE(char [, fmt [, 'nlsparam' ] ] )</td>
<td>converts a formatted TEXT or NTEXT expression to a DATETIME value</td>
<td>TO_DATE('31.12.2011', 'DD.MM.YYYY')</td>
</tr>
<tr>
<td>TRUNC (DATE)</td>
<td>TRUNC(date [, fmt ])</td>
<td>returns date with the time portion of the day truncated to the unit specified by the format model fmt</td>
<td>TRUNC((today), 'YYYY')</td>
</tr>
</tbody>
</table>

**NULL-Related Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>COALESCE</td>
<td>COALESCE(expr [, expr ]...)</td>
<td>returns the first non-null expr in the expression list.</td>
<td>COALESCE((quantitycommitted), 0)</td>
</tr>
<tr>
<td>NULLIF</td>
<td>NULLIF(expr1, expr2)</td>
<td>compares expr1 and expr2. If they are equal, then the function returns null. If they are not equal, then the function returns expr1.</td>
<td>NULLIF((price), 0)</td>
</tr>
</tbody>
</table>
### NVL

- **Syntax**: NVL(expr1, expr2)
- **Short Description**: lets you replace null with the second parameter.
- **Example**: NVL(quantity, '0')

### NVL2

- **Syntax**: NVL2(expr1, expr2, expr3)
- **Short Description**: If expr1 is not null, then NVL2 returns expr2. If expr1 is null, then NVL2 returns expr3.
- **Example**: NVL2(location, 1, 2)

### Decode

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DECODE</td>
<td>DECODE(expr, search, result, [search, result]...)</td>
<td>Compares expr to each search value one by one. If expr is equal to a search, the corresponding result is returned. If no match is found, default is returned.</td>
<td>DECODE(systemnotes.name), (assigned), 'T', 'F')</td>
</tr>
</tbody>
</table>

### Sysdate

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSDATE</td>
<td>SYSDATE</td>
<td>returns the current date and time set</td>
<td>TO_DATE(SYSDATE, 'DD.MM.YYYY') or TO_CHAR(SYSDATE, 'mm/dd/yyyy')</td>
</tr>
</tbody>
</table>

See also TO_DATE and TO_CHAR in the Datetime Functions.

### Case

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASE</td>
<td>CASE { expr WHEN comparison_expr THEN return_expr [ WHEN comparison_expr THEN return_expr ]...</td>
<td>returns value based on different conditions</td>
<td>CASE {state} WHEN 'NY' THEN 'New York' WHEN 'CA' THEN 'California' ELSE (state) END or CASE WHEN (quantityavailable) &gt; 19 THEN 'In Stock' WHEN (quantityavailable) &gt; 1 THEN 'Limited Availability' WHEN (quantityavailable) = 1 THEN 'The Last Piece' WHEN (quantityavailable) IS NULL THEN 'Discontinued' ELSE 'Out of Stock' END</td>
</tr>
</tbody>
</table>
Analytic and Aggregate Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Short Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DENSE_RANK</td>
<td>DENSE_RANK(expr [, expr ...]) WITHIN GROUP (ORDER BY expr [ ASC</td>
<td>DESC ] [ NULLS ( FIRST</td>
<td>LAST ] ) ...)</td>
</tr>
<tr>
<td>KEEP()</td>
<td>KEEP(DENSE_RANK FIRST</td>
<td>LAST ) ORDER BY expr [ NULLS ( FIRST</td>
<td>LAST ) ]</td>
</tr>
<tr>
<td>RANK</td>
<td>(expr [ ASC</td>
<td>DESC ] [ NULLS ( FIRST</td>
<td>LAST ] )</td>
</tr>
</tbody>
</table>

Exporting Search Results

You can export most NetSuite search results as files that you can open in external applications. (Popup searches and their results pages do not include Export option buttons.)

- From most search pages:
  - Click **Export**, to export search results to a .csv file instead of displaying them in a NetSuite page. The Export button also has a menu option to export data only.
- From most search and saved search results pages:
  - Click Export - CSV to export results to a CSV file.
  - Click Export - PDF to export results to a PDF file.
Click Export - Microsoft® Excel to export results to an XLS file.

Note: If your account administrator enabled the Export to Tableau® Workbooks feature for your account and assigned you the Tableau Workbooks Export permission, your search results page will also contain the Export to Tableau Workbook icon. For more information, see the help topics Enabling Features and Permissions for Searches.

For results exported to a CSV or XLS file, you have the option of saving the file or opening it for immediate viewing in Microsoft® Excel. For results exported to a PDF file, the file opens immediately.

You can preserve the relational aspects of exported data by including the Internal ID as a results column in the search to be exported.

Exported search results can help to integrate NetSuite tasks with tasks you perform in different applications. For example, if you use cash sales without Advanced Shipping and ship your items to customers via UPS, you can use the search export function to transfer shipping information from NetSuite to UPS WorldShip®. You can:

- Create a transaction search to find all cash sales with UPS shipping items within a certain date range.
- On the Results subtab, select the information you want exported and in what order.
- Click Submit, and on the results page, click Export.
- You can then open the .csv file in UPS WorldShip®.

If your search results pages do not include an Export button, your account administrator may not have assigned you the Export Lists and Perform Search permissions. These permissions are required for exporting search results. See Permissions for Searches.

If your search takes a long time to run, and you want to export your search results to a CSV file, consider persisting search results. For more information, see Persisting Search Results.

Exports of each saved search are recorded in its execution log. This log is available to users with at least Create level of the Publish Search permission. See Audit Trail for Saved Searches, Reports and Schedules.

Warning: Note: Users can export all address search result fields on the customer record to Excel or CSV, including the following fields: addressee, address (returns the entire address string), address1, address2, city, state, zip code, and country.

Each export format has certain advantages and limitations. NetSuite recommends that you become familiar with the limitations before selecting a preferred format. Choosing the wrong format can affect data accuracy and report readability. For details on all export formats and their limitation see the help topic Comparing Export Formats.

Known Excel Limitations

Be aware of the following limitations for exporting search results to Excel:

- **Values with more than 16 digits** – When opening a CSV file directly, Excel treats long numeric sequences as numbers and displays them using scientific notation. This treatment leads to a loss of precision when the number has more than 16 digits and to loss of information when digits at 16+ position are truncated. Even if apostrophes or double quotes are used as text qualifiers, the text within them is still recognized by Excel heuristics as a number and an additional formatting hint must be provided. This heuristics is known in Excel as the “General” format. One way to work around this
limitation is to always open CSV files using Excel's multistep Text Import Wizard. The wizard lets you set column formatting in the last step (“Text” format). Alternatively, you can use a different Office suite, for example LibreOffice, which always displays the import wizard when opening a CSV file.

- **Item’s Detailed Description length** – When exporting search results that contain Detailed Description fields for items, the length of these fields in the exported Excel file is limited to 1,300 characters.

### Persisting Search Results

Persisting search results enables you to run saved searches asynchronously, for up to 3 hours, saving search results in a CSV file. This capability is useful for searches across high volumes of data that could possibly return a timeout.

The results for each search are saved in a CSV file that is available for 7 days. Results are deleted after this time period. When a search has a Pending status for 24 hours, its status changes to Failed. When a search has a Failed status, you can try to persist the search again. The available statuses are:

- **Pending** – Search is running.
- **Completed** – Search is finished. The download link is available.
- **Timeout** – An execution of the search exceeded the three hour time limit. The download link is not available.
- **Failed** – Some error occurred in the execution of the search. The download link is not available.

**To persist search results:**

1. Go to Reports > Saved Searches > All Saved Searches to view the Saved Searches list page.
2. Click **Persist (CSV)** for the search.

When you click **Persist (CSV)**, a Search Results page displays the status of the search running in the background.

When search execution is complete, a download link for a CSV file of the results is available on the Search Results page. You can also access this page by clicking the new Reports > Scheduled Searches > Search Results link.
Persisting Search Results for Non-Administrator Users

Administrators may enable other users with non-administrative roles to persist searches.

To allow a role to persist searches:

1. Go to Setup > Users/Roles > Manage Roles and click the custom role for users whom you want to enable to persist search results.
2. Click Edit to modify the role settings.
3. On the Permissions tab, click Lists.
4. Choose Persist Search from the bottom of the dropdown list and click Add.
5. Click Save.

If you want to enable selected users to persist searches, you can add the Persist Search permission to their global permissions. To learn how to assign a global permission, see the help topic Using the Global Permissions Feature.

Emailing Search Results

Most search results pages include an Email button that you can click to send results in the body of an email to any employee, vendor, customer, or partner entered in your account. (Popup search pages do not include this button.)

If your search results pages do not include an Email button, your account administrator may not have assigned you the Full level for the Perform Search permission. This level is required for emailing search results. See Permissions for Searches.

When you email search results, you need to select one primary recipient. You also can:

- Send a copy of the search results email to multiple additional recipients, as either Cc or Bcc.
- Send search results as an attached Microsoft® Excel file.
- Include in the email a comment that explains the results to the recipients.

**Note:** Saved searches provide a more powerful set of email options, including sending email alerts triggered by search results changes, and scheduling saved searches to be run and emailed at defined dates or intervals. For information, see Saved Search Email.

To email search results:

1. On a search results page, click the Email button to open a popup window.
2. Select the email's primary recipient in the Recipient box at the top of the window.
   1. Click the dropdown arrow to view a list of possible recipients.
2. Click on a recipient.

3. By default, search results are sent within the email message. Choose Send as CSV, Send as Microsoft® Excel, or Send as PDF to instead send search results in a file attached to the message. (Note that CSV is the preferred format because it is the most compact.)

4. Enter a comment to include in the body of the email, if desired.

5. The Recipient list at the bottom is where you can indicate other recipients to receive copies of the email. You can select these in the same way you selected the primary recipient. By default, the Cc box is checked. You can check the Bcc box instead.

6. Repeat step 5 for each additional recipient.

7. Click the Email button to send search results email.

**Important:** Because of existing email limitations, excessively large search results are truncated before they are sent in email. Emails containing truncated results include a note stating that truncation has occurred. This truncation occurs if an email's size is greater than 5MB or if the number of results exceeds 10,000 rows. To include the maximum possible data in a search email, send results as CSV, which is the most compact format. Use of other formats causes email size to be larger.

Permissions for Searches

Your NetSuite account administrator assigns roles to users. For each role, the administrator sets up permissions to view and edit objects and to complete tasks, and defines access to searches for specific record types.

You have one or more assigned roles that you can use to log in to NetSuite. The permissions and search access associated with the role you use to log in determine the searches that you can run during a NetSuite session. For saved searches, your role's permissions and search access determine the record types for which you can create saved searches.
NetSuite includes four different types of permissions: Lists, Reports, Setup, and Transactions. Five Lists type permissions determine your ability to run, export, and email searches, and to create, run, export, email, and share saved searches:

- **Perform Search** – This permission has two possible levels, View and Full. If you have View level for the Perform Search permission, you can run searches and saved searches, for record types to which you have access. If you have Full level for the Perform Search permission, you can run, create, and save searches, for record types to which you have access.

- **Publish Search** – This permission has four possible levels, View, Create, Edit, and Full. If you have Create level or higher for the Publish Search permission, you can share saved searches with other users, and set up alert emails and scheduled emails of saved search results. The Audience, Roles, Email, and Execution Log subtabs are available on the saved search definition page.

- **Persist Search** – This permission has only one possible level, Create. With this permission, a Persist (CSV) link becomes available for saved searches listed at Reports > Saved Searches > All Saved Searches. This permission enables you to extend the timeout for the saved searches you run to up to 3 hours and to save search results in a CSV file.

- **Export Lists** – This permission has only one possible level, Create. With this permission, Export and Email buttons become available on your search and saved search results pages, which enables you to export and email both searches and saved searches, for record types you are allowed to access. This permission is activated only if you have at least the View level for the Perform Search permission.

- **Tableau® Workbooks Export** – This permission has only one possible level, Create. With this permission, the Export to Tableau Workbook button becomes available on search and saved search results pages, enabling the export of search results as analysis-ready Tableau® workbooks, for record types you are allowed to access. The Export to Tableau button is available only for users who also have the Export Lists permission and at least the View level of the Perform Search permission.

In addition, the following Transactions type permission determines your ability to save a transaction search:

- **Find Transaction** – This permission has four possible levels, View, Create, Edit, and Full. If you have Create level or higher for the Find Transaction permission, the Create Saved Search button is available for transaction searches. With the View level, you can run transaction searches but you cannot save them.

Also, the following employee permissions determines your ability to create a search and perform a global search:

- Perform Search
- Employee Record

If you are experiencing difficulties running, exporting, or emailing searches, or creating, running, exporting, emailing, or viewing the log for saved searches, contact your administrator to determine whether your assigned role, permissions, and search access require changes. For information about role permissions, see the help topic NetSuite Permissions Overview.

Another level of access control applies to saved searches created by other users. You can access a saved search created by another user if the search is public, or if you have been defined as an audience member, either by name or based on your assigned role, department, subsidiary, or group.
Important: When you create or customize roles that require the capability to search for employees, you need to make sure the Perform Search, Employees, and Employee Search permissions are included for the role.

Note: Custom fields have an additional level of field-level security that applies to the use of custom fields in searches. Security for a custom field in searches can be defined as a Search/Reporting access level, on the custom field record. Access can be defined generally, and by role, department, or if you are using NetSuite OneWorld, subsidiary. Available access levels include Edit (can view and change the field), Run (can view the field in search and report results but cannot change it), and None (cannot view or change the field). For more information, see the help topic Restricting Access to Custom Fields.

Popup Searches

To facilitate searches, some individual records include select list fields that provide popup menus with search links. For example, the following figure shows, on an Opportunity record, a popup menu with a link to search items.

When you click a search link in a popup menu, a search opens in a new popup window. A popup search appears as either a simple or advanced search, according to which was used most recently for a search of the selected record type. So, for information about completing a popup search, see either Defining a Simple Search or Defining an Advanced Search.

Popup searches are different from other search pages as follows:

- They do not include the Use Advanced Search box, so they cannot be switched between simple and advanced.
- They do not include the Export, Reset, Customize, or Create Saved Search buttons.
- Their results pages display in the popup window.
- Their results pages do not include Export, Email, or Create Saved Search buttons.

Personalizing a Search Form

By default, the simple search form for each record type displays a system-defined set of fields that can be used as filters. To simplify your searches, you can personalize this form to include only the filters you need.

For example, if you always search customer records using either the customer name, sales rep name or partner name, you can create a personalized search form that only displays these three fields.

Note: An alternate approach is to apply available filters from a saved search to your simple search form. See Defining a Saved Search as a Preferred Search Form.

To personalize a search form:

1. Go to a search definition page.
Use a menu option like the following to get there:
- Reports > New Search
- Transactions > Management > Search Transactions
- Lists > (Category) > (Record Type) > Search

2. Ensure that the **Use Advanced Search** box is not checked, and click Personalize Search.

If this box is checked, clicking Personalize Search displays a saved search definition page, with many options that are not relevant to personalizing a search form.

On this page, you can:
- Change the search title. Default is: Preferred <record type> Search Form.
- Remove or reorder fields, to simplify your search form.
- Check the **Show in Footer** box for a field, to display it as an available filter in search results page filters.
- Check the **Show as Multi-Select** box to cause available filter values in the results page footer to display in a multi-select dropdown list rather than a single-select dropdown list. (Available only when **Show in Footer** box is checked)

**Note:** Available filter values that display on the search form itself are always displayed in a multi-select dropdown list. The Show as Multi-Select option applies only to the available filter in the search results page footer; it does not apply to the available filter on the search form.

- Enter a custom label for a field, to be displayed instead of the field name.
- Click **Save** to use these personalized settings for the record type search form.
Click More Options to display a full saved search definition page, where you can edit other options. (Note that if you make changes to other options on this page, these settings are preserved when you return to the simple personalization page, even though they are no longer visible.)

Click Cancel to return to the simple search form, with no changes.

After you have created a personalized search form, you can add it to your dashboard. See Adding Personalized Search Forms to NetSuite Pages.

Adding Personalized Search Forms to NetSuite Pages

You can add search form portlets to NetSuite pages. These portlets help you to quickly find the records you need.

You need to create a personalized search form before you can display it in a portlet. For information, see Personalizing a Search Form. After you have created the personalized form, you can add it to any NetSuite dashboard that offers search form portlet.

To add a personalized search form to a NetSuite page:

1. Click Personalize Dashboard on the NetSuite page to which you want to add your form.
2. In the Add Content panel, under the Standard Content folder, click or drag and drop the Search Form item.
3. In the Search Form portlet, click Set Up.
4. In the Search Form:Search field, enter the name of preferred search form. You can click the List button to see a list of available search forms.
5. Click Save.

You now can use your personalized form to search directly from this page.

Note: You need to complete different steps to add a search form to a website. See the help topic Search Forms.

Mass Changes or Updates

You can use the Mass Updates functionality to find multiple records, with outdated information and update all field values simultaneously of these records. If you have the Mass Updates permission, you can go to Lists > Mass Update > Mass Updates, where you can select from the mass update list to run a Mass Update page. This page is similar to a Saved Search, where you can define the:

- Filters used to select records to be updated
- Results columns to be displayed for an update
- Audience for an update
- Schedule to use for running the update (account administrators only)
- Field values to be updated for each record

To be available for mass update, a field must meet the following criteria:

- It must support inline editing. For more information, see the help topic Using Inline Editing.
- It must be displayed on your preferred form for the record type being updated.
- If it is a standard field, it must be outside of subtab lists and must not have dependencies on other fields.
- If it is a custom field, it must be stored and must not have a sourcing relationship.
When you define a mass update, you can perform it immediately or save it for future use. If you have the Schedule Mass Updates permission, you also can schedule a mass update to run on a recurring basis.

- When you run a mass update, processing 50 records or less begins instantly. If you are processing more than 50 records, there may be a delay of up to one minute before the job begins. When a mass update is in process, you cannot stop it or cancel it.
- After you have saved a mass update, it is available at Lists > Mass Update > Saved Mass Updates.
- For information about setting up a mass update, see Defining a Mass Update.
- For information about setting up a schedule for a mass update, see Scheduling a Mass Update.
- Be aware that only one mass update can be run at a time in your account.

Additional mass update options may be available at Lists > Mass Update, depending on the features enabled in your account.

- For information about Lists > Mass Update > Update Prices, see the help topic Updating Item Prices.
- For information about Lists > Mass Update > Swap Prices Between Price Levels, see the help topic Swapping Prices Between Price Levels.
- For information about Lists > Mass Update > Mass Duplicate Record Merge, see the help topic Duplicate Record Detection.
- For information about Lists > Mass Update > Bulk Update Translation, see the help topic Multi-Language Names and Descriptions.

If the mass update you want is not available, try using the Import Assistant to update data through import of a CSV file. For information, see the help topic Importing CSV Files with the Import Assistant.

It is possible to send an email in bulk for multiple transactions at one time with the possibility to attach any message to the email and with support for scriptable templates. For the procedure for setting a mass update for sending a bulk email for transactions, see the help topic Sending Transaction Email in Bulk

Mass Updates and SuiteScripts

- Mass Update Scripts
  You can programmatically perform custom mass updates to update fields that are not available through general mass updates, using a SuiteScript action script. See the help topic Mass Update Scripts. If the SuiteFlow feature is enabled, you also can use the mass updates functionality to find multiple record instances associated with a single workflow, and either initiate or process all records simultaneously. See the help topic Workflow Mass Updates.
- Mass Updates and User Event Scripts
  Be aware that a record change that results from a mass update can trigger a related user event script as the same change not made through a mass update would. However, in the case of the mass update, the full record is not passed to the user event script; instead, only the field(s) actually changed by the mass update are passed. For details about user event scripts, see the help topic User Event Scripts.

Defining a Mass Update

You can define a mass update if you have the Mass Updates permission.

**To define a mass update:**

2. On the Mass Updates list, expand a category and click a link.
3. In the **Title of Action** field, enter a name for this update.

   If you are saving this mass update, create a name that describes the update so you can find it in the future.

4. To enter the new information:
   - If you are performing a General mass update on a record type:
     
     Click the **Mass Update Fields** subtab and review the fields that are available for update.

     Check the box in the **Apply** column next to each field you need to update, and enter or select the new data in the **Value** column. Or, you can enter a formula to dynamically calculate values to be entered. See [Entering Formulas for a Mass Update](#).

     Fields exposed for mass updates are the same as those available for inline editing and include the following: standard fields that are outside of subtab lists and do not have dependencies on other fields, and custom fields that are stored and do not have sourcing relationships.
Important: For transactions updates, fields that are not displayed on your preferred form for a transaction are not made available for mass updates. For example, if your preferred invoice form does not include the To Be Printed field, this field is not listed on the Mass Update Fields subtab for a mass update to invoices.

- If you are performing a specific type of update, such as Contact Management:

  To the right of the Title of Action field, select or enter the new data.
Mass Changes or Updates

On the **Criteria** subtab, select filters that you want to use to set criteria. When you select a filter, a window pops up where you can select criteria.

5. Define a filter or filters on the **Criteria** subtab.
   - Select a field or formula in the dropdown list and enter values in the popup that appears.
   - For information, see Advanced Search Criteria Filters.

6. Define display options for mass update results on the **Results** subtab.
   - Select the order in which you want the results to sort.
   - Choose to view the list as a report.
   - Pick which columns you want to appear in the list.
   - For information, see Search Results Display Options.

7. Define the users who can run the update on the **Audience** subtab, if available.

8. If you are an administrator and you want to run the mass update on a recurring basis, set up this recurrence on the **Schedule** subtab. See Scheduling a Mass Update.

9. Click Preview to see which records the mass update will change, and review the Mass Update Preview page.
   - To modify the mass update, click Return to Criteria, and repeat steps 4-8 as necessary.
   - If your list has less than 1000 entries, an **Apply** column is shown. (If you want to show the **Apply** column, select search criteria that return results with less than 1000 entries.) If any record listed should not be updated, clear the box in the **Apply** column.

10. Choose one of the following options:
    - Click **Perform Update** to make the mass update.
      - After you click Perform Update, you cannot stop or cancel the mass update, so proceed with caution!
    - Click **Save** to save this mass update for future use.
      - When you save the update, it is not run. To make the mass update changes, go to Lists > Mass Update > Saved Mass Updates, and click Preview next to the name of the update. On the Mass Update Preview page, click Perform Update to make the changes.
      - When you save a mass update, you can always return to the list to make changes to the same records by going to Lists > Mass Update > Saved Mass Updates.
**Note:** You can update more than one field on records, by using the links under the General Updates heading on the Mass Updates list. Use the links under the Sales Force Automation, Contact Management, Activities, Files, Group Records, Customer Support and Service and Marketing headings to quickly create more specific updates that only affect one field.

### Entering Formulas for a Mass Update

For mass updates that are General updates, you can update multiple fields per record. You select the fields to be updated on the Mass Update Fields subtab of the mass update page, by checking the Apply box. For each selected field, you can enter a static value to use for updating the field in all records, in the Value field. Or, if you want to update a field based on dynamic values, you can enter a SQL expression in the Formula field. You can enter SQL directly in the Formula field, or click the Set Formula button to display a popup formula builder.

Formula values are dynamically calculated at the time a mass update is performed. Formulas can include NetSuite field IDs for which field values are substituted, SQL functions, and mathematical operators. NetSuite field IDs should be formatted as follows: `{field_name}`. Most common SQL functions and operators are available.

The following are example mass update formulas:

- To increase customer credit limits by 25%, do a Customer general update, check the Apply box for Credit Limit, and enter this formula: `{creditlimit} * 1.25`.

- To set inventory items' preferred stock level to twice the reorder point, do an Inventory Item general update, check the Apply box for Preferred Stock Level, and enter this formula: `{reorderpoint} * 2`.

**Note:** Knowledge of SQL will help you to fully leverage the flexibility and power of SQL functions to define complex formulas. For more details, refer to [SQL Expressions](#). Also, you can refer to [SuiteScript Supported Records](#) for tables of NetSuite field IDs.

### Scheduling a Mass Update

If you have the Schedule Mass Updates permission, you can set up a mass update to run on a recurring basis, according to a schedule that you specify.

Be aware that only one mass update can run at a time in your account. When a scheduled mass update is running, NetSuite recommends that you do not start another mass update.
Note: If you have Create, Edit, or Full level of the Schedule Mass Updates permission, a Schedule subtab displays on each mass update page, where you can define a new scheduled mass update. If you have Edit or Full level, you can edit an existing scheduled mass update and save it with the same name. If you have Create level, and you edit an existing scheduled mass update, you cannot save it with the same name; you need to save as a different name.

To set up a schedule for a mass update:

1. On a mass update page, click the Schedule subtab.
2. Enable the Run Update According to Schedule option.
3. Select the interval at which you would like to run the mass update, or click Single Event to run the mass update one time only.
4. As you select each interval, additional options are displayed for you to select. For example, if you select Weekly Event, you then can select individual days of the week on which to run the update.
5. Select a series start date. This is the first day on which the mass update is run.
6. Select an end date in the End By field or check the No End Date box to continue running the mass update indefinitely.
7. Define other characteristics of the mass update and save it. (See Defining a Mass Update.)

You must save a mass update for its schedule to take effect. After you have saved a scheduled mass update, it is listed at Lists > Mass Update > Saved Mass Updates, with its recurrence displayed in the Schedule column.

After you save a scheduled mass update, you can review information about the times it was run, in history columns on the mass update page's Schedule subtab. These columns include the date, user, and count of records updated for each time the mass update was run.

Translations for Mass Updates

When defining a mass update you can add translations for action titles and labels so that users of your mass update can view the results in other system supported languages.

Note: Translation support for mass updates is only available in accounts where the Multi-Language feature has been enabled. For further information on multiple languages see the help topic Configuring Multiple Languages. The translation languages need to be selected at Setup > Company > Preferences > General Preferences, on the Languages subtab. Add all the languages that you would like to make available on your mass update results.

You can add translations for mass update elements as follows:

- Adding Translations for the Saved Search title - The translated title will be displayed in the mass update results and also in the list of mass updates.
- Adding Translations for Saved Search column headings - The translated column headings and summary column headings will be displayed in the mass update results.
- Translations can also be added for saved searches. See Translations for Saved Searches.

These translations will be displayed when the NetSuite user interface is set to the appropriate system-supported language.
Adding Translations for the Mass Update action title

If the Multi-Language feature is enabled, the Mass Update definition page will display an additional subtab Action Title Translation.

Add translations for the Mass Update action title as follows:

1. From the Mass Update definition page, click on the Action Title Translation subtab.
2. For each language listed, enter the translated text into the Label column.
3. Click Save.

Adding Translations for Mass Update column headings

If the Multi-Language feature is enabled, the Results subtab of the Mass Update definition page will display two additional columns - Custom Label Translation and Summary Label Translation.

Add translations for the mass update column headings as follows:

1. From the Mass Update definition page, click on the Results subtab.
2. Click the field that you wish to edit.
3. Click the Custom Label Translation column.
4. Enter the translated text for each language.
5. Click Done.
6. Click the Summary Label Translation column.
7. Enter the translated text for each language.
8. Click Done.
9. Repeat steps 2-8 for every field that requires translating.
10. Click Save.
Example Mass Update

A sales manager can give all outdated lead records the status Customer-Lost Customer:

- From the Contact Management section of the Mass Updates list, the manager selects the Change Customer Status mass update. On the Mass Update page, the manager:
  - In the Change Status to dropdown list, selects Customer-Lost Customer.
  - On the Criteria subtab, defines the Date Created as a filter, and in the popup that appears, selects within last month to date and clicks Set.
  - On the Results subtab, defines the columns to be displayed as update results.
  - On the Audience subtab, defines the users who have access to the mass update.
  - Click the Save button.
- The mass update is now available as a saved mass update.

The manager can go to Lists > Mass Update > Saved Mass Updates each month and use the saved mass update to close lead records that have become outdated since the last update.

Available Mass Updates

The following mass updates may be available in your system. Fields exposed for mass updates are the same as those available for searching and include the following: standard fields that are outside of subtab lists and do not have dependencies on other fields, and custom fields that are stored and do not have sourcing relationships.
**Note:** If a mass update is not available for your needs, try using the Import Assistant to update data through a CSV file import. For information, see the help topic Importing CSV Files with the Import Assistant. Also, you can programmatically perform custom mass updates to update fields that are not available through general mass updates, using a SuiteScript action script. See the help topic Mass Update Scripts. If the SuiteFlow feature is enabled, you also can use the mass updates functionality to find multiple record instances associated with a single workflow, and either initiate or process all records simultaneously. See the help topic Workflow Mass Updates.

You may not have access to all of the updates in the following list. The updates available to you depend upon the features enabled in your account, and on your assigned roles and permissions. Also, you may have access to additional mass updates for custom record types defined in your account. Custom record updates are exposed under General Updates. To see the updates available to you, navigate to Lists > Mass Update > Mass Updates and expand each mass update category.

Some mass updates have subcategories. Click on the triangle to expand and view the subcategories.

### Mass Updates

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Updates</td>
</tr>
<tr>
<td>Sales Force Automation</td>
</tr>
<tr>
<td>Contact Management</td>
</tr>
<tr>
<td>Activities</td>
</tr>
<tr>
<td>Files</td>
</tr>
<tr>
<td>Group Records</td>
</tr>
<tr>
<td>Customer Support and Service</td>
</tr>
<tr>
<td>Transactions</td>
</tr>
<tr>
<td>Reassign Transactions</td>
</tr>
<tr>
<td>Add Sales Team Member</td>
</tr>
<tr>
<td>Remove Sales Team Member</td>
</tr>
<tr>
<td>Replace Sales Team Member</td>
</tr>
<tr>
<td>Add Partner</td>
</tr>
<tr>
<td>Remove Partner</td>
</tr>
<tr>
<td>Replace Partner</td>
</tr>
<tr>
<td>Bulk Email</td>
</tr>
<tr>
<td>Opportunities</td>
</tr>
</tbody>
</table>

### General Updates

**Note:** Not all fields in the supported record types are available for mass update. When you select a record type for a general mass update, the Mass Update Fields subtab lists the updatable fields. For transactions updates, fields that are not displayed on your preferred form for a transaction are not made available for mass updates.

- Case
- Company
- Contact
- Customer
- Employee
- Issue
- Items
  - Assembly Item
  - Inventory Item
  - Kit/Package
  - Non-inventory Item
    - For Purchase
    - For Resale
    - For Sale
- Other Charge
  - For Purchase
  - For Resale
  - For Sale
- Service
  - For Purchase
  - For Resale
  - For Sale
- Project
- Opportunity
- Partner
- Campaign
- Phone Call
- Report
- Task
- Time
- Transactions
  - Assembly Build
  - Assembly Unbuild
  - Bill
  - Bill Credit
  - Bill Payment
  - Blanket Purchase Order
  - Credit Card Refund
  - Cash Refund
  - Cash Sale
  - Check
  - Credit Card (Payment)
  - Credit Memo
- Customer Deposit
- Customer Refund
- Deposit
- Estimate
- Expense Report
- Fulfillment Request
- Inventory Adjustment
- Inventory Cost Revaluation
- Inventory Worksheet
- Invoice
- Item Fulfillment
- Item Receipt
- Journal (custom fields only)

⚠️ Warning: If you update any type of journal entry that has been applied as a payment to an invoice or vendor bill, the relationship between the journal entry and payment is removed and the payment is no longer applied.

- Payment
- Period End Journal
- Purchase Contract
- Purchase Order
- Request for Quote
- Requisition
- Return Authorization
- Revenue Commitment
- Revenue Commitment Reversal
- Sales Order
- Vendor Prepayment
- Vendor Prepayment Application
- Vendor Request For Quote
- Vendor Return Authorization
- Work Order
- Work Order Close
- Work Order Completion
- Work Order Issue

- Vendor
- Custom Records

Sales Force Automation
- Convert Projects to Subcustomers
Mass Changes or Updates

- Change Sales Rep Assignment
- Change Territory Assignment
- Reassign Customers by Sales Territory Rules
- Add Sales Team Member (when Team Selling enabled)
- Remove Sales Team Member (when Team Selling enabled)
- Replace Sales Team Member (when Team Selling enabled)
- Add Partner (when Multi-Partner Management enabled)
- Remove Partner (when Multi-Partner Management enabled)
- Replace Partner (when Multi-Partner Management enabled)

Contact Management

- Change Customer Status
- Inactivate Companies
- Inactivate Contacts
- Inactivate Customers
- Inactivate Vendors
- Inactivate Partners
- Change Owner
- Add Contact Category

Activities

- Mark Events Complete
- Delete Events
- Mark Tasks Complete
- Delete Tasks
- Mark Phone Calls Complete
- Delete Phone Calls

Files

- Inactivate Files
- Move Files to Folder
- Delete Files
- Make Files Available Online

Group Records

- Group Customers
- Group Vendors
- Group Employees
Mass Changes or Updates

- Group Partners
- Group Contacts

Customer Support and Service

- Change Case Status
- Change Support Rep Assignment
- Reassign Cases by Case Territory Rules
- Change Case Priority
- Escalate Cases
- Change Customer Role
- Inactivate Cases
- Delete Cases

Transactions

- Reassign Transactions (available here when Team Selling is enabled)
- Add Sales Team Member (when Team Selling enabled)
- Remove Sales Team Member (when Team Selling enabled)
- Replace Sales Team Member (when Team Selling enabled)
- Add Partner (when Multi-Partner Management enabled)
- Remove Partner (when Multi-Partner Management enabled)
- Replace Partner (when Multi-Partner Management enabled)
- Bulk Email

Opportunities

- Reassign Opportunities
- Add Sales Team Member (when Team Selling enabled)
- Remove Sales Team Member (when Team Selling enabled)
- Replace Sales Team Member (when Team Selling enabled)
- Add Partner (when Multi-Partner Management enabled)
- Remove Partner (when Multi-Partner Management enabled)
- Replace Partner (when Multi-Partner Management enabled)

Marketing

- Send Subscription Message to Entities
- Send Subscription Message to Customers
- Send Subscription Message to Contacts
- Send Subscription Message to Vendors
- Send Subscription Message to Partners
Reports
Delete reports (For more information, see the help topic Mass Updating Reports.)

Items
- Change Item Units of Measure on Assembly/Bill of Materials
- Update Item Prices (For more information, see Updating Item Purchase Prices.)
- Update Purchase Price from Most Recent Purchase (For more information, see Updating Item Purchase Prices.)
- Apply Merchandise Attributes

**Note:** When Prices are enabled, another mass update that lets you change price level pricing is available at Lists > Mass Update > Swap Prices Between Price Levels. For information, see Swapping Prices Between Price Levels.

Rev Rec Schedules
- Update Is Recognized Flag
- Create/Recreate Schedules on Sales Orders & Return Authorizations

For more information, see the help topic Mass Updating Revenue Recognition Schedules.

Amortization Schedules
- Update Is Recognized Flag

(For information, see the help topic Mass Updating Amortization Schedules.)

Special Transaction Updates
- Update Orders Kit Members with Current Kit Members

For more information, see Kit/Package Items.

Individuals
- Reformat Customers Using Last Name First
- Reformat Customers Using First Name First
- Reformat Vendors Using Last Name First
- Reformat Vendors Using First Name First
- Reformat Partners Using Last Name First
- Reformat Partners Using First Name First
- Reformat Employees Using Last Name First
- Reformat Employees Using First Name First
- Reformat Contacts Using Last Name First
- Reformat Contacts Using First Name First
Roles & Permissions

- Add/Edit Permission on Roles

For information, see the help topic Mass Updating a Permission on Custom Roles.

Web Site Redirects

- Delete Web Site Redirects

For information, see Delete Web Site Redirects Mass Update.

Templates

- Inactivate Campaign Templates
- Inactivate Email Templates
- Inactivate Fax Templates
- Inactivate System Email templates

Duplicate Resolution

- Contacts
- Customers
- Partners
- Vendors

Customer Web Site Assignment

- Update Customer Web Site Assignment

Item Collection

- Add Items to Item Collection

For information, see the help topic Creating Item Collections.

Custom Updates

- If you have created any SuiteScript action scripts that programmatically update fields not available through general mass updates, they are listed here, according to record type. For information about creating these scripts, see the help topic Mass Update Scripts.

Workflows

- If you have created any workflows, mass updates to initiate or process all workflow records simultaneously are listed here. Each workflow is listed in alphabetical order, with Initiate <workflow...
Mass Changes or Updates

name> and Process <workflow name> links. For more information, see the help topic Workflow Mass Updates.

Mass Updates of Global Subscription Status

You can use the Global Subscription Status field to help manage marketing email campaigns. This field, which has replaced the formerly used Unsubscribe field, is available for mass updates on Company, Contact, Customer (including Leads and Prospects), Partner, and Vendor records. Be aware that mass updates can only set the value of this field to Soft Opt-In or Soft Opt-Out. Only users themselves can change their status to Confirmed Opt-In or Confirmed Opt-Out. The following mass updates are permitted:

<table>
<thead>
<tr>
<th>If Current Status Is:</th>
<th>Mass Update Can Set Status to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmed Opt-In</td>
<td>Soft Opt-In or Soft Opt-Out</td>
</tr>
<tr>
<td>Soft Opt-In</td>
<td>Soft Opt-Out</td>
</tr>
<tr>
<td>Soft Opt-Out</td>
<td>Soft Opt-In</td>
</tr>
<tr>
<td>Confirmed Opt-Out</td>
<td>(NO MASS UPDATE AVAILABLE)</td>
</tr>
</tbody>
</table>

For more information on global subscription statuses, see the help topic Subscription Management.

To perform a mass update of global subscription status:

2. Expand General Updates, then click Company, Customer, Partner, or Vendor.
3. Set criteria for the users you want to update.
4. On the Mass Update Fields subtab, check the Global Subscription Status box.
5. Select the status you want to set: Soft Opt-In or Soft Opt-Out
   - All records that match the criteria you have set and that are permitted to be changed through mass updates will be set to the selected status.
6. Click Save.

Performing Mass Deletes

The Mass Update functionality enables you to delete multiple records. To perform mass deletes, you must have the Mass Updates permission and the appropriate permission level to delete the records. For example, to use the Delete Files mass update, you must have at least the Edit level of the Documents and Files permission. Files deleted using the Delete Files mass update cannot be recovered.

Available Deletions

The following table describes the mass deletes that are available on the Mass Updates page and the permission required to delete the records.

<table>
<thead>
<tr>
<th>Delete Name</th>
<th>Permission Required</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Cases</td>
<td>Cases - Full</td>
<td></td>
</tr>
<tr>
<td>Delete Name</td>
<td>Permission Required</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Events</td>
<td>Events - Full</td>
<td></td>
</tr>
<tr>
<td>Delete Files</td>
<td>Documents and Files - Edit</td>
<td></td>
</tr>
<tr>
<td>Delete Phone Calls</td>
<td>Tasks - Edit</td>
<td></td>
</tr>
<tr>
<td>Delete Reports</td>
<td>Owner or Administrator</td>
<td></td>
</tr>
<tr>
<td>Delete Tasks</td>
<td>Tasks - Edit</td>
<td></td>
</tr>
<tr>
<td>Delete Web Site Redirects</td>
<td>Set Up Web Site - Full</td>
<td></td>
</tr>
<tr>
<td>Remove Partner</td>
<td>Estimate - Edit</td>
<td>Removes a partner from a customer or sales transaction, if the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>partner contribution percentage is set to 0%.</td>
</tr>
<tr>
<td>Remove Sales Team Member</td>
<td>Estimate - Edit</td>
<td>Removes a sales team member from a customer, if the sales</td>
</tr>
<tr>
<td></td>
<td></td>
<td>member commission assignment percentage is set to 0%.</td>
</tr>
</tbody>
</table>

**To perform a mass delete:**

2. Expand an item in the **Action** list to see which records can be deleted in bulk. For example, if you expand **Activities**, you can mass delete events, tasks, or phone calls.
3. Choose the record type to delete and click the link. For example, to delete event records, click **Delete Events**. The Mass Update page opens.
4. In the **Filter** list on the **Criteria** tab, specify the criteria that define the records you want to mass delete. For example, you can delete all events for a specific Attendee.
5. When you have finished, click **Preview**.
6. Review the records that match your criteria.
   - If you want to keep any of these records, clear the **Apply** box next to them.
7. To mass delete the records, click **Perform Update**.
Saved Searches

A saved search is a reusable search definition, that can have many advanced search filters and results display options. If you have the Publish Search permission, you can share search results with other users. Saved search results provide reporting and tracking and can serve as the basis for business analysis and strategic decision-making.

You may decide you want to save a search when you are defining a search, or after you have run a search. Or you may know in advance that you want to create a saved search rather than a search. When you have decided to save a search, and you have opened a saved search page, you can define the saved search. For step-by-step instructions, see Defining a Saved Search.

As you are defining a saved search, you can specify that results be sent automatically by email to selected recipients, if you have the Publish Search permission. Email messages of search results can be sent at scheduled intervals and/or when results are updated, without you needing to rerun the search. See Saved Search Email.

After you have defined a saved search, you and other users designated as audience members can access the search by title from NetSuite saved search menus. For information, see Accessing a Saved Search.

Each saved search has an execution log listing the users who have run or exported the saved search in the past 60 days, and the dates and times of each execution. See Auditing Saved Search Execution. An audit trail is also available for tracking changes to saved searches. See Audit Trail for Saved Searches, Reports and Schedules.

Your account administrator grants general search permissions and search access by record type that enable you to create and run saved searches. Your level of search permissions determines whether you can email, export, and persist saved search results, whether you can share saved searches with other users, and whether you can view saved search execution logs. For more information, see Permissions for Searches.

If your saved search takes a long time to run, you may consider setting up a scheduled email or persisting search results. For more details, see Enabling Saved Search Scheduled Email and Persisting Search Results. If you have the Application Performance Management SuiteApp installed in your account, you can also use the Search Performance Analysis dashboard to view search performance details. For more information, see the help topic Analyzing Search Performance.

Saved search results can be linked to and displayed from dashboard portlets:

- You can add links to results pages in the Shortcuts portlet. See Creating Shortcuts to Saved Search Results.
- You can display detailed results in a Custom Search portlet. See Displaying Saved Search Results in Dashboard Portlets.
- You can use other portlets to display multiple saved searches on your home page. See Displaying Multiple Saved Searches on Your Home Page.
- You can display summary values from saved search results by defining saved searches as custom KPIs. See the help topic Custom KPIs. Custom KPIs can be displayed in the following portlets:
  - Key Performance Indicators Portlet. See the help topic Adding a Custom KPI to the Key Performance Indicators Portlet.
  - KPI Scorecard Portlet. See the help topic Using a Custom KPI in a KPI Scorecard.
  - KPI Meters. See the help topic KPI Meters.
  - Trend Graphs. See the help topic Trend Graphs.
- You can add counts of and links to results in the Reminders portlet. See the help topic Creating Custom Reminders.
You also can use saved searches in the following ways:

- You can designate results to be used as the dashboard view, list view, and/or sublist view of the selected record type. See Using a Saved Search as a View.
- You can designate a search’s filtering and display options to be used on forms for the selected record type. See Defining a Saved Search as a Preferred Search Form.
- You can publish the results of public saved searches to your website. Users with the Publish Search Permission can make saved searches public. For more information, see the help topic Adding a ‘Tell A Friend’ Link.

### Defining a Saved Search

To create a saved search, you need to access a saved search definition page for a selected record type.

You can access a saved search definition page in any of the following ways:

- Go to Reports > Saved Searches > All Saved Searches > New and select the record type for the saved search.
  - You can also use Transactions > Management > Saved Searches > New or Lists > Search > Saved Searches > New.
- On a simple or advanced search definition page, click the **Create Saved Search** button.
- On a search results page, click the **Save This Search** button.
- For an existing saved search, go to Reports > Saved Searches > All Saved Searches, and click Edit next to the saved search you want to redefine.

#### To define a saved search:

1. On a saved search definition page, enter a title for the saved search.
   - Try to make the title concise and meaningful, as it may appear in menu links, as a dashboard portlet header, or as a custom KPI name.
2. If you are editing an existing saved search, you can use the **Owner** dropdown menu to change the search owner. By default, the user who created the saved search is the owner of the search.
   - The **Owner** dropdown menu is available to administrators and, if the search is public or has an audience defined, to the search owner.
3. If you want the search to be available to all users, check the **Public** box. If not, you can define a more limited audience on the **Audience** subtab.
   - The **Public** check box and the **Audience** subtab are available only to administrators and to other users with at least Create level of the Publish Search permission, a Lists type permission.
   - Making a saved search public means all users can run the search and see its results. Even for public searches, only administrators and the search owner, meaning its creator, can edit the search. To allow other audience members to edit saved search definitions, you need to check the **Allow Audience to Edit** check box on the **Audience** subtab.

**Warning:** If the owner of a scheduled saved search is changed to another user who has never previously scheduled a saved search, the search email is no longer sent at the scheduled time. For scheduled email for this search to resume, the new owner must log in with the appropriate role and resave the search.
If you create a saved search but do not have the Publish Search permission, any searches you create are automatically marked as public. This prevents you from the deleting the search or editing the search definition, even though you are the search owner. For more information, see Editing or Deleting a Saved Search.

Customers, vendors, and partners other than advanced partners generally do not have access to saved searches, even those that are defined as public. If these types of users do gain access to a published saved search, they can run the search only if they have permission to view the search record type, and the search returns only their own records. However, if your saved search contains sensitive information, it is strongly recommended that you do not make it public, and instead use the fields on the Audience subtab to define a more limited audience.

4. Check any of the following boxes, if you want search results to be available as views for list pages of the searched record type.
   - Available as List View
   - Available as Dashboard View
   - Available as Sublist View

If you want these views available to a subset of the audience, leave these boxes blank, and check the corresponding boxes on the Roles subtab. For more information, see Using a Saved Search as a View.

5. If you want to be able to link to search results from the Reminders portlet, check the Available for Reminders box. For more information, see the help topic Creating Custom Reminders.

6. If you want this search to be available in menus, check the Show in Menu box.

7. On the Criteria subtab, define criteria to filter saved search records. These criteria can include dynamically calculated field values, including join fields; formulas containing SQL functions, as well as AND/OR expressions. For information, see:
   - Advanced Search Criteria Filters
   - Formulas in Search
   - Search Formula Examples and Tips
   - Using And/Or Expressions in Search Criteria
   - Related Records Fields Available for Advanced Searches

   **Note:** To use a saved search as a custom KPI that displays results for multiple date ranges, you must not define a date field as a filter on the Criteria subtab. For additional requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom KPIs.

8. On the Results subtab, define display options for saved search results, including:
   - In the subtab header:
     - Sort order of results records, or rows

     **Note:** A saved search must include at least one sort order. If you do not specify a column in the Sort By field, when the record is saved, the first column specified on the Columns subtab is used for sorting. For saved searches with large data sets, set Sort By to the same columns that you added on the Results subtab.

     - Output type, meaning overall format for the results page
     - Show Totals option to display a total line on results page
     - Run Unrestricted option to make search results available to users who would normally be restricted from seeing the underlying records. Note that users without the correct permission cannot access the underlying records.
permissions will still be unable to view the search results. See the help topic Permissions and Restrictions

**Important:** The Run Unrestricted option is not applied to time and expense searches by users that have roles with the Restrict Time and Expenses option enabled. Employees using a role with the Restrict Time and Expenses option enabled cannot enter expense reports or time transactions on behalf of other employees and their reports and searches do not return any time or expense transactions entered by other employees. The Restrict Time and Expenses option for a role overrides the Run Unrestricted option for a search.

- Disallow Drill Down option to prevent users of unrestricted search results from drilling down to more detailed data
- Max Results option to limit the number of records displayed in results
- My Preferred Search Results option to apply search settings to quick search results pages (See Defining a Saved Search as Preferred Results.)

**On the Columns subtab:**

- Order of columns
- Fields and/or formula calculations to be displayed as columns on the search results page, including:
  - Custom labels for one or more fields
  - Summary types to group one or more fields' values (including group, sum, count, min, max, and average)
  - Functions to be applied to one or more fields' values

**On the Drill Down Fields subtab (if available):**

- Fields, including join fields, to be displayed when a viewer of search results drills down on a record
- The order in which drill down fields are displayed
- Custom labels for displayed drill down fields

For more information, see Search Results Display Options.

9. On the Available Filters subtab, define fields or formulas to appear as filters on the results pages. For information, see Selecting Available Filters for Saved Searches.

**Note:** To use a saved search as a custom KPI that displays results for multiple date ranges, you must define a date field as an available filter. You do not need to check the Show in Filter Region box. For additional requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom KPIs.

10. (If you have at least the Create level of the Publish Search permission) On the Audience subtab, define the users who can run the saved search and view its results, and whether they can edit its definitions. For information, see Defining Audiences for Saved Searches.

11. (If you have at least the Create level of the Publish Search permission) On the Roles subtab, define the users who will see search results as their view of the selected record type, in lists, sublists, dashboard list portlets, forms, and quick search results. For information, see Using a Saved Search as a View and Defining a Saved Search as a Preferred Search Form.
12. (If you have at least the Create level of the Publish Search permission) On the Email subtab, you can send search results email, as alerts triggered by record changes, and/or according to a schedule.

- Check the Send Alerts When Records are Created/Updated box to send email alert messages when saved search results are added or updated, and then define recipients for alerts. For information, see Enabling Saved Search Email Alerts.
- You can make alerts available to users other than defined recipients by checking the Public and Allow Users to Subscribe boxes. Then users can go to Home > Set Preferences and elect to receive alerts. For information, see Setting User Preferences to Receive Saved Search Alerts.
- Check the Send Emails According to Schedule box to set up the search to be run on a certain date or interval, with results emailed to yourself and/or other users. For information, see Enabling Saved Search Scheduled Email. Scheduling is a good option for saved searches that take a long time to run.

For more information, see Saved Search Email.

13. On the Highlighting subtab, you can set up visuals to draw attention to selected individual or aggregated results. Highlighting options include images, colored text, background colors, and bold text. For information, see:

- Highlighting Search Results
- Adding a Legend to Highlighted Search Results

14. After you have completed saved search definitions, you can do the following:

- Click Preview to review search results without saving the search definitions.
- Click Save to save search definitions and make the search available to be run by yourself and other audience members.
- Click Save & Run to save search definitions and review search results.
- Click Save & Email to save search definitions and email results to the recipient(s) you set up on the Email, Specific Recipients subtab. (available only if you have the Publish Search permission)

For information about viewing saved search results, see Displaying Saved Search Results on Your Dashboard.

Notes on Using Saved Searches as Custom KPIs

For a saved search to be used as a custom KPI that displays results for multiple date ranges in the Key Performance Indicators portlet, a KPI scorecard, a trend graph, or a KPI meter, the search definition must:

- Not include any date fields defined as filters on the Criteria subtab
- Have only field with a summary type (such as group, sum, or count) defined on the Results subtab.
- Have a date field defined as an available filter on the Available Filters subtab.

For more information, see the help topic Custom KPIs.

Selecting Available Filters for Saved Searches

The filters you define on the Criteria subtab of a saved search page exclude records from search results. On the Available filters subtab, you can define additional, optional filters that search viewers can use to further limit results, or that other system functions like KPI scorecards can use internally to calculate summaries and comparisons of results.

Available filters can appear as dropdown menus or multi-select boxes of field values in the filter region of search results, and viewers can select values to dynamically apply filtering to search results. You can define a custom label for each available filter’s dropdown list or multi-select box.
To define available filters for a saved search:

On the Available Filters subtab of the saved search page:

1. To define a field to be available as a dynamically set filter on search results, select the field from the Filter dropdown list.
   Fields from the selected record type and join fields from related record types are listed in the Filter dropdown list.

2. For each filter that has non-numeric values, you can check the Show in Filter Region box to display choices of field values in the filter region of search results, so that search viewers can dynamically filter results.
   By default, field values are displayed in a dropdown menu where viewers can select one value at a time.
   Please note that there are limitations for certain filters included in the filter region. For details, see Limitations for filters displayed in the filter region.

3. When the Show in Filter Region box is checked, you can check the Show as Multi-Select box to cause values to be displayed in a multi-select dropdown list, enabling you to select multiple values to filter search results.
   - In search results page filters, values are by default displayed in a single-select dropdown list.
   - The Show as Multi-Select option does not apply to available filters shown on search forms.
     Values for an available filter on a search form are always displayed in a multi-select dropdown list.

4. For each filter, you have the option of defining a custom label.

A transaction saved search with the Type field defined as an available filter and the Show in Filter Region box checked displays a Type dropdown list on the results page, where a viewer can choose one type of transaction at a time to dynamically filter search results.

---

**Note:** To use a saved search as a custom KPI that displays results for multiple date ranges, you must define a date field as an available filter. You do not need to check the Show in Filter Region box. For additional requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom KPIs.
If the Show as Multi-Select box is checked, a multi-select box displays in the filter area so that you can choose multiple Type values to filter search results.

Limitations for filters displayed in the filter region

- If you add a date filter that has already been set on the Criteria tab and select the Show in Filter Region option for this field, the field in the filter region will inherit the date settings specified on the Criteria tab. For example, if you added a Date Created field on the Criteria tab and set it to before 12/31/2014, the date filter in the filter area will display results that were created before any other date that you choose in the filter area.

- If you add a Period filter that has already been set to a specific period on the Criteria tab, the Period field in the filter region will not contain that specific period, and it will neither be available in the filter’s dropdown list. For example, if the Period field is set to May 2013 on the Criteria tab, the Period filter in the search results will appear blank, and May 2013 will be not listed as an available option for this filter.

Defining Audiences for Saved Searches

If you are an administrator or have at least Create level of the Publish Search permission, you can use the Audience subtab on saved searches to define a list of users who can run the search and view its results. You also have the option of making the search available to all users by checking the Public box. For information, see Making Saved Searches Public.

Only users who are members of the defined audience and account administrators see the saved search on search related lists. Setting the audience for a saved search also restricts its appearance in list views, sublist views, dashboard list portlets, and preferred search forms. You set up these preferences on the Roles subtab. By default only administrators and the owner of a saved search, meaning its creator, can edit the search. Audience members cannot edit saved search definitions unless you check the Allow Audience to Edit check box.

Customers, vendors, and partners other than advanced partners generally do not have access to saved searches, even those that are defined as public. If these types of users do gain access to a published
saved search, they can run the search only if they have permission to view the search record type, and the search returns only their own records. However, if your saved search contains sensitive information, it is strongly recommended that you do not make it public, and instead use the fields on the Audience subtab to define a more limited audience.

**To define an audience for a saved search:**

1. When defining or editing a saved search, click the **Audience** subtab.
2. If you want to allow the audience to make changes to search definitions, check the **Allow Audience to Edit** box.

   - If this option is enabled, the audience can make changes and save the search with the same name.
   - If this option is not enabled and the audience makes changes, they can do a “save as” to save the search with a different name.
3. In the fields provided, choose an audience for your search results. You can select options from any or all of the following audience types.

   For each of the audience types, you can select multiple options by holding down the Ctrl key as you are making your selections.
   - **Roles** – Select one or more roles.
     To make the search available to all users in your account, check the **Select All** box.
   - **Departments** – Select one or more departments.
   - **Subsidiaries (If Available)** – Select one or more subsidiaries.
   - **Groups** – Select one or more groups.
   - **Employees** – Select one or more employees.
     To make the search available to all employees, check the **Select All** box.
   - **Partners** – Select one or more partners.
     To share with all partners, check the **Select All** box.

**Note:** If your account contains a large number of roles, they may not be in a dropdown list, making it difficult to select multiple roles. You can change the roles list to display in a dropdown list by increasing the number set for Maximum Entries in Dropdowns at Home > Set Preferences, on the **General** tab.
Defining a Saved Search

Important: If you choose both role and department options, a user must belong to one of the selected roles AND one of the selected departments to access the search. If you choose any other combination of options, a user needs to belong to only one type of option OR the other, not both, to access the search.

Making Saved Searches Public

To define a saved search as public, check the Public box near the top of the saved search page. This check box is available only to administrators and to other users with the Publish Search permission, a Lists type permission. If you are unable to check this box or you do not see it, you do not have the ability to make saved searches public.

Public saved searches can be published in your website, and they are available to be run by everyone with access to your account. The use of public saved searches can save time for employees and ensure that all users conduct searches using the same criteria. Also, if you want a saved search to be available for inclusion in a NetSuite bundle, you must make it public.

By default, only administrators and a saved search's owner (creator) can edit its definitions. Users can run and view results of a public saved search, but they cannot edit its definitions and resave it with the same name, unless the Allow Audience to Edit box is checked. Users can, however, edit the search and click the Save As button to save the search with a different name.

Note: You can let users subscribe to email alerts of search results only if you already have made the saved search public. For more information, see Enabling Saved Search Email Alerts.

Highlighting Search Results

Saved searches provide a variety of highlighting options you can use to call attention to selected search result rows. You can highlight individual rows that meet defined conditions. If your search results include grouped values such as counts, sums, and averages, you can highlight aggregated results that meet defined conditions.

Available highlighting options include:

- Images
- Text colors
- Background colors
- Bold text
- Description for a highlighting legend in the results page.

For information about highlighting search results, see:

- Step-by-Step Instructions for Highlighting Results
- Conditions for Highlighting
- Summary Highlighting
- Adding a Legend to Highlighted Search Results

Step-by-Step Instructions for Highlighting Results

1. When editing or creating a saved search click the Highlighting subtab.
2. On the Highlight If or Highlight If (Summary) subtab, click the Set Options icon next to the Condition field to open a popup window.
- If you want to include expressions in the condition's filter(s), check the **Use Expressions** box. For information, see Using And/Or Expressions in Search Criteria.
- If you are creating a condition for summary results, select from the Summary Type dropdown list. This selection must match the summary type defined for the field on the **Results** subtab.

3. In the popup, select a field or a formula to be used as filter for the highlighting condition.

**Note:** If you are creating a condition for summary results, make a selection from the Summary Type dropdown list. This selection must match the summary type defined for the field on the **Results** subtab.

- To define a field value from the selected record type as a filter:
  - Select the field from the Filter dropdown list.
  - Click the **Set Options** button to open a popup where you can enter a value, and search logic (if available), for the filter field.
- To define a formula as a filter:
  - Select a Formula option from the Filter dropdown list.
  - Click the **Set Options** button to open a popup where you can enter the formula.
  - For more information about search formulas, see Formulas in Search.
- To define a join field value from a related record type as a filter:
  - Select the related record type in the Filter dropdown list.
  - In the first popup that appears, select the join field from a Filter dropdown list.
  - In the next popup, enter a value, and search logic (if available), for the filter field.
  - For a list of related record types with join fields available for each record type search, see Related Records Fields Available for Advanced Searches.

4. Repeat step 3 for each filter you want to apply as a condition for highlighting results. When you have added all filters, click the **Set** button in the popup.

5. If you want to use an image to highlight results that meet the condition, select from the Image dropdown list, or click the Icon next to this dropdown list and select an image from the popup Icon Picker.

6. If you want to change the text color of each result that meets the condition, click the Select Color icon in the **Text Color** column.

7. If you want to change the background color of each result that meets the condition, click the Select Color icon in the **Background Color** column.

8. If you want to bold text for each result row that meets the condition, check the **Bold** box.

9. If you want to include a Legend in the footer of the Search, enter a Description for this highlight condition. For more information about legends, see Adding a Legend to Highlighted Search Results.

10. Click **Add**.

11. Repeat steps 2-10 for each highlighting condition you want to apply to the results of this search.

12. Click **Save**.

**Conditions for Highlighting**

You select the result rows to be highlighted by defining conditions on the Highlighting subtab of a saved search page. You can define multiple conditions for each saved search; each condition can have its own associated highlighting options. A condition consists of one or more filters that are compared with results...
Defining a Saved Search

values. Results that satisfy filter(s) meet the condition, and are highlighted according to the options you set for that condition.

For example, you could create a condition for a saved customer report that would apply a green background to all customers in San Francisco with a balance greater than $5000. You then could create an additional condition that would highlight customers in San Diego with a balance over $5000 with a blue background.

One row in a search result can meet more than one highlight condition. When multiple conditions are met, highlighting depends on the order of highlight conditions. The first condition has the highest priority. When the first met highlight condition doesn't use all highlight possibilities (Image, Text color, Background color, Bold) then another condition is applied but for available criteria. If there are multiple conditions, the search results will be highlighted using the order of the conditions. For example, if a search result is a row with the following values.

<table>
<thead>
<tr>
<th>Name</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adam</td>
<td><a href="mailto:No@nsmail.com">No@nsmail.com</a></td>
</tr>
</tbody>
</table>

For this example, the user applies multiple condition in this order:

1. Name starts with 'X', Background Color is 'Black', Bold is 'None', Text Color is 'White', and Image is 'None'.
2. Name starts with 'A', Background Color is 'Green', Bold is 'None', Text Color is 'None', and Image is 'None'.
3. Email starts with 'N', Background Color is 'Red', Bold is 'Y', Text Color is 'None', and Image is 'None'.

Nothing in the first condition applies to the search result. In the second condition, the search result matches the criteria of 'Name starts with A' so the entire rows background is green. In the third condition, the email does match the criteria of 'Email starts with N' so the background would be red, however, in the second condition the criteria supersedes this criteria. The 'Bold is Y' criteria is a match so the entire row has bold text.

Highlighting Using Greater Than or Magnitude Greater

The difference between the 'Greater Than' and 'Magnitude Greater Than' option is that the 'Magnitude Greater Than' option highlights both compared periods whereas the 'Greater Than' option does not. For example, if you compare sales for this period to last period and you use the 'Magnitude Greater Than' as follows:

Highlight if = Magnitude Greater Than | Threshold = 'amount' | Period = All | Background Color = 'color'.

The result for both periods are highlighted. If, however, you use the 'Greater Than' option, in this example it will highlight the results for 'This Period'.

Summary Highlighting

If you have defined a summary type for a field on the Results subtab of a saved search page, you can set up highlighting of aggregated results for this field on the Highlight If (Summary) subtab of the Highlighting subtab. Available summary types include count, sum, minimum, maximum, and average.

For example, if you filtered a saved transaction search to include sales transactions, and defined a summary type of Sum for the Net Amount field, you could highlight the names of customers with over $100,000 total sales with a red background color.

Adding a Legend to Highlighted Search Results

You can add a legend to the footer of saved searches to help you identify the highlighted search results.
Defining a Saved Search

1. When editing or creating a saved search, click the Highlighting subtab.
2. For each defined highlighting condition enter a description in the Description field.
   For example, if you chose to highlight all customers with the 504 area code in yellow, you can enter 504 area code as your description.
3. When the description is entered, click Done.
4. Click Save.

Marking a Search Inactive

You can mark a search inactive for any saved search that you own. By default, the creator of a saved search is its owner.

To mark a search inactive:

1. Go to the list of your saved searches.
2. Make sure that the Show Inactives option is selected.
3. Check the Inactive box next to the saved search you would like to make inactive.
4. Click Submit.

Editing or Deleting a Saved Search

If you have the Publish Search permission, you can edit or delete any saved searches that you own. By default, the creator of a saved search is its owner.

You also can edit saved searches to which you have access, that are owned by other users. If the search owner has checked the Allow Audience to Edit box for a saved search, you can edit it and save it with the same name. If not, you still can edit the search, but you must do a “Save As” to save it with a different name.

Important: If you create a saved search but do not have the Publish Search permission, the search is automatically marked as Public. Public searches can only be deleted or saved by administrators or users with the Publish Search permission. Consequently, even if you own a saved search, if you do not have the Publish Search permission you can only do a “Save As” to save it with a different name. For more information about administrator access to saved searches, see Administrator Access to Other Users’ Saved Searches.

To edit a saved search:

1. Open a saved search definition page.
You can open a saved search by selecting it from a list of saved searches. Lists of saved searches are available at Reports > Saved Searches > All Saved Searches, and at Lists > Search > Saved Searches.

You can use global search to find a saved search. In the Search field in the upper right corner, enter the prefix `s:` and the name of the search, as in the following example:

`s:Custom Lead Search`

2. To delete the saved search, point to Actions, then click Delete, if it is available. (This option will only be available if you are the saved search owner or an account administrator.)

3. Make changes to the saved search as desired.
   - For information on what you can define for a saved search, see the steps in Defining a Saved Search.
   - If you want to undo changes at any point, click the Reset button.

4. After you have edited saved search definitions, you can do the following:
   - Click the Preview button to review search results without saving the search definitions.
   - Click the New Template button to create an advanced PDF/HTML template for printing the saved search results. For more information, see the help topic Advanced Templates for Printing Saved Search Results.
   - Click Save As to save the changed search under a different name.
     - Click Save to save the changed search under the same name. (if available)
     - Click Save & Run to save the changed search and review results. (if available)
     - Click Save & Email to save the changed search and email results to the recipient(s) you set up on the Email, Recipients from Results or Email, Specific Recipients subtabs. (if available)
     - For more details on save options, see Accessing a Saved Search.
   - To create a custom template to use when printing results from this saved search, click New Template. The New Template button is available if advanced PDF/HTML templates are enabled for your organization. For more information about creating a custom template to print results from this saved search, see the help topic Advanced Templates for Printing Saved Search Results.
   - If server SuiteScript is enabled, click the Change ID button to change the search ID.
     (NetSuite generates a default ID for each saved search you create. The default ID format is customsearch#. If you are including calls to saved searches in scripts, you may want to change this ID.)

Using a Saved Search as a View

You can define a saved search's definition to be available for views to all of its audience, and/or make it the preferred view for that record type's lists. The search audience is defined by your settings in the Public check box and the Audience subtab.

A list view is a definition of the records and fields to be displayed on a list page for a record type. A sublist view is a definition of the records and fields to be displayed on a subtab list for a record type. A dashboard view is a definition of the records and fields to be displayed in the List portlet for a record type. These view definitions are based on saved searches, so the saved search definition page enables you to reuse your search settings for list, sublist, and dashboard views.
Defining a Saved Search

125

Important: If the Use Expressions option is enabled for a search, inline editing is disabled in list, dashboard, and sublist views based on the search. If you want inline editing to be available for a view, ensure that the Use Expressions box on the Criteria subtab is not checked for the search that filters view results. See Using And/Or Expressions in Search Criteria.

Making a Saved Search Available for Views

Each saved search page has a set of Available as View check boxes in the header. You can enable one or more of these check boxes to make the saved search's definitions available for the audience to apply to list views, sublist views, and/or dashboard list portlets of the selected record type.

- If the Available as List View box is checked, users can select the saved search's title in the View dropdown list at the bottom of list pages of the selected record type, to display records and fields according to saved search definitions.
- If the Available as Sublist View box is checked, users can select the saved search's title in the View dropdown list at the bottom of lists of the selected record type on subtabs.
- If the Available as Dashboard View box is checked, users can select the saved search's title in the View dropdown list at the bottom of dashboard list portlets of the selected record type.

If a list, sublist, or dashboard List portlet does not include a View dropdown list, it means no saved searches for that record type have been made available for that type of view. Do not use record type names in search names.

In addition to the View dropdown list, users can click Customize View to create their own custom search to use as a custom view. See the help topic Working with List Views, Sublist Views, and Dashboard Views.
Defining a Saved Search

The Roles subtab of each saved search page has a set of Preferred View check boxes. You can check these boxes to apply the saved search's definitions to default views for lists, sublists, and/or dashboard list portlets of the selected record type.

Use the global preferred view check boxes at the top of the subtab to set preferred views for all users, based on public searches. The View dropdown list selection is sticky, which means it remembers the last users selection. The user's selection takes precedence over any existing or newly created preferred view that may exist. For example, if a default view is added by an administrator, the default view will not supersede existing individual users' preference of view displayed by default.

Use the check boxes in the List, Sublist, and Dashboard columns to set preferred views per role.

To set this saved search as the default list view for all users:
- Check the Preferred List View box. This option is available when the Public and Available as List View boxes are checked.

To set this saved search as the default list view for a subset of users:
- Check the List box for each role that should use this saved search as the default list view. This option is available when the Available as List View box is checked.

To set this saved search as the default sublist view for all users:
- Check the Preferred Sublist View box. This option is available when the Public and Available as Sublist View boxes are checked.

To set this saved search as the default sublist view for a subset of users:
- Check the Sublist box for each role that should use this saved search as the default sublist view. This option is available when the Available as Sublist View box is checked.

To set this saved search as the default dashboard view for all users:
- Check the Preferred Dashboard box. This option is available when the Public and Available as Dashboard View boxes are checked.
To set this saved search as the default dashboard view for a subset of users:

- Check the Dashboard box for each role that should use this saved search as the default dashboard view. This option is available when the Available as Dashboard View box is checked.

**Note:** Account administrators also may customize roles to set up a saved search as the default list view, sublist view, or dashboard view for a record type, or restrict a role from using a saved search as a list view, sublist view, or dashboard view for a record type. See the help topic Customizing or Creating NetSuite Roles.

Defining a Saved Search as Preferred Results

Check the My Preferred Search Results box, on the Results subtab, to customize your quick search results. All search settings are applied, including criteria, are applied to quick search results.

If you are an administrator or another user with the Publish Search permission, you can check boxes on the Roles subtab to customize quick search results for other users.

- To customize results for users assigned a selected role, check the Results box for that role.
- To customize results for all roles, ensure the Public box is checked, and check the Preferred Search Results box.

**Note:** The My Preferred Search Results option for a user overrides any preferred search results set on the Roles subtab by other users.

For more information, see Quick Search Portlet.

Defining a Saved Search as a Preferred Search Form

By default, the simple search form for each record type displays a system-defined set of fields that can be used as filters. To simplify your searches, you can apply your saved search's available filters to be the only fields on this form. If you are an administrator or another user with the Publish Search permission, you can define a preferred search form for other users too.

For details, see:

- Setting My Preferred Search Form
- Setting a Preferred Search Form for Other Users

**Note:** An alternate approach is to create a personalized search form rather than using a saved search. See Personalizing a Search Form.

Be aware that account administrators also may customize roles to set up default search forms for one or more record types per role. See the help topic Customizing or Creating NetSuite Roles.

**Setting My Preferred Search Form**

To set up your saved search to be used as your preferred simple search form, go to the Available Filters subtab of the saved search definition page, add filter fields, and check My Preferred Search Form.
For example, you can set up the following search to be your preferred form for customers:

Your simple search form looks like this:
Setting a Preferred Search Form for Other Users

The Roles subtab of each saved search page has a set of Preferred Form check boxes you can use to apply the saved search's available filters to the simple search form, for some or all of the search audience.

- To use a saved search as the preferred form for all users, check Preferred Search Form.
  
  You must first make the search public and add at least one filter to the Available Filters subtab, before you check this box.

- To use a saved search as the preferred form for a subset of the audience, check Form boxes for specific roles.

Note: Your setting for My Preferred Search Form overrides Preferred Search Form settings here.

Forms are the pages used to enter information into the NetSuite database. Setting preferred forms for your employees lets you control the entry and transaction forms employees use to enter data. This maintains consistency in your company and lets you capture the information that is most important to your business.

Using a Saved Search as a Reminder

If a saved search's results drive your work tasks, you can add a count of results, with a link to the details, to your dashboard Reminders portlet. This link, called a custom reminder, makes your important task information readily accessible. After you check the Available for Reminders box on the saved search page, you can set up your Reminders portlet to include the new saved search reminder. This reminder also is available to other users in the search audience.

Be aware of the following when you plan to use a saved search as a reminder:

- The search title is displayed in the Reminders portlet, with the format: `<number_of_results><saved_search_name>`
  
  Define a search title that makes sense as a reminder.

- Custom reminders work best for saved searches that do not have results grouped by summary types, because reminders are based on a count of the number of results, and only display when this count is a non-zero integer.
  
  If you set up a reminder for a saved search that groups results by a summary type other than a count, the reminder does not display.

  You can define a count for a field that has a summary type defined, to make the reminder display, but the reminder result is affected by the grouping and may not include the total count of saved search results.

  You should check the Results subtab to see if the saved search includes any summary types. If it does, it may be best to remove them, or to recreate the search without summary types.

For detailed steps and an example, see the help topic Creating Custom Reminders.

Using Saved Searches for Customer Center Lists

If you try to use a saved search to modify what is displayed for a Customer Center list, such as See All Transactions or See Orders, the search definition is automatically modified to show the list as originally defined. You cannot override the definition for these lists that are specifically designed for Customer Center.

Instead of modifying searches, you can use permissions to control the visibility of Customer Center lists. For example, to control the display of the See Orders link to displaying only invoices, you can modify the role used by customers as follows:
Remove the Transactions : Sales Order permission.
Set the Transactions : Find Transaction permission to View level.
Set the Transactions : Invoice permission to View level.

Change of Sign for Expense Account Amounts in Transaction Saved Searches

Before Version 2014 Release 1, saved searches handled expense accounts as credit accounts instead of debit accounts. Consequently, transaction saved searches displayed positive amounts for credit posting transactions and negative amounts for debit posting transactions. Note that this behavior impacted saved searches only; it did not impact reports or accounting processes.

As of Version 2014 Release 1, saved searches handle expense accounts as debit accounts. Consequently, transaction saved searches display positive amounts for debit posting transactions and negative amounts for credit posting transactions. This change ensures that expense accounts are handled and displayed consistently throughout NetSuite.

NetSuite recommends that you look at all of your transaction saved searches that include results amounts associated with Expense accounts to review how these amounts are displayed as of Version 2014 Release 1.

- If there is a transaction saved search where you need to maintain the behavior that existed before this release, you must edit the search to flip the sign of the impacted amount field(s) such as Amount, Amount (Alt. Sales), or Amount (Gross).
- You can flip the sign of an impacted amount field by replacing that field, for example Amount (Gross), with a formula field like the following: DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(grossamount).

The following table provides suggested formulas that you can use as a reference if you need to flip the sign of impacted amount fields in your transaction saved searches.

<table>
<thead>
<tr>
<th>Result Field</th>
<th>Formula Field</th>
<th>Suggested Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>{amount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(amount)</td>
</tr>
<tr>
<td>Amount (Alt. Sales)</td>
<td>{altsalesamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(altsalesamount)</td>
</tr>
<tr>
<td>Amount (Alt. Sales Net)</td>
<td>{altsalesnetamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(altsalesnetamount)</td>
</tr>
<tr>
<td>Amount (Foreign Currency)</td>
<td>{fxamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(fxamount)</td>
</tr>
<tr>
<td>Amount (Gross)</td>
<td>{grossamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(grossamount)</td>
</tr>
<tr>
<td>Amount (Net)</td>
<td>{netamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(netamount)</td>
</tr>
<tr>
<td>Amount (Net of Tax)</td>
<td>{netamountnotax}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(netamountnotax)</td>
</tr>
<tr>
<td>Amount (Transaction Total)</td>
<td>{totalamount}</td>
<td>DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of Goods Sold', -1, 1) *(totalamount)</td>
</tr>
</tbody>
</table>
Saved Search Email

If you are an administrator or have at least Create level of the Publish Search permission, you can enable system-generated search email messages on the Email subtab of a saved search page. The saved search email function provides a powerful set of options that can serve multiple purposes.

You can use saved search email to share complete search results with other users, to schedule long-running searches for low usage times, and to alert targeted users about changes to their important records, and for specialized purposes such as drip marketing.

You can define whether to send saved search results email according to a regular schedule, as alerts triggered by record adds or updates, or both. You can specify multiple recipients for both types of email. Recipients can be indicated by user or group name, or derived based on search results field values. For public saved searches, you can designate email alerts as available to users other than specified recipients. You can customize email text and include search results embedded in messages or as attached .csv or .xls files. (Note that CSV is the preferred format because it is the most compact.)

By default, each saved search email is sent from the search owner's email address. You can set a different default as a company preference, and you can customize the email content for a saved search to define a different sender.

**Important:** Because of existing email limitations, excessively large search results are truncated before they are sent in email. Emails containing truncated results include a note stating that truncation has occurred. This truncation occurs if an email's size is greater than 5MB or if the number of result exceeds 10,000 rows. To include the maximum possible data in a search email, send results as CSV, which is the most compact format. Use of other formats causes email size to be larger.

Saved search email messages currently are limited to 10,000 rows.

For more details, see the following:
- Enabling Saved Search Scheduled Email
- Enabling Saved Search Email Alerts
- Defining Recipients for Saved Search Email
- Customizing Saved Search Email Content

**Note:** The interface to set up both alerts and scheduled saved search email has been relocated from the Alert and Schedule subtabs to a new Email subtab. Note that recipients for scheduled search email and alert email now are shared, so if you enable both types of emails, recipients all get both types of email. For more information, see Defining Recipients for Saved Search Email.

Enabling Saved Search Scheduled Email

You can define a schedule to automatically email the results of a saved search to yourself and/or other users, on a specific date, or at regularly recurring intervals.

- Scheduled email is a great option for saved searches that take a long time to run. In addition, for exceptionally long searches, you may consider persisting search results. For details, see Persisting Search Results.
- Scheduled search email messages can serve as regular status updates; you can send full results to a specified list of users, and matching results to targeted users.
- You can specify recipients by user name or group name. You can also target users by defining search results fields that determine recipients, such as the Sales Rep field for a Customer search. For more information, see Defining Recipients for Saved Search Email.
If a Saved Search is set to inactive, any schedules applying to that Saved Search will not run. Both the Saved Search and the schedule will still exist in the system, but the scheduled action will not trigger, and no scheduled email will be sent.

You can prevent emails from being sent for searches with no results. Disable the Send if No Results option on the Saved Search Email subtab. For information, see Canceling Scheduled Saved Search Emails When No Results.

Targeted scheduled email, by default, includes a summary of each user’s results in one email message on each scheduled date. You can change this setting to instead send a separate email message for each related result, so that each user may receive multiple messages on each scheduled date. This ability is useful for activities like drip marketing. For more information, see Sending Summarized vs. Single-Record Results.

You can customize much of the text for scheduled email messages, and elect whether to include embedded search results or to attach a .csv or .xls file. For more information, see Customizing Saved Search Email Content.

You can define the sender for saved search emails. See Defining the Sender for Saved Search Email.

Saved search emails that have been scheduled in your production account are not run in your Release Preview account, to avoid confusion. If you want to email saved search results from your Release Preview account, you need to define this schedule directly in that account.

**Warning:** Be aware that only one scheduled saved search can run at a time per user, with up to 200 concurrent scheduled saved searches per NetSuite implementation. When multiple saved searches are scheduled by a user for the same time, then only one search is executed and all other searches are waiting. If the search execution time becomes too big for all of the scheduled searches waiting to be executed at a single time, the scheduling process is blocked. If this issue occurs, the user needs to update scheduling on saved search definition pages to cancel all waiting processes so that schedule searches can be processed correctly. You can avoid this issue by scheduling searches at different times.

**To enable scheduled email for a saved search:**

1. On a saved search page’s Email subtab, enable the Send Emails According to Schedule option.
2. To set up the schedule for sending emails, click the Schedule subtab.
   1. Select the interval at which you would like to email the search results, or click Single Event to email the search results only one time.
   2. As you select each interval, additional options are displayed for you to select. For example, if you select Weekly Event, you then can select the individual day of the week on which to send the results.
   3. Select a series start date. This is the first day on which the search is run and its results are emailed.
      
      For a monthly or weekly event, the value entered for Start Date should match the selection(s) made for the series interval. For example, for a Start Date of 9-8-2014, which is a Monday:
      
      - For a monthly event, the day in the Start Date should match the selection in the option buttons. In this example, you should enter 8 for Day, if this option is selected, or select the second Monday.
      - For a weekly event, the day of the Start Date should match the selected day of the week. In this example, you should check the Monday box.
   4. Select a series start time. This is the time of day that the search is run and its results are emailed.
   5. Select an end date in the End By field or check the No End Date box to continue running the search and emailing its results indefinitely.
3. To specify recipients by user name and/or group name, click the **Specific Recipients** subtab.

On each scheduled date, a single email message is sent, with all specified recipients (except those marked Bcc) listed in the **To** field, and full search results included. If a group defined as a scheduled search email recipient has an email address, that address is used in the **To** or **Bcc** fields of the message containing the results; otherwise individual email addresses for group members are used.

1. Select a user or group in the **Recipient** field. Click the [ ] button and select List to open the Choose Recipient dialog. Notice that you can limit the list of possible recipients to a specific type: contacts, customers, employees, groups, partners, or vendors. By default all types are listed.

2. If you do not want other users to see this recipient listed, enable the **Bcc** option.

3. Click **Add**.

4. Repeat these steps for other users and groups as necessary.

4. To target recipients based on values of search results fields, click the **Recipients from Results** subtab.

On each scheduled date, separate email messages are sent to all recipients who match search results values for the selected field(s). Each message includes only search results with values matching the recipient. By default, each recipient receives one message with a summary of all matching results.

1. Select a field from the **Recipient Field** dropdown list and click **Add**, repeating as necessary.

   Available options include entity and email type fields. For example, for a Customer saved search, you can select Sales Rep.

2. To send a separate email message for each matching result, rather than a summary of all matching results, to each recipient derived from results, disable the Summarize Scheduled Emails option.

   This option can be used for drip marketing.

5. To customize email message text, click the **Customize Message** subtab.

Some customization options apply to all scheduled email. Some options apply only to “single-record results”. (These occur when the Summarize Scheduled Emails option has been disabled).

1. In the **From** field, enter the sender’s name and email address. For required format details, see **Required Format for Saved Search Email Sender**.

2. In the **Subject** field, enter optional custom text. For single-record results only, you can include values from search results fields by entering field IDs enclosed in curly braces `{fieldID}`.

3. In the **Introduction** field, enter optional custom text to appear before search results.

4. For single-record results only, enter custom message body text in the **Single-Record Results** field.

   - You can include values from search results fields in this text by entering field IDs enclosed in curly braces `{fieldID}`. Select a field in the **Insert Field** dropdown list to insert its field ID.

   - Use the syntax `<%=formula%>` to add formulas to the text. Formulas can include `{fieldID}` references.

   - You can define email body text as an entire HTML page (by enclosing it with HTML tags), to send email content exactly as specified, with no additional styles, View Record link, or introduction.

5. Select an option button to indicate whether search results should be: **embedded in the email message**, **attached as a .csv file**, or **attached as an .xls file**.

   (This option is not applicable to single-record results.)
6. If you do not want to include a separate record link for each results row, disable Include View Record. When this option is disabled, one link appears at the bottom. When this option is enabled, a link appears for each row/record.

6. Click Preview, Save, Save & Run, or Save & Email.

Scheduled Search Email Limitations

- The Show Internal IDs preference does not apply to results in scheduled saved search email. You must add Internal ID as a results column to return Internal ID values for a search.
- If a saved search includes criteria filters that have non-specific values, such as -Mine- or -My Team-, scheduled emails may not be sent. Try to avoid using these values in your criteria filters.

Canceling Scheduled Saved Search Emails When No Results

When you set up a saved search to email the results to yourself and/or other users based on a schedule, by default an email is sent on the scheduled date even when the search has no results. You can prevent emails from being sent for searches with no results. Disable the Send if No Results option on the Saved Search Email subtab.

Enabling Saved Search Email Alerts

You can enable email alerts for a saved search, so that specified recipients, and additional subscribers, receive email messages whenever search results are added, and in some cases updated.
By default, email alerts are triggered whenever a newly added record matches criteria defined in the saved search. You can enable a Send on Update option so that email alerts, for some or all users, also are triggered whenever an existing record is updated to match criteria defined in the saved search. Update alerts optionally can include information about recent changes. You also can filter update alerts to be sent only when certain fields change, or only when certain old and/or new values occur.

If a Saved Search is set to inactive, any email alert applying to that Saved Search will not be triggered. the email alert will still exist in the system, but it will not trigger, and no email will be sent.

Email alerts are not available for all types of saved searches, for record types with more frequently changing, time-sensitive data. For a list of these record types, see Types of Saved Searches Available for Alerts.

Email alerts are not available for searches with summarized results. To learn more about summarizing search results, see Summary Types for Search Results.

You can specify alert recipients by user name or group name. You also can target users by defining search results fields that determine recipients, such as the Sales Rep field for a Customer search. For more information, see Defining Recipients for Saved Search Email.

You can allow users other than specified recipients to receive email alerts by enabling the Public option and the Allow Users to Subscribe option. Users then need to set their own preferences to receive alerts. For information, see Setting User Preferences to Receive Saved Search Alerts.

You can customize much of the text for alert email messages. For information, see Customizing Saved Search Email Content.

You can define the sender for saved search emails. See Defining the Sender for Saved Search Email.

A separate alert email message is sent to each recipient for every record add and, if applicable, update. For groups: if a group defined as an alert recipient has an email address, the alert is sent to that address; otherwise alert emails are sent to individual addresses of group members.

Each alert message usually includes one result row, because the search is filtered by the triggered record. You can include multi-row results for searches that may return multiple rows for each triggering record, such as transaction searches. For information, see Enabling Multi-Row Results for Email Alerts.

If a saved search with an email alert defined is included in a bundle, note that in target accounts where the bundle is installed, the email alert is not sent unless the Enable Email Alerts for WS and CSV Imports preference is enabled, at Setup > Company > Email > Email Preferences.

Saved Search Email does not work with any email capture feature including, for example, email capture plug-in and email case capture. Use an email address that is not associated with a capture feature to send saved search results. For more information, see the help topic Email Capture Plug-in Overview.

**Important:** To improve performance and avoid unnecessary email, by default email alerts are not sent for updates made by CSV imports or SOAP web services integrations. To cause email alerts to be sent for CSV imports and SOAP web services integrations, an account administrator or another user with the Set Up Company permission can set the Enable Email Alerts for WS and CSV Imports preference at Setup > Company > Email > Email Preferences. See the help topic Setting Printing and Fax Preferences.

To enable email alerts for a saved search:

1. On a saved search page's Email subtab, enable the Send Email Alerts When Records are Created/Updated option.

   If this option is not available, it means alerts are not available for this type of saved search. For more information, see Types of Saved Searches Available for Alerts.
2. To allow users other than your selected recipients to receive this search's alerts, enable the Public and Allow Users to Subscribe options.

The Public option is available near the top of the page, only for administrators and other users with the Publish Search permission. The Allow Users to Subscribe option is on the Specific Recipients subtab. Users can subscribe to a saved search's alerts by setting a preference. For information, see Setting User Preferences to Receive Saved Search Alerts.

3. To specify recipients by user name and/or group name, click the Specific Recipients subtab.
   1. Select a user or group in the Recipient field. Click the button and select List. Notice that you can limit the list of possible recipients to a specific type: contacts, customers, employees, groups, partners, or vendors. By default all types are listed.
   2. If you want this recipient to receive alerts for updates as well as adds, enable the Send on Update option.
   3. If you have enabled the Send on Update option, and you want these alerts to include information about changes, enable the Show Recent Changes option.
   4. Click Add.
   5. Repeat these steps for other users and groups as necessary.

4. To target recipients based on values of search results fields, click the Recipients from Results subtab.
   1. If you want all recipients derived from results to receive alerts for updates as well as adds, enable the Send on Update option.
   2. If you have enabled the Send on Update option, and you want these alerts to include information about changes, enable the Show Recent Changes option.
   3. Select a field from the Recipient Field dropdown list and click Add, repeating as necessary.

   Available options include entity and email type fields. For example, for a Customer saved search, you can select Sales Rep.

5. To filter update alerts to occur only for a subset of updates, click the Updated Fields subtab:
   1. If you want alerts to be sent only when a particular field is updated, select the field from the dropdown list.
   2. If you want alerts to be sent only when a particular old value (value before update) occurs for the selected updated field, enter that value.
   3. If you want updates to be sent only for a particular new value (value after update) occurs for the selected updated field, enter that value.
   4. Click Add.
   5. Repeat these steps for other fields as necessary.

6. To customize email message text, click the Customize Message subtab.
   1. In the From field, enter optional custom text. You can include values from search results fields by entering field IDs enclosed in curly braces {fieldID}.
   2. In the Subject field, enter optional custom text. You can include values from search results fields by entering field IDs enclosed in curly braces {fieldID}.
   3. In the Introduction field, enter optional custom text to appear before search results.
   4. Enter custom message body text in the Single-Record Results field.
      - You can include values from search results fields in this text by entering field IDs enclosed in curly braces {fieldID}. Select a field in the Insert Field dropdown list to insert its field ID.
      - Use the syntax <%=formula%> to add formulas to the text. Formulas can include {fieldID} references.
You can define email body text as an entire HTML page (by enclosing it with HTML tags), to send email content exactly as specified, with no additional styles, View Record link, or introduction.

7. Click Preview, Save, Save & Run, or Save & Email.

Adding the Same Field Multiple Times to a Saved Search

You can add the same field multiple times to a saved search. Search evaluates a change and adds an OR relation between all updated fields. For example, if you define:

<table>
<thead>
<tr>
<th>Field</th>
<th>Old Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>a</td>
<td>b</td>
</tr>
<tr>
<td>Test</td>
<td>c</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td></td>
<td>d</td>
</tr>
</tbody>
</table>

The email will send if the Test field is changing from 'a' to 'b' or the Test field is changing from 'c' to anything else or the Test field is changing from anything to 'd'. Additionally, you can actually define the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Old Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this example, an email alert will send if the Test field is changing from anything to anything else, but the email will send only if the Test field was modified. For example, if you modified Amount and not the Test field then the email alert will not be sent.

Email Alerts Limitations

- The Show Internal IDs preference does not apply to results in saved search email alerts. You must add Internal ID as a results column to return Internal ID values for a search.
- If a saved search includes criteria filters that have non-specific values, such as -Mine- or -My Team-, email alerts may not be sent. Try to avoid using these values in your criteria filters.

Types of Saved Searches Available for Alerts

Email alerts are not available for all types of saved searches, for record types with more frequently changing, time-sensitive data. The following types of saved searches support email alerts:

- Campaign
- Case
- Contact
- Customer
- Employee
- Event
- Issue
- Item
- Project (if you enable Project Management)
- Opportunity
- Partner
Setting User Preferences to Receive Saved Search Alerts

Users can set individual preferences to receive alerts about saved searches for which an administrator has defined them as eligible recipients.

Note the following:

- Alerts are available only for saved searches for which the following are true BEFORE a user subscribes:
  - Saved search is public.
  - Send Email Alerts When Records are Created/Updated option is enabled.
  - Allow Users to Subscribe option is enabled.
- Users who subscribe to saved search alerts are added to the Specific Recipients list for the saved search, on the Email subtab.
- Users subscribed to saved search alerts also may receive scheduled emails of saved search results, if the Send Email According to schedule option is enabled AFTER they have subscribed.
- For more information about saved search alerts and scheduled emails, see Saved Search Email.

To set preferences to receive saved search alerts:

1. Go to Home > Set Preferences.
2. On the Set Preferences page, click the Alerts subtab.
3. Select the time(s) when you want to receive email alerts.
4. Enable the Include links in HTML alerts option to have the key indicators and reminders included in your alerts appear as links.
   When you click a link, a browser window opens where you can log in to NetSuite and view the report for that key indicator.
5. If you want to send on-demand alerts, enable the Send an On-Demand Alert from this Role option.
   On-demand alerts enable you to send email to alerts@alerts.netsuite.com or to reply to an alert email and receive an email from NetSuite with the contents of your dashboard to your login email address.
6. If you want to base email alerts on a date other than the one set in your dashboard's Quick Date Selector portlet, disable the Respect Quick Date Portlet settings box. By default, this preference is enabled.
7. If you want alerts to be sent to an alternate email address, select from the E-Mail dropdown list.
8. To select one or more saved searches for which you want to receive alerts:
   1. In the Record Type dropdown list, select the type of record returned by the saved search.
      (Not all record types are available. For a list, see Types of Saved Searches Available for Alerts.)
   2. In the Search dropdown list, select the saved search. (Only public saved searches marked as Allow Users to Subscribe appear in the dropdown list.)
3. If you wish to receive alerts for updates as well as adds, enable the Send on Update option.
4. If you have enabled the Send on Update option, and you want these alerts to include information about changes, enable the Show Recent Changes option.
5. Click Add.
6. Repeat these steps to add each saved search for which you would like to receive an email alert.

9. Click Save.

Defining the Sender for Saved Search Email

The sender of emails for a saved search is determined as follows:

1. If a custom email address has been provided in the From field on the saved search record’s Email subtab’s Customize Message subtab, emails are sent from this address.
   For required format details, see Required Format for Saved Search Email Sender. For other details, see Customizing Saved Search Email Content.
2. If the From field is blank, email messages are sent from the email address defined in the search owner’s employee record.
3. If the From field is blank, and no email address is defined in the search owner’s employee record, email messages are sent from the email address defined in the Return Email Address field at Setup > Company > Company Information.
   For details about default return email address settings, see the help topic Configuring Company Information.

Required Format for Saved Search Email Sender

The required format of the email sender for the From field on the saved search record’s Email subtab’s Customize Message subtab is the following:

```
“name” <email address>
```

Note the following:

- The name must be enclosed in double quotes.
- The email address must be enclosed in carets.
- There must be a space between the quoted name and the email address.

Defining Recipients for Saved Search Email

On the Email subtab of the saved search page, you can enable saved search email alerts triggered by record adds or updates, as well as scheduled email of saved search results sent according to defined intervals.

You can define multiple recipients for both types of saved search email, alerts and scheduled. Recipient lists are shared for both types of saved search email, and you can enable both at the same time. If you have enabled both alerts and scheduled email, defined recipients receive both types of email.

- You can define a list of recipients by selecting user or group names on the Specific Recipients subtab.
  - For alerts, each specific recipient receives alerts for every record.
  - For scheduled email, a single email message is sent to all specific recipients, with full search results embedded or attached.
You can derive recipients targeted to search results field values, so that users with matching values receive email. For example, for a Customer saved search, you could select the Sales Rep field.

- For alerts, each targeted recipient receives alerts only for matching records.
- For scheduled email, by default each targeted recipient receives an email with a summary of all matching record results. If the Summarize Scheduled Emails option is disabled, then each targeted recipient receives a separate email for each matching record result.

An alternate method for targeting recipients based on search results field values is to define a filter for search criteria, such as Sales Rep is Mine or Sales Rep is My Team, as well as selecting recipients on the Specific Recipients subtab. Email is sent only to users who match search criteria AND are listed as Specific Recipients. This option may allow more control than selecting fields on the Recipients from Results field.

**Defining Specific Recipients:**

1. To specify recipients by user name and/or group name, click the **Specific Recipients** subtab of a saved search **Email** subtab.
   
   For alerts, a separate alert email message is sent to each recipient for every record add and, if applicable, update. For groups: if a group defined as an alert recipient has an email address, the alert is sent to that address; otherwise alert emails are sent to individual addresses of group members.
   
   For scheduled email, on each scheduled date, a single email message is sent, with all specified recipients (except those marked Bcc) listed in the To field, and full search results included.

   **Note:** At least one recipient must not be flagged as Bcc so the emails would be received by the recipients.

   If a group defined as a scheduled search email recipient has an email address, that address is used in the To or Bcc fields of the message containing the results; otherwise individual email addresses for group members are used.

2. Select a user or group in the **Recipient** field. Click the **button and select List to open the Choose Recipient dialog.

Notice that you can limit the list of possible recipients to a specific type: contacts, customers, employees, groups, partners, or vendors. By default all types are listed.
3. (Alerts only) If you want this recipient to receive alerts for updates as well as adds, enable the Send on Update option.

4. (Alerts only) If you have enabled the Send on Update option, and you want these alerts to include information about changes, enable the Show Recent Changes option.

5. (Scheduled email only) If you do not want other users to see this recipient listed, enable the Bcc option.

6. Click Add.

7. Repeat these steps for other users and groups as necessary.

**Deriving Recipients from Results:**

1. To target recipients based on values of search results fields, click the *Recipients from Results* subtab of a saved search *Email* subtab.

2. (Alerts only) If you want all recipients derived from results to receive alerts for updates as well as adds, enable the Send on Update option.

3. (Alerts only) If you have enabled the Send on Update option, and you want these alerts to include information about changes, enable the Show Recent Changes option.

4. Select a field from the Recipient Field dropdown list and click Add, repeating as necessary. Available options include entity and email type fields. For example, for a Customer saved search, you can select Sales Rep.

5. (Scheduled email only) On each scheduled date, separate email messages are sent to all recipients who match search results values for the selected field(s). Each message includes only search results with values matching the recipient. By default, each recipient receives one message with a summary of all matching results.

   To send a separate email message for each matching result, rather than a summary of all matching results, to each recipient derived from results, disable the Summarize Scheduled Emails option. This option can be used for drip marketing.

**Targeting Recipients Based on Search Filters:**

For an alternate method of targeting saved search email recipients based on search results field values, that does not use the *Recipients from Results* subtab, do the following:

1. Go to the *Standard* subtab of a saved search *Criteria* subtab.

2. Select the field you want to use to target recipients, and in the popup that appears, select a field value.

   For example, for a Customer saved search, you can select the *Sales Rep* field and a value of Mine or My Team.

3. Click the *Email* subtab and the *Specific Recipients* subtab.

4. Select users from the Recipient dropdown list, clicking Add after each selection.

   Email is sent only to users who match search criteria AND are listed as Specific Recipients.

**Customizing Saved Search Email Content**

You can customize much of the text for scheduled and alert email messages. Some customizations are available only for emails containing results from one record, referred to as single-record results, meaning all alerts, and scheduled emails to recipients derived from the *Recipients from Results* subtab when the Summarize Scheduled Emails option is disabled. An option to choose whether to include search results as embedded content, as an attached .csv file, or as an attached .xls file applies to scheduled email with full or summarized results.
To customize text, click the Customize Message subtab of a saved search Email subtab:

- In the **From** field, enter an optional sending email address.
  - Your entry in this field must use the following format: “name” <email address>. For details, see [Required Format for Saved Search Email Sender](#).
  - For single-record results only, you can include values from search results fields by entering field IDs enclosed in curly braces `{fieldID}`.
  - If the **From** field is blank, email messages are sent from the email address defined in the search owner’s employee record. For details, see the help topic [Adding an Employee Record](#).
  - If the **From** field is blank, and no email address is set in the search owner's employee record, email messages are sent from the return email address defined in the Return Email Address field at Setup > Company > Company Information. For details, see the help topic [Configuring Company Information](#).

- In the **Subject** field, enter optional custom text. For single-record results only, you can include values from search results fields by entering field IDs enclosed in curly braces `{fieldID}`.

- In the **Introduction** field, enter optional custom text to appear before search results.

- For single-record results only, enter custom message body text in the **Single-Record Results** field.
  - You can include values from search results fields in this text by entering field IDs enclosed in curly braces `{fieldID}`. Select a field in the **Insert Field** dropdown list to insert its field ID.
  - Use the syntax `<%=formula%>` to add formulas to the text. Formulas can include `{fieldID}` references.
  - You can define email body text as an entire HTML page (by enclosing it with HTML tags), to send email content exactly as specified, with no additional styles, View Record link, or introduction.
  - You cannot enter more than 4000 characters as custom message body text.

**Note:** You can include multiple matching rows in a saved search alert email by using a `{results}` parameter in the text for the **Single-Record Results** field. See [Enabling Multi-Row Results for Email Alerts](#).

- Select an option button to indicate whether search results should be: embedded in the email message, attached as a CSV file, attached as an XLS file, or attached as a PDF file. (This option is not applicable to single-record results.)
- If you do not want to include a separate record link for each results row, disable the **Include View Record Link** option. When this option is disabled, one link appears at the bottom.

### Enabling Multi-Row Results for Email Alerts

Normally, each saved search alert email includes only one row, because the search is filtered by the triggering record. However, certain searches, such as those with results fields from one-to-many joins, or transaction searches, can return multiple rows for each triggering record.

In this case, you can include multiple matching rows in each alert email by using a `{results}` parameter in the text for the Single-Record Results field.

The following steps provide an example of how you could set up a search alert in this case:

1. Go to Reports > Saved Searches > All Saved Searches > New.
   a. Select Type from the Filter dropdown list and in the popup, select Sales Order and click Set.
b. Select Main Line from the Filter dropdown list and in the popup, choose No and click Set. (This choice means that the search will return transaction line items but not the transaction header.)

4. Click the Results subtab.
   a. Select Item from the Field dropdown list and click Add.
   b. Select Quantity from the Field dropdown list and click Add.
   c. Select Amount from the Field dropdown list and click Add.
   d. Select each additional field that is listed and click Remove.

5. Click the Email subtab.
   a. Enable the Send Email Alerts When Records are Created/Updated option.
   b. Click the Specific Recipients subtab and select user or group names, clicking Add after each one.
   c. Click the Customize Message subtab. In the Single-Record Results field, enter the following text:

   Here are the items of the order: <CR><CR> {results}

   Note that each <CR> indicates a carriage return.

6. Click Preview, Save, Save & Run, or Save & Email.
   Each alert email includes all rows for each transaction.

**Warning:** The {results} parameter cannot be used in a scheduled saved search email that is not summarized, because the results are all single rows sent out individually. For this type of email, instead of adding the {results} parameter, use the Insert Field dropdown list to insert a field ID enclosed in curly braces for each column for which you want results returned. See Sending Summarized vs. Single-Record Results and Customizing Saved Search Email Content.

### Sending Summarized vs. Single-Record Results

The following options are available for scheduled email results:

- **When the Summarize Scheduled Emails option is enabled,** the recipients listed on the Specific Recipients subtab of the saved search Email subtab will receive a single email that contains a summary of all results. However, each of the recipients listed on the Recipients from Results subtab will receive only a summary of results related to this particular recipient.

- **When the Summarize Scheduled Emails option is disabled,** the recipients listed on both the Specific Recipients and Recipients from Results subtabs of the saved search Email subtab will receive a separate email for each of the records in the search results. In this case, each email message is a "single-record result". Recipients may receive multiple messages on each scheduled date. This option can be used for drip marketing.

**Important:** If the Results subtab of your saved search contains even one summarized field, all recipients are sent a summary of the results. This happens even if the Summarize Scheduled Emails option is disabled. Recipients on the Specific Recipients subtab are sent a single email containing the summary of the results. Recipients on the Recipients from Results subtab are sent an email containing a summary of the results specific to their records. Additionally, sending email using the Save & Email button always sends summarized results, regardless of the Summarize Scheduled Emails setting.

These settings do not apply to alert email, because these messages are always single-record results. Note that you can customize an alert message for a search that returns multiple rows per record, such as a
transaction search, to include multiple rows. For information, see Enabling Multi-Row Results for Email Alerts.

Accessing a Saved Search

To find a saved search:

- Check to see if the saved search has its own menu option at Reports > Saved Searches, and click on it, if available.
- If you know part of the search title, use Global Search to find it. Enter `se:<search_title_text>` as keywords in the Search field in the upper right corner.
- If you do not know the search title, you can display a list of all saved searches at:
  - Transactions > Management > Saved Searches
  - Lists > Search > Saved Searches
  - Reports > Saved Searches > All Saved Searches

You can click links to edit a saved search or view its results. If the list is lengthy, you can use available options to filter the list, review characteristics of searches, and find the search you need. See Using the Saved Searches List.

You can run a saved search and view its results if:

- The saved search is public, or
- You have been defined as part of the saved search audience, either by name or based on your assigned role, department, subsidiary, or group.

**Note:** When you run a saved search with the Advanced Employee Permissions feature enabled some fields are hidden depending on what your role has access to. Please contact your administrator to change what you are permitted to view. For more information about this feature, see the help topic Advanced Employee Permissions.

You can edit a saved search if:

- The saved search has been marked as Allow Audience to Edit,
- You are the owner, or
- You are an account administrator.

You also need general search permissions, and permissions for specific record types, to access saved searches. For information about general permissions required to access saved searches, see Permissions for Searches.

**Note:** Account administrators have greater access than other users to saved searches. For information, see Administrator Access to Other Users' Saved Searches.

After you have accessed a saved search page by clicking a menu link or Edit on a saved searches list page, you can:

- Make changes to search definitions on any of the header check boxes or subtabs.
- Click the Preview button to run the saved search and view its results.
Accessing a Saved Search

- Click the **New Template** button to create an advanced PDF/HTML template for printing the saved search results. For more information, see the help topic *Advanced Templates for Printing Saved Search Results*.
- Click the **Reset** button to clear any changes you have made.
- Click the **New** button to open a page where you can create a new saved search for the same record type.
- Click the **Change ID** button to open a page where you can enter a new script ID for the saved search.
- If you are not the saved search's owner, and the Allow Audience to Edit box has not been checked:
  - Click the **Save As** button to save the search with a different name.
- If you are the saved search's owner, or the Allow Audience to Edit box has been checked:
  - Click the **Save** button to resave the search with the same name.
  - Click the **Save & Run** button to resave the search with the same name and immediately run it to view results.
  - Click the **Save As** button to save the search with a different name.
  - Click the **Delete** button to remove the saved search from the system.
- If you are the saved search's owner, or the Allow Audience to Edit box has been checked, and you have the Publish Search permission:
  - Click the **Save & Email** button to resave the search with the same name and email the results to the recipients designated on the *Email, Recipients from Results* or *Email, Specific Recipients* subtabs.

  The results that are emailed to each recipient depend on the filters set up for the search, and the subtab on which the recipients are selected.
  - If the recipients are selected on the Recipients from Results subtab, a single email with a summary of the results for each users' records is sent.
  - If the recipients are selected on the Specific Recipients subtab, a single email with a summary of the results is sent to each recipient unless there is a *-Mine-* filter set up on the Criteria tab for any Entity fields. If this type of filter exists, each recipient is sent a summary of the results for their records only. In this scenario however, the results for all potential recipients are processed before the filter is considered, which can cause the data to exceed the size limit of 5MB or 10,000 rows. In such cases, the email that is sent might only contain some of the results and a truncation message, indicating that the results are incomplete.

Using the Saved Searches List

You can view a list of saved searches to which you have access using a navigation like the following: Reports > Saved Searches > All Saved Searches or Lists > Search > Saved Searches.

Reviewing and Filtering the Saved Searches List

The following options enable you to review and filter the list by search characteristics. Filtering can be particularly helpful if you have access to a large number of searches. Note that these options are sticky, meaning your selections persist the next time you view the list.

- **Show Inactives** – Check this box to list inactive searches and to be able to change the active/inactive status for searches. When this box is checked, an Inactive column displays as the first column in the list.
- **Show All Private Searches** – (Available to Account Administrators only) Select an option to determine whether private searches should be displayed in the list.
Accessing a Saved Search

- **Yes** – Select this option to include all private searches, even those where you are not included in the audience.
- **All** (default) or **No** – Select either of these options if you do not want private searches to be listed.

Account administrators have greater access than other users to saved searches. For information, see Administrator Access to Other Users’ Saved Searches.

- **Available As** – Select an option to filter listed searches by their use.
  - **All** (default) Lists all saved searches.
  - **Dashboard Views** – Lists saved searches available as dashboard views.
  - **Email Alerts** – Lists saved searches for which the Send Email Alerts When Records are Created/Updated option has been enabled. See Enabling Saved Search Email Alerts.
  - **General** – Lists saved searches that are not available as views.
  - **List Views** – Lists saved searches available as list views. See Using a Saved Search as a View.
  - **Reminders** – Lists saved searches available as reminders. See Using a Saved Search as a Reminder.
  - **Sublist Views** – Lists saved searches available as sublist views.

- **Type** – Select an option to filter listed searches by their record type. The default is to list all record types.
  - **All** – (default) Lists all record types.
  - **Dashboard Views** – Lists saved searches available as dashboard views.
  - **Email Alerts** – Lists saved searches for which the Send Email Alerts When Records are Created/Updated option has been enabled. See Enabling Saved Search Email Alerts.
  - **General** – Lists saved searches that are not available as views.
  - **List Views** – Lists saved searches available as list views. See Using a Saved Search as a View.
  - **Reminders** – Lists saved searches available as reminders. See Using a Saved Search as a Reminder.
  - **Sublist Views** – Lists saved searches available as sublist views.

- **Access Level** – Select an option to filter listed searches by the access they provide.
  - **All** – (default) Lists private, shared, and public saved searches.
  - **Private** – Lists only private saved searches.
  - **Public** – Lists only public saved searches.
  - **Shared** – Lists shared and public saved searches

For information about setting up access for searches, see Defining Audiences for Saved Searches and Making Saved Searches Public.

- **Scheduled** – Select an option to filter listed searches by whether or not they have been scheduled.
  - **All** – (default) Lists scheduled and unscheduled searches.
  - **Yes** – Lists saved searches for which the Send Emails According to Schedule option has been enabled. See Enabling Saved Search Scheduled Email.
  - **No** – Lists saved searches for which the Send Emails According to Schedule option has not been enabled.

**Taking Action from the Saved Searches List**

You can take the following actions from the saved searches list:

- Click **Edit** to review and edit a saved search’s definitions.
- Click **View** to run a saved search and view its results.
- Click **Export (CSV)** to export saved search results to a CSV file.
- Click **Persist (CSV)** to persist search results for searches that take longer time to run. The results are saved in a CSV file. For details, see Persisting Search Results.

The saved searches list also includes columns indicating the user who last ran or exported each saved search, and the date and time of this execution. If you are an administrator or have at least Create level of the Publish Search permission, you can view more details about recent executions on each saved search record. See Audit Trail for Saved Searches, Reports and Schedules.
Administrator Access to Other Users' Saved Searches

Account administrators have greater access than other users to saved searches. In addition to their own private searches, administrators can view, edit, make inactive and delete ALL saved searches, including:

- Shared searches, with or without the Allow Audience to Edit option enabled, whether or not they include the administrator in the audience
- Public searches, with or without the Allow Audience to Edit option enabled
- Private searches owned by users other than the administrator

This capability is available from the Saved Searches list page, at Lists > Search > Saved Searches, and Reports > Saved Searches > All Saved Searches. This page includes a Show All Private Searches option that the administrator can set to Yes to include all private and shared saved searches in the list.

Each listed saved search includes Edit. When this link is clicked, all editing functions are available for the saved search, including the ability to change its owner. This ability is useful in cases where the owner has left a company but the search is still in use.

The Show All Private Searches option is set to All by default, which means that private searches are not included. After it is set to Yes, it is sticky, meaning it remains enabled until you explicitly set it to All or No. Note that even when an administrator enables this option, setting it to Yes, Global Search does not return private searches and shared searches that do not include the administrator in the audience.

OneWorld accounts include the following limitation on this capability: If an administrator of a subsidiary enables scheduled email for a saved search, the administrators of other subsidiaries cannot see this search on their saved search list.

Note: In each saved search record, you can view an execution log listing the users who have run or exported the saved search in the past 60 days, and the dates and times of each execution. See Audit Trail for Saved Searches, Reports and Schedules.

Audit Trail for Saved Searches, Reports and Schedules

Saved searches, saved reports, and report schedules utilize the Analytics Audit Trail for auditing changes. The analytics audit trail offers the following features:
Audit Trail for Saved Searches, Reports and Schedules

- Audit Trail Subtab - directly from the relevant Saved Search, Saved Report, or Report Schedule edit page, you can view the history of changes made to that search or report. See Audit Trail Subtab.
- Audit Trail Search - You can create custom saved searches to display audit trail data covering all Saved Searches, Saved Reports and Report Schedules. See Audit Trail Search.

Execution of Saved searches is audited by the execution log. To view data on when the search was last run and by whom, see Auditing Saved Search Execution.

**Note:** Execution log is available for saved searches only.

Audit Trail Subtab

The Audit Trail Subtab lists all audited changes and actions for the respective Saved Search, Saved Report, or Report Schedule.

The default columns displayed are as follows:
- Date: the date and time the change was made.
- Set By: the user who made the change.
- Component Action: the action taken (update, delete, or create).
- Component Type: the type of page component that was edited.
- Component Name: the name of the edited page component.

Customizing the default Audit Trail View

Click Customize View to customize the default view for your specific needs. Additional columns available include; New value, Old Value, Record Type, Record Title, Record Owner and Record Action.

Understanding Audit Trail Data

The Audit Trail offers a rich selection of data that can be used to gather a detailed insight into changes made. In the example below two changes were made to a saved search.

1. The Public check box was unmarked. This change registered 2 changes in the Audit Trail.
   - The Search Options component type was updated from value=T to value=F.
   - The component type Audience was updated from value=T to value=F.
   In effect the value for the Audience Search Option was changed from true to false.
2. The Public check box was marked again. This change also registered 2 changes in the Audit Trail - the reverse of the previous changes.
Tips

- A single user action can create a series of cascading events in the audit trail. When reading audit trail data it is useful to group actions by date and time. Actions with the same time are most probably a single action.
- Customize the audit view to increase your understanding of what events took place.
- Focus on the key data that you need. Are you searching for the actual new and old values, or are you more concerned with who made the change?

Audit Trail Search

Analytics Audit Trail searches display audit trail data covering changes to all saved searches, custom reports, report schedules, and financial report layouts. For example, you can use this type of search to determine whether a saved search has been deleted.

To run an Analytics Audit Trail search:

1. Go to Reports > New Search.
2. Click Analytics Audit Trail.
3. Use the Record Type list to specify the record types to be included in the search. You can specify any combination of the following record types:
   - Financial Layout – Select this option to find the changes made to financial report layouts.
   - Report – Select this option to find the changes made to saved custom reports.
   - Report Schedule – Select this option to find the changes made to report schedules.
   - Search – Select this option to find the changes made to saved searches.

   If you are looking for specific changes, use the Record Action field.
Audit Trail for Saved Searches, Reports and Schedules

If you are looking for changes related to a specific search or report, you can specify its name in the Record field.

4. To define your search further, you can also use the following fields:
   - **Date** – If you are looking for changes during a specific time period, enter the time period.
   - **From/To** – If you entered a time period to filter the search, enter the start and end dates for the period.
   - **Component Name** – If you are looking for changes to a specific search or report component, enter the name of the component.
   - **Component Type** – If you are looking for changes to search or report components of a specific type, enter this type.
   - **Component Action** – If you are looking for a specific action that resulted in changes, enter this action.
   - Use the **Old Value** and **New Value** fields to look for specific values before or after the change.

5. When ready, click **Submit** to find the changes, or click **Create Saved Search** if you want to create a saved search based on your criteria.

Auditing Changes to Saved Searches

Changes to saved searches are audited using the Analytics Audit Trail and can be viewed using the Audit Trail Subtab or by running a customized Audit Trail saved search. See Audit Trail Subtab and Audit Trail Search.

To view the Audit Trail of an individual Saved Search:

1. Go to Reports > Saved Searches > All Saved Searches.
2. Click **Edit** next to the required saved search in the list.
3. Click the **Audit Trail** subtab to view a history of all changes.

Execution of saved searches is audited by the execution log. To view data on when the search was last run and by whom, see Auditing Saved Search Execution.

Auditing Saved Search Execution

Information on execution of saved searches is available via the saved search Execution Log and the Saved Searches list. For information on changes made to saved searches see Auditing Changes to Saved Searches.

Saved Search Execution Log

The saved search Execution Log subtab provides a rolling usage history for the past 60 days. This history lists each user who has run or exported the saved search, and the date and time when each execution occurred. A check box indicates whether the search was exported.
You must be an administrator or have at least Create level of the Publish Search permission to view the saved search Execution Log subtab.

**Note:** Execution log is available for saved searches only, not for reports.

**To view the saved search Execution Log:**

1. Go to Reports > Saved Searches > All Saved Searches.
2. Click **Edit** next to the required saved search.
3. Click the **Execution Log** subtab.

**Note:** Each saved search log includes executions that are scheduled, that are customized quick searches based on the saved search, that are from scripts, and that are in dashboard portlets, including saved search, KPI, and trend graph portlets.

**Saved Search List**

Not all users have access to the saved search Execution log. You must be an administrator or have at least Create level of the Publish Search permission to view it. Alternatively, you can view the Saved Searches list page, which includes the following columns:

- **Last Run By:** displays the user who last executed the saved search
- **Last Run On:** displays the date and time of execution.

<table>
<thead>
<tr>
<th>SCHEDULED</th>
<th>LAST RUN BY</th>
<th>LAST RUN ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>17 Varner, Nicholas</td>
<td>07/30/2014</td>
<td>8:16 am</td>
</tr>
</tbody>
</table>

**To view the Saved Searches list page:**

1. Go to Lists > Search > Saved Searches.

You do not need this permission to see the columns on the Saved Searches list page.

**Translations for Saved Searches**

When defining a saved search you can add translations for search titles and labels so that users of your saved search can view the results in other system-supported languages.

**Note:** Translation support for saved searches is only available in accounts where the Multi-Language feature has been enabled. For further information on multiple languages see the help topic Configuring Multiple Languages. The translation languages need to be selected at Setup > Company > Preferences > General Preferences, on the Languages subtab. Add all the languages that you would like to make available on your saved search results.

You can add translations for search elements as follows:

- **Adding Translations for the Saved Search title** - The translated title will be displayed in the search results and also in the list of saved searches.
Translations for Saved Searches

- **Adding Translations for Saved Search column headings** - The translated column headings and summary column headings will be displayed in the search results.
- **Adding Translations for Saved Search highlighting** - The translated descriptions for highlighted saved search results and summary rows will be displayed in the search results.
- **Adding Translations for Saved Search filters** - The translated labels for available filters are displayed in the filter area of the saved search results.
- Translations can also be added for mass update titles and column headings. See Translations for Mass Updates.

These translations will be displayed when the NetSuite user interface is set to the appropriate system-supported language.

Each search element translation has a maximum length of 80 characters.

**Adding Translations for the Saved Search title**

If the Multi-Language feature is enabled, the Saved Search definition page will display an additional subtab **Search Title Translation**.

Add translations for the Saved Search title as follows:

1. From the Saved Search definition page, click on the **Search Title Translation** subtab.
2. For each language listed, enter the translated text into the **Label** column.
3. Click **Save**.

**Adding Translations for Saved Search column headings**

If the Multi-Language feature is enabled, the **Results** subtab of the Saved Search definition page will display two additional columns - Custom Label Translation and Summary Label Translation.

Add translations for the saved search column headings as follows:

1. From the Saved Search definition page, click on the **Results** subtab.
2. Click the Field that you wish to edit.
3. Click the **Custom Label Translation** column.
4. Enter the translated text for each language.
5. Click **Done**.
6. Click on the **Summary Label Translation** column.
7. Enter the translated text for each language.
8. Click **Done**.
9. Repeat steps 2-8 for every Field that requires translating.
10. Click **Save**.
Translations for Saved Searches

Adding Translations for Saved Search highlighting

Add translations for the Saved Search highlighting as follows:

1. From the Saved Search definition page, click on the **Highlighting** subtab.
2. Click on a highlighting condition.
3. Click on the Translation column.
4. Enter the translated text for each language.
5. Click **Done**.
6. Repeat steps 2-5 for every highlighting condition that requires translating.
7. Click **Save**.

Translations for Saved Search highlighting of summary rows can be added in the same way.

1. From the Saved Search definition page, click on the Highlighting subtab.
2. Click on the Highlighting if..(Summary) subtab.
3. Repeat steps 2-5 (above) for every summary row that requires translating.
4. Click **Save**.

Adding Translations for Saved Search filters

Add translations for the saved search filters as follows:
1. From the Saved Search definition page, click on the **Available Filters** subtab.
2. Click on a filter.
3. Click on the **Translation** column.
4. Enter the translated text for each language.
5. Click **Done**.
6. Repeat steps 2-5 for every filter that requires translating.
7. Click **Save**.

---

**Displaying Saved Search Results on Your Dashboard**

If you are an administrator or a saved search’s owner, or a saved search is public or you have been defined as an audience member, you can run the search yourself to view its results. For information, see [Accessing a Saved Search](#).

For saved searches to which you have access, you also can display saved search results in dashboard portlets, or define saved searches as custom key performance indicators (KPIs) to view summaries, comparisons, and/or graphs of their results on your dashboard.

For information, see:

- [Creating Shortcuts to Saved Search Results](#)
- [Displaying Saved Search Results in Dashboard Portlets](#)
- [Displaying Multiple Saved Searches on Your Home Page](#)
- [Custom KPIs](#)
- [Adding a Custom KPI to the Key Performance Indicators Portlet](#)
- [Using a Custom KPI in a KPI Scorecard](#)
- [KPI Meters](#)
- [Trend Graphs](#)
- [Creating Custom Reminders](#)

**Notes:**

- When placed in the right or left columns of a dashboard, custom search portlets display only the first 4 results columns of the saved search. When placed in the center column, they display the first 9 results columns.
- You can display up to six custom search portlets on the Home page.
If you want to display these types of results for multiple date ranges, your saved search must fulfill certain requirements. For information, see Notes on Using Saved Searches as Custom KPIs.

Creating Shortcuts to Saved Search Results

If you do not want to display a saved search's results right on a page, but you still want easy access to them, you can create a shortcut. Shortcut links appear as menu options under the star menu available on every NetSuite page, and in the Shortcuts portlet, if any. You can add shortcut links for multiple saved search results pages.

If a Shortcuts portlet does not yet exist on a page, you may be able to add it. For instructions, see the help topic Adding a Portlet to a Dashboard.

To create a shortcut on your home page to saved search results:

1. Run the saved search to get to the results page. (For information, see Accessing a Saved Search or Defining a Saved Search.)
2. On the Search Results page, go to the star menu and click the Add to Shortcuts option.
3. In the Add Shortcut popup:
   1. You can modify the name for the shortcut link. By default, it is "<saved_search_name> Results".
   2. You can check the box to indicate that the search results page should open in a new window when the shortcut link is clicked. By default, the results page opens in the same window.
   3. Click Save.

There are other ways to add shortcuts links. For information, see the help topic Shortcuts Portlet.

Note: Another way to link to search results from your dashboard is to make the search available for reminders and add it to the Reminders portlet. Each reminder link includes a count of search results; the link does not display if the search has 0 results. For more information, see Creating Custom Reminders.

Displaying Saved Search Results in Dashboard Portlets

To make dynamically updated saved search results immediately available, you can add Custom Search portlets to dashboards on one or more NetSuite tabbed pages. Each Custom Search portlet displays results for a saved search that you select. Results are updated every time the page loads. The portlet also has a Refresh link that you can click to update search results. In addition, you can change the search portlet title by assigning a custom title to this portlet.

Note: When placed in the right or left columns of a dashboard, custom search portlets display only the first 2 results columns of the saved search. When placed in the center column, they display the first seven results columns. Custom search portlets also include New, Edit, and View columns with clickable links for each result record. If your saved search results include fields using custom labels that contain HTML markup or JavaScript code, those fields may not be displayed correctly in the dashboard view.

You are limited to six Custom Search portlets on the home page dashboard, but if you want to display results of additional searches on your dashboard, you have some other options to make this happen. For information, see Displaying Multiple Saved Searches on Your Home Page.
To add a Custom Search portlet to a page:

1. On the page where you want to display saved search results, click **Personalize Dashboard**.
2. In the **Personalize Dashboard** panel, under the **Standard Content** folder, click or drag and drop the **Custom Search** item.
3. In the **Custom Search** portlet, click **Set Up**.
4. In the **Custom Search** setup window:
   1. Select a saved search from the **Search** dropdown list.
   2. In the **Custom Portlet Title** field, you can specify your custom title for this custom search portlet.
   3. In the **Results Size** field, enter the number of results you want displayed at one time in the portlet. If the total number of results exceeds this number, a **From-To** dropdown list appears that you can use to navigate among results pages.
   4. In the **Drill Down** field, select whether to open an individual result in the portlet or in a new page. If you set this option as **To New Page**, you will be redirected to a page that displays the results for the drilldown.
   5. (If the Inline Editing feature is enabled) Check or clear the **Allow Inline Editing** box to indicate whether records returned as search results can be edited directly in the portlet.
      - When the Inline Editing feature is enabled in an account, inline editing is available by default in all custom search portlets. You can clear this check box to selectively disable inline editing per portlet.
      - To limit other users’ inline editing of custom search portlets, you can disable the **Allow Inline Editing** option for these portlets in personalized dashboards that you publish to users. See the help topic **Publishing Dashboards Overview**.
      - For details about inline editing capabilities, see the help topic **Using Inline Editing**.
   6. Click **Save**.
5. You can move the portlet around on the dashboard. For information, see the help topic **Arranging Dashboard Portlets**.

When search results are available in the portlet, you can choose to view or edit records. If you have Inline Editing enabled, you can edit information shown in the portlet without opening the record and the record is updated automatically. You also may be able to use Quick Add to create a new record or add new information to a record, all from within the portlet, or to click **Edit** in the portlet to modify the saved search definitions.

Displaying Multiple Saved Searches on Your Home Page

Currently, you can add up to six custom search portlets to a home page dashboard.

**Note:** When placed in the right or left columns of a dashboard, custom search portlets display only the first 2 results columns of the saved search. When placed in the center column, they display the first 7 results columns. Custom search portlets also include New, Edit, and View columns with clickable links for each result record.

If you would like to display results for more than six saved searches on this page, you can try the following options:

- **Setting Up a Custom Tab for a Standard Page**
- **Creating a New Custom Tab** (This option gives you the most flexibility, if you have permissions to do it.)
Displaying Saved Search Results on Your Dashboard

Setting Up a Custom Tab for a Standard Page

To display results from more than six saved searches on your home page, you can set up a custom tab for a standard page, add multiple Custom Search portlets to the tab, and make the tab your landing page.

1. Click Set Up Custom Tab in the upper right corner of a standard page.
2. On the Custom Center Tab page, click the Portlets subtab of the Content tab, and add multiple Custom Search portlets.
   For more information about setting up custom tabs, see the help topic Creating Center Tabs.
3. After you have saved the custom tab, you can define it to be the landing page when you log in, instead of the home page, by going to Home > Set Preferences, and on the Appearance subtab, in the Centers & Dashboards section, selecting the tab name from the Landing Page dropdown list.

Creating a New Custom Tab

To display results from more than six saved searches on your home page, you can create a new custom tab, add multiple Custom Search portlets, and make it your landing page.

1. Go to Customization > Centers and Tabs > Custom Center Tabs > New.
2. On the Custom Center Tab page, click the Portlets subtab of the Content tab, and add multiple Custom Search portlets. (You can define any other tab characteristics as well.)
   For more information about setting up custom tabs, see the help topic Creating Center Tabs.
3. After you have saved the custom tab, you can define it to be the landing page when you log in, instead of the home page, by going to Home > Set Preferences, and on the Appearance subtab, in the Centers & Dashboards section, selecting the tab name from the Landing Page dropdown list.

Saved Search Examples

Review the following for examples of saved searches:

- Creating Saved Searches for Bin Numbers
- Creating Saved Searches for System Notes
- Creating Saved Searches for User Notes
- Creating Saved Searches for Messages on Records
- Creating a Campaign Response Search
- Creating an Average Items Per Order Search
- Creating a Web Orders Search
- Creating a Daily Inventory Additions Search
- Creating a Search for Customers with No Recent Activity
- Creating a Search for Contacts with Customer Center Access
- Creating a Search Email Alert for Leads Created through Online Forms
- Creating a Search Email Alert for De-escalated Cases
- Creating a Search for Shopping Cart Information

For examples of other searches that use formulas, see Search Formula Examples and Tips.
Creating Saved Searches for Bin Numbers

You can return bin number data for transaction and item searches. The following fields are available as criteria and results:

- For transaction searches: Transaction Bin Number, Transaction Bin Quantity
- For item searches: Bin Number, Bin on Hand Count, Bin on Hand Available, Preferred Bin (whether the bin is the preferred bin for the location)
- Other Bin Number record fields are available as join fields for both transaction and item searches.

Creating a Transaction Bin Numbers Search

The following search returns all transactions that use bins, and indicate the quantities moved between bins.

To create a transaction saved search with bin number data:

1. Start a transaction saved search.
2. On the Criteria subtab, select Transaction Bin Number in the Filter field.
3. In the popup window, select “is not empty” in the dropdown list and click Set.
4. On the Results subtab, select the following fields in the Field column, clicking Add after each one: Date, Type, Transaction Number, Amount, Transaction Bin Number, and Transaction Bin Quantity. (You can remove other selected fields as necessary.)
5. Click Preview or Save & Run to view your search results.

Creating an Item Bin Numbers Search

The following search returns all items that use bins and includes all bin information, including bin numbers, quantity on hand, quantity available, whether bin is preferred, and if multi-location inventory is in use, location.

To create an item saved search with bin number data:

1. Start a transaction saved search.
2. On the Criteria subtab, select Bin Number in the Filter field.
3. In the popup window, select “is not empty” in the dropdown list and click Set.
4. On the Results subtab, select the following fields in the Field column, clicking Add after each one: Name, Type, Base Price, Bin Number, Bin On Hand Count, Bin On Hand Available, and Preferred Bin. (You can remove other selected fields as necessary.)
5. In the Field column, scroll down through all fields and click Bin Number fields. In the popup, click Add Multiple, select Location and Memo, and click Add.
6. Click Preview or Save & Run to view your search results.

Creating Saved Searches for System Notes

You can create saved searches for system notes using the System Notes Fields... filter. When you select this filter you can choose which type of system note you want to search and enter your criteria to track changes on records.
To create a saved search for system notes:

1. Go to Lists > Search > Saved Searches > New, and select a record type for the search.
2. On the Criteria subtab, select System Notes Fields... in the Filter field.
3. In the popup window, select the System Note field you want to filter your search by.
4. Select the criteria based on the type of note you selected.
5. Click Add.
6. Click Preview or Save & Run to view your search results.

**Note:** A new company preference, Log System Notes on Update Only enables you to view log system notes when updates occur. See the help topic Setting General Account Preferences. Before you enable this option in an account that existed before that release, you should first review any saved searches containing system notes fields, as these searches may use data from record creation system notes. If your account includes searches that rely on record creation system notes, you can either revise the searches before enabling the Log System Notes on Update Only option, or you can leave this option disabled. For example, a case search may use record creation system notes fields to retrieve dates when cases were first escalated. To make this search work with the Log System Notes on Update Only option enabled, this search would need to be edited to use expressions and to return values for cases' Date Created field if the escalation date was not available through record update system notes fields.

For more information on saving searches, see Defining a Saved Search.

Creating Saved Searches for User Notes

You can define search criteria that let you filter your search results by user notes entered on entity, transaction or custom records.

To create a saved search for system notes:

1. Go to Lists > Search > Saved Searches > New, and select a record type for the search.
2. On the Criteria subtab, select User Notes Fields... in the Filter field.
3. In the popup window, select the user note field you want to filter your results by.
4. Select the criteria based on the field you selected.
   The criteria appears in the Description field.
5. Click Add.
6. Click Preview or Save & Run to view your search results.

For information on permissions, see Permissions for Searches.

Creating Saved Searches for Messages on Records

You can define search criteria that let you filter your search messages entered on entity records.

To create a saved search for messages:

1. Click Search next to the type of record you want to search.
2. On the Criteria subtab, select Message Fields..., Messages From Fields..., or Messages To Fields... in the Filter field.
3. In the popup window, select the user note field you want to filter your results by.
4. Select the criteria based on the field you selected. The criteria appears in the **Description** field.

5. Click **Add**.

6. Click **Preview** or **Save & Run** to view your search results.

Creating a Campaign Response Search

You can create a saved search to review responses to email marketing campaigns. This search lets you obtain a list of recipients who did not open emails or did not receive them because they were bounced. Then you can resend campaign emails to these recipients.

**To create a saved search of campaign non-respondees:**

1. Click **Saved Searches > New** to open a Saved Customer Search page.
2. Enter a descriptive **Search Title**.
3. On the **Criteria** subtab, define a filter for a specific campaign:
   1. In the Filter dropdown list, scroll down and select **Campaign Response Fields**.
   2. In the first popup, select **Title**.
   3. In the second popup, enter the name of the marketing campaign, and click **Set**.
4. Next, define a filter for responses:
   1. In the Filter dropdown list, scroll down and select **Campaign Response Fields**.
   2. In the first popup, select **Response**.
   3. In the second popup, press **Ctrl** and select one or more responses, and click **Set**.
5. On the **Results** subtab, select the fields you want to appear in the results list. It would be helpful to include **Campaign Response:Response**, and perhaps to sort by this field.
6. If you want to be able to dynamically filter results list records by campaign response, you can select the **Campaign Response:Response** field on the **Available Filters** subtab and check the **Show in Filter Region** box.
   
   You then will be able to select a single response, such as Bounced, from a dropdown list in the results list filter area and view only customers with bounced responses for the selected campaign.
7. Enter any other search definitions that you want to include.
8. Save the search.

Creating an Average Items Per Order Search

You can create a saved search to obtain the average number of unique items per sales order. A maximum type summary result field with a formula calculates this amount.

**To create a saved search of average items per order:**

1. Click **Saved Searches > New** to open a Saved Transaction Search page.
2. Enter a descriptive **Search Title**.
3. On the **Criteria** subtab in the Filter dropdown list:
   1. Select **Type**, choose **Sales Order** in the popup, and click **Set**.
   2. Select **Main Line**, choose **No** in the popup, and click **Set**.
3. Select Shipping Line, choose No in the popup, and click **Set**.

4. On the **Results** subtab's **Columns** subtab:
   1. Select Formula (Numeric).
   2. Select a Summary Type of Maximum.
   3. Select a Function of Round to Hundredths.
   4. Enter a Formula as follows:
      \[
      \text{max(1)}*\text{count(distinct \{item\}||','||\{internalid\})}/\text{count(distinct \{internalid\})}
      \]
   5. (Optional) Enter a custom label for the formula.

5. To enable use of the saved search as a custom KPI, click the **Available Filters** subtab and select a Date field from the Filter dropdown list.

   This filter lets you compare search results for different date ranges, display them as KPIs, and even illustrate them in trend graphs.

   If you want to include a dropdown list date selector on results pages, check the **Show in Filter Region** box.

6. Enter any other search definitions that you want to include.

7. Save the search.

---

Creating a Web Orders Search

You can create a saved search that distinguishes orders placed through your website from other orders by using a filter field of Lead Source or Source on a transaction search.

If you have multiple sites, you can add a filter of website name to determine which orders were placed at each of your sites.

**To create a search that returns Web orders:**

1. Click Saved Searches > New to open a Saved Transaction Search page.
2. Enter a descriptive Search Title.
3. On the **Criteria** subtab in the Filter dropdown list:
   1. Select Type. In the popup, hold down the CTRL key to select the types of transactions you want to include in the report and click Set.
   2. Select Lead Source or Source. In the popup, select Web and click **Set**.
   3. Select Web Site. In the popup, select the name of a site and click **Set**.
4. On the **Results** subtab, select the columns you want to display.
5. Complete other subtabs as desired.
6. Save the search.

Creating a Daily Inventory Additions Search

You can create a saved search that provides the names and quantities of items added to inventory each day.

**To create a daily inventory additions search:**

1. Go to Reports > Saved Searches > All Saved Searches > New and click **Transaction**.
2. Enter a descriptive search title.
3. On the Criteria subtab, add the following filters to the Filter column:
   1. Date – Set the date to be today.
   2. Account – Select your inventory account.
   3. Posting – Select a Yes value for this filter.
   4. Formula (Numeric) – In the Formula field, type \{quantity\}, set Formula (Numeric) to greater than and Value to 0.
4. On the Results subtab's Columns subtab, add the following fields:
   1. Item – Select a Summary Type of Group for this field.
   2. Quantity – Select a Summary Type of Sum for this field.
   3. Add and remove other fields as desired.
5. Complete other subtabs as desired.
6. Save the search.

Creating a Search for Customers with No Recent Activity

You can create a saved search that lists customers who have not made any purchases for a specified period of time. You can use this search to identify customers you may want to contact.

To create a search for recently inactive customers:
1. Click Saved Searches > New to open a Saved Customer Search page.
2. Enter a descriptive Search Title.
3. On the Criteria subtab, Summary subtab:
   1. Select a Summary Type of Maximum.
   2. Select a Field of Activity: Date (from Activity Fields...)
   3. In the popup's first Date list, select not after. In the second Date list, select Relative. In the third list, select months ago, and enter 1 in the field to its right. Click Set.
      This filter limits results to customers with no activity in the past month. You could enter a different relative time period to search for customers with no activity for a different period of time.
4. On the Results subtab:
   1. Select a Field of Name with a Summary Type of Group.
   2. Click the Add button.
   3. Select a Field of Activity: Date with a Summary Type of Maximum.
   4. Add and remove other fields as desired, giving them a Summary Type of Maximum.
5. Complete other subtabs as desired.
6. Save the search.

Creating a Search for Contacts with Customer Center Access

To get a list of all contacts with access to their respective Customer Centers, use a filter of Login Access is true on a saved contact search.
Creating a Search Email Alert for Leads Created through Online Forms

You can create a saved search with an email alert that sends customized email to Sales Reps when new leads are created through online forms.

To send alerts for leads from online forms:

1. Create a lead source (campaign) for the online form. For details about how to do this, see the help topic Lead Sources.
2. Create an online form.
   1. Set Send Email Notification to False.
   2. Set Lead Source to the name of the online form.
   3. Set up other values for the online form as desired. For details, see the help topic Creating an Online Customer Form.
3. Create a new customer saved search.
   1. Click Saved Searches > New to open a Saved Customer Search page.
   2. Enter a descriptive Search Title.
   3. On the Criteria subtab, in the Filter dropdown list, select Lead Source, and in the popup, select the online form name and click Set.
4. Set up an email alert for the search on the Email subtab.
   1. Check the Send Email Alerts When Records are Created/Updated box.
   2. On the Recipients from Results subtab, select Sales Rep from the Recipient Field dropdown list.
   3. On the Customize Message subtab, customize the message text as desired, for example by adding CRMSDK tags. For details, see Customizing Saved Search Email Content.
5. Save the search.

For more information about creating saved search email alerts, see Enabling Saved Search Email Alerts.

Creating a Search Email Alert for De-escalated Cases

You can create a saved search with an email alert that sends email to assigned support reps when cases are de-escalated

To send alerts for de-escalated cases:

1. Click Saved Searches > New to open a Saved Case Search page.
2. Enter a descriptive Search Title, such as De-escalated Case Alert.
3. On the Criteria subtab, in the Filter dropdown list:
   1. Select System Notes fields, select Date, select “on” and “today”, and click Set.
   2. Select System Notes fields again, select Old Value, select “contains” and “escalated”, and click Set.
4. Set up an email alert for the search on the Email subtab.
   1. Check the Send Email Alerts When Records are Created/Updated box.
2. On the **Recipients from Results** subtab, check Send on Update, and select Assigned To from the Recipient Field dropdown list.

3. On the **Updated Fields** subtab, select Status from the Field dropdown list, and type “Escalated” for the old value.

5. Save the search.

For more information about creating saved search email alerts, see [Enabling Saved Search Email Alerts](#).

---

### Creating a Search for Shopping Cart Information

The following examples show how you can use the SuiteScript 1.0 `nlapiSearchRecord` method to get shopping cart information.

- Use the following code snippet to search carts from a certain website (ID:1) which contain a particular item (item ID:352):

  ```javascript
  var result = nlapiSearchRecord('ShoppingCart', null, [ new nlobjSearchFilter('WEBSITEID', null, 'equalto', '1'), new nlobjSearchFilter('ITEMID', null, 'equalto', '352') ], [ new nlobjSearchColumn('ITEMID'), new nlobjSearchColumn('ITEMQTY'), new nlobjSearchColumn('WEBSITEID'), new lobjSearchColumn('CUSTOMERID')])
  ```

- Use the following code snippet to access the shopping cart using the customer record. This snippet is written to get carts from all websites visited by a certain customer (ID:324):

  ```javascript
  var cart = nlapiSearchRecord('Customer', null, new nlobjSearchFilter('internalId', null, 'is', '324'), [ new nlobjSearchColumn('WEBSITEID', 'shoppingcart'), new nlobjSearchColumn('ITEMID', 'shoppingcart'), new nlobjSearchColumn('ITEMQTY', 'shoppingcart') ])
  cart[0].getValue('WEBSITEID', 'shoppingcart')
  ```
FAQ: Search

See the questions and answers below for information on Searches.

Can I display search results on my home dashboard?

You can display search results on your home dashboards using a Custom Search portlet. The data displayed in the portlet is updated each time the page is refreshed. For more information, see the help topic How can I display search results on my home dashboard?

Can I display results from more than three saved searches on my dashboard?

You can display results from more than three saved searches on your dashboard by adding up to three Custom Search portlets. To display results for more saved searches, you can add a List portlet, set up a custom tab, or create a new custom tab. For more information, see the help topic How can I display results from more than three saved searches on my dashboard?

Why can't I email or export search results?

If you need to email or export search results, but you do not see Email and Export buttons on your search and saved search results page, you may require a higher level of the Perform Search permission.

The Perform permission has two possible levels, View and Full. If you have View level for the Perform Search permission, you can run searches, and create and run saved searches, for record types to which you have access. If you have Full level for the Perform Search permission, you can run, export, and email searches, and create, run, export, and email saved searches, for record types to which you have access. Export and email buttons are available on your search and saved search results pages when you have Full level for this permission.

If you want to set up scheduled or alert emails of saved search results, you must have the Create, Edit, or Full level for the Perform Search permission.

Contact your account administrator for changes to your permission levels.

See the following topics.

- Permissions for Searches
- Emailing Search Results
- Exporting Search Results
- Saved Search Email

Why can't I make my saved search public?

You must have at least the Create level of the Publish Search permission to share a saved search with other users. If you do not have this permission level, the Public check box and the Audience subtab are not available on your saved search definition pages.

Administrators have this permission by default but most other roles do not. Contact your account administrator for changes to your permission level.

See the following topics.

- Defining Audiences for Saved Searches
- Making Saved Searches Public
- Permissions for Searches
How do I allow other users to subscribe to my saved search?

If you are an administrator or have at least Create level of the Publish Search permission, you can enable system-generated search email messages. You can define whether to send saved search results email according to a regular schedule, as alerts triggered by record adds or updates, or both.

You set up saved search email on the Email subtab of a saved search page. This subtab includes two recipient subtabs where you can specify the other users who should receive search results email. For details, see Saved Search Email.

See the following topics.

■ Enabling Saved Search Scheduled Email
■ Enabling Saved Search Email Alerts
■ Saved Search Email

How can I make my saved search results available to users who do not have permissions to the underlying records?

You cannot make saved searches available to users who do not have the required permissions. However, you can lift restrictions on saved search results. See the help topic Permissions and Restrictions for clarification on the difference between permissions and restrictions.

Check the Run Unrestricted option on the Results subtab of a saved search definition page to make the saved search results available to users normally restricted from viewing the underlying records.

If you do not want viewers of an unrestricted saved search to drill down into detailed data, be sure to check the Disallow Drill Down box. For example, the transaction saved search described above should have the Disallow Drill Down option enabled, to prevent sales reps from drilling down into details of individual transactions from summary-level search results.

Note: Users without the correct permissions will still be unable to view the search results.

See the following topics.

■ Defining a Saved Search
■ Permissions and Restrictions
■ Defining Order and Overall Formatting for Search Results

Why has the scheduled email for a saved search suddenly stopped?

Either of the following circumstances can cause scheduled saved search email not to send:

■ The saved search owner has been changed to a user who has not previously scheduled a saved search.
   For scheduled email for this saved search to resume, the new owner needs to log in with the appropriate role and resave the search.
■ The saved search owner no longer has login access to the NetSuite account, for example if the owner has left the company.
   For scheduled email for this saved search to resume, an account administrator must change the owner, and that user must log in and resave the search

See the following topics.

■ Defining a Saved Search
■ Saved Search Email
FAQ: Search

- Enabling Saved Search Scheduled Email
- Why has the running of a scheduled report suddenly stopped?

Why doesn't my search filter show in the footer of my results?

When you add a filter to search results, you must be sure to set the filter to appear in the footer of the results.

To add a filter to the footer of search results:

1. Run the saved search, and on the results page, click Edit this Search.
2. Click the Available Filters subtab.
3. In the Filter column, select the field you want to use to filter the saved search.
4. Check the box in the Show in Footer column.
5. Click Add.
6. Repeat these steps for each filter you want to add to the report.
7. Click Save.

See the following topics.

- Selecting Available Filters for Saved Searches
- Saved Searches

Why doesn't my transaction search return any values for Opportunity fields' results?

Opportunity fields in a transaction search return data only for opportunities that are linked to other transactions where the transaction linked is the criteria for the search. To return all opportunity data, use an Opportunity search instead of a transaction search.

For item searches, what is the difference between the On Hand and Location On Hand fields that can be used as search criteria and results?

On Hand is the total on hand quantity of the item on ALL locations. Location On Hand refers to the specific on hand quantities per location.

This distinction also applies to the following pairs of fields:

- Available and Location Available
- Average Cost and Location Average Cost
- Back Ordered and Location Back Ordered
- Committed and Location Committed
- On Order and Location On Order
- Preferred Stock Level and Location Preferred Stock Level
- Reorder Point and Location Reorder Point
- Total Value and Location Total Value

For more information, see Saved Searches.

Why doesn't my transaction search return any values for Created From fields' results?

If you select Created From field as results for a transaction search, line-level fields do not return values, because the join from a transaction to its source transaction's Created From fields is at the main body level and not at the line-level.
In some cases, you can define Applied To Transaction fields as results to return values for line-level fields. For example, if the source transaction for an invoice is a sales order, Applied To Transaction fields, the join between the two transactions is at the line-level, so values are returned for line-level fields. However, if the source transaction for an invoice is an estimate, the join is at the main body level, so values are not returned for line-level fields.

For more information, see Saved Searches.

**How can I include line numbers in my transaction search?**

To improve the readability of transaction line items, you can include line numbers in transaction search results by adding the **Line Sequence Number** field as a result on the Results subtab of the search definition page. This field represents the internal sequence number stored for each transaction line.

Note that line numbers are not guaranteed to be in order, even if results include all lines of a transaction. To make line numbers contiguous in search results, add a Formula(Numeric) field as a results field on the search, with the following formula expression:

```
RANK() OVER (PARTITION by {internalid} ORDER BY {linesequencenumber})
```

Note that you can create a line number custom formula field and apply it to transaction forms to display line numbers on viewed and printed transactions. For instructions, see the help topic Creating a Formula Field to Display Transaction Line Numbers. If you are using this type of field and you also want to include the line number in search results, set up the search as follows to ensure that search results match viewed and printed transaction items:

- Set a criteria of Main Line = No (false).
- Filter out transaction line items related to taxes.
- Add the Item field as a results field.
- Add the Amount (Gross) field as a results field; do not use the Amount field.
- Add a Formula(Numeric) field as a results field, with the following formula expression: RANK() OVER (PARTITION by {internalid} ORDER BY {linesequencenumber})

See the following topics.

- Selecting Fields to Display in Search Results
- Search Formula Examples and Tips
- Creating Formula Fields

**What formula can I use to return values for one search results field when the value of another field is minimized or maximized?**

If you want to return the amount of the most recent transaction for a customer, for example, you can use complex dense_rank syntax in a search formula. However, the When Ordered By Field on the Results subtab of advanced search and saved search records provides an alternative. You need to select the results field for which you want to return a value, select a Summary Type of Minimum or Maximum, and select the field that you want minimized or maximized as the When Ordered By Field.

For more details, see the Using When Ordered By Field for Search Results.

See the following topics.

- Selecting Fields to Display in Search Results
- Using When Ordered By Field for Search Results
How can I narrow results for my global search?

The Search field in the upper right corner of every NetSuite page lets you enter keywords for searches of all NetSuite records.

To speed your global searches, you can include a prefix in keywords to narrow the search by record type. A search prefix is made up of all or some of the letters of a record type plus a colon or a caret, for example, you could use it: to search for items. For more details, see Global Search Prefixes.

Why does my global search for an exact subcustomer name return no results?

Hierarchical names for child entities such as subcustomers usually contain colons. When you enter a name of this sort as global search keywords, the search usually returns "no results found".

This result occurs because global search treats a colon as a type specifier. When you enter a hierarchical name, the first part of the name is treated as a NetSuite record type. For example, if you enter Company1:Company1A, global search looks for a record of the Company1 record type, with the name Company1A, and because this record type does not exist in your system, no results are found.

To avoid this problem, you can:

- Enter a non-hierarchical name, for example Company1A, or
- Add a space immediately before the colon, for example Company1 :Company1A.

In this case, the colon is treated as a normal keyword separator instead of a type specifier and the search returns both the parent customer record and the subcustomer record. (If a string includes spaces or hyphens between words, global search treats each word as a separate keyword and results return exact matches per keyword.)

You can add a type specifier as needed, for example, enter cu:Company1 :Company1A.

Can global search return matches to fields other than record name and ID?

Global searches generally return only records that have name or ID field values that match the entered keywords. However, some custom fields also may be indexed for global search, so that records with indexed custom field values that match keywords are returned for global searches.

For details, see Including Custom Fields in Global Search.

Search
How do I use the Inline Editing feature?

NetSuite's Inline Editing feature enables you to edit records directly from lists or search results, so you can change fields without having to open individual records. Also, you can edit multiple records simultaneously by using keyboard commands.

To turn on Inline Editing:

1. Navigate to .
2. On the Company Tab, under Data Management, check the Inline Editing box.
3. Click Save.

Inline Editing is available on the following lists:

- Campaigns
- Cases
- Contacts
- CRM Tasks
- Customers
- Employees
- Events
- Issues
- Items
- Leads
- Partners
- Phone Calls
- Projects (jobs)
- Prospects
- Solutions
- Transactions
- Vendors

On these lists, you can turn on the Inline Editing feature by clicking the Inline Editing button to set it to ON. Then editable fields include an edit icon in their column headings. You also can identify editable fields by placing the cursor on them. A field is editable if the cursor turns into a hand when on the field.

- To edit a field, click on the field, and enter the new value. Press TAB or Enter, or click away from the field, to save the change.
- You can undo changes made from inline editing one cell at a time. To undo a change you have made, click on the field, hold down the CTRL Key and press the letter Z (Ctrl + Z).
- To move right for the next editable column in a list, press TAB.
- To move back to the previous column, hold down SHIFT and press TAB.
- To move one line down to the next record in a list, press Enter.
- To move one line up to the previous record, hold down SHIFT and press ENTER.
- To edit one field across multiple records, click on the field in the first record you want to change.
  - If the records are listed together, hold down the SHIFT key and click the same field on the last record to select all fields for that series of records.
If you want to select records individually, hold down the CTRL Key and click the same field individually for each record you want to edit. When the fields for the multiple records are selected, enter the new value, and press TAB or Enter to save the change.

At this time, only multiple fields in the same column can be edited. Multiple fields across different columns cannot be edited simultaneously.

To add a new record to a list, check the Show Quick Add box at the bottom of the page. Enter information for a new record at the bottom of a list. When you are finished, click Add to save the record.

See the following topics.

- Using Inline Editing
- Working with Records

Why don’t I see the field I want to update in the Mass Update Fields list?

To be available for mass update, a field must meet the following criteria:

- It must support inline editing.
- It must be displayed on your preferred form for the record type being updated.
- If it is a standard field, it must be outside of subtab lists and must not have dependencies on other fields.
- If it is a custom field, it must be stored and must not have a sourcing relationship.

For more information, see Mass Changes or Updates.

See the following topics.

- Mass Changes or Updates
- Defining a Mass Update

Is there a limited number of rows for report and search results?

Report results are truncated if they exceed a certain number of rows, depending on the report type. For more information, see the help topic Are there size limits for report and search results?.